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Abstract 
Aram Chaos is a 280 km in diameter impact crater, located in the equatorial region of 
Mars. It contains ‘chaotic terrain’: 10 km-sized tilted and collapsed blocks, and at 
specific locations km-scale hills, both bounded by fractures. Chaotic terrains are the 
source regions of outflow channels, which have been interpreted to be formed by water 
flow. The Aram Chaos chaotic terrain is connected with the ~40 km wide, ~1 km deep 
Ares Vallis outflow channel via a 15 km wide, 2.5 km deep channel. 
The goal of this study is to better understand the processes behind chaotic terrain 
formation. A 1000x1000 km research area was chosen, surrounding Aram Chaos. A 
Geographical Information System (GIS) was created, incorporating High Resolution 
Stereo Camera (HRSC) image data from the ESA Mars Express orbiter and Thermal 
Emission Imaging System (THEMIS), Mars Orbiter Camera (MOC) and Mars Orbiter 
Laser Altimeter (MOLA) data from NASA. The research encompassed the structural and 
lineament analysis of the Aram, Iani, Aureum and Hydaspis Chaos chaotic terrains within 
the research area. Geological mapping was performed to aid the analysis and to provide a 
geological framework. The results include 1) (structural) geological and 
geomorphological maps of Aram Chaos and surrounding region, 2) observation 
descriptions, 3) stratigraphical columns, 4) cross sections and 5) rose diagrams and 
concentricity/radiality of lineaments. 
The main mapped unit in the study area is the Highland Terrain (HT) unit, which is of 
Noachian age (4.5 – 4.6 Ga until 3.5 – 3.7 Ga) and at least 1.5 to 2 km thick. The 
Highland Terrain is interpreted to have been formed by a complex interplay between the 
processes of volcanism, impact cratering, erosion, deposition and (regional) deformation. 
The Aram Chaos crater is interpreted to be buried within the HT stratigraphy. After 
formation of the crater, it was filled with water rich materials. Ongoing HT formation, 
including deposition, erosion and impact cratering subsequently buried the Aram Chaos 
crater. More buried craters, with water rich infilling, are interpreted to occur within the 
HT stratigraphy. During the Noachian these formed water filled ‘cavernous systems’, 
which are combined fracture systems of many buried impact craters. 
In the Hesperian Period (3.5 – 3.7 Ga until 2.9 – 3.3 Ga) instability of the buried water 
led to the formation of the Chaotic Terrain (CT), probably triggered by subsurface 
igneous activity. The following definition of CT is used in this study: CT is considered a 
lateral unit of the HT, which is observed to have lost coherence with the surrounding HT 
due to intense fracturing (brecciation). The fracture patterns and morphology of the 
fractured HT and CT in the study area are interpreted to be caused by fluid assisted 
brecciation within a hydrothermal system, as well as due to crater related fractures and 
cavern subsidence. The subsurface water was released catastrophically forming the 
current brecciated CT morphology of fracture bounded km-scale hills. Water could also 
have been released through the HT fractures surrounding the CT. No Preferred 
Orientations (PO’s) were observed within the fractured HT and CT lineaments. This 
suggests that the observed fracture patterns have not been influenced by regional stress. 
Subsurface faults, related to the Tharsis Bulge volcanic complex could however occur in 
the study area. 
During and/or after the formation of the fractured HT and CT the Aram Chaos Formation 
(ACF) has been deposited. It is divided into a Lower, Intermediate and Upper ACF. The 
Lower ACF is further divided into a broken, fractured and smooth subunit. The smooth 
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subunit is non-fractured and has been interpreted to be a deposit on top of the fractured 
and broken LACF. The fractured and broken LACF has been deposited during the 
collapse of the underlying fractured HT and has subsequently been fractured and broken 
up. The fracturing is 1 km sized compared to the 10 km sized fracturing pattern of the 
underlying HT. The fractured and broken LACF is contained by the ~150 km in diameter 
inner ring of the Aram Chaos crater and is therefore interpreted to have been deposited 
after the formation of this structure. The unit could have been deposited sub-lacustrine 
within the inner ring. 
The non-fractured ACF units form a dome, which does not agree with the previously 
proposed sub-lacustrine depositional origin for these deposits. Similar looking non-
fractured deposits occur within Aureum and Iani Chaos (the Aureum Chaos Deposits and 
the Iani Chaos Deposits, mapped in this study). The layering sequence of the non-
fractured ACF units, from old to young (e.g. smooth LACF, IACF, UACF), is found to 
be associated with the occurrence of the sulphate kieserite, other hydrated minerals and 
hematite, respectively. The non-fractured ACF units underwent erosion, after deposition. 
The erosion morphology of the non-fractured ACF units is interpreted to be caused by the 
dominant wind direction. 
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1. Introduction
This thesis describes the research I performed of the Aram Chaos region on the planet 
Mars. It is my graduation research of my geology Masters programme and included a 4 
month internship at ESA ESTEC, Noordwijk.
The research  of Mars is  possible  due to a  vast  amount of data  (images,  topography, 
hyperspectral,  subsurface  data),  currently  available  from  NASA  and  ESA  satellites 
orbiting Mars or landers, and rovers on the surface, with more data being acquired every 
day. Since December 2003 the Mars Express satellite from ESA is orbiting Mars. The 
payload of the Mars Express satellite includes 1) a high resolution stereo camera (HRSC) 
of  which  digital  terrain  models  (DTMs)  and  anaglyphs  can  be  derived  and  2)  the 
Observatoire pour la Minéralogie, l’Eau, les Glaces et l’Activité (OMEGA) hyperspectral 
scanner. This research will focus on the use of the HRSC and OMEGA data covering 
Aram Chaos.  When I started this research a complete HRSC coverage of Aram Chaos 
had  been  achieved.  Aram Chaos  had  not  before  been  investigated  using  HRSC and 
OMEGA data in a GIS.
The research area is 1000 by 1000 kms and is located in the equatorial region of Mars, 
between the high elevated southern hemisphere and the low elevated northern hemisphere 
(Figure 2.1). Aram Chaos is a so called chaotic terrain, containing tilted and collapsed 
blocks and fractured terrain. Chaotic terrain are the source regions of outflow channels, 
which have been interpreted to be formed by water flow (e.g. Masson et al., 2001; Baker, 
2001). The largest system of chaotic terrain occurs in the Xanthe and Margaritifer Terrain 
region,  including  Aram Chaos  (Figure  3.1).  The research  area  also  includes  the  Iani 
Chaos, Hydaspis Chaos and part of the Aureum Chaos chaotic terrain and the Ares Vallis 
outflow channel. Aram Chaos is a special type of chaotic terrain, completely contained 
by a 280 km in diameter impact crater (Figure 2.3). Layered deposits  occur in Aram 
Chaos. A small channel connects the chaos with the Ares Vallis outflow channel.
No terrestrial analogues for chaotic terrain are known, and it is unclear which processes 
formed the  observed  chaotic  terrain  morphology and fracture  patterns.  This  research, 
involving geological mapping and structural analysis, using high resolution HRSC data, 
aims  to  understand  the  processes  behind  the  chaotic  terrain  formation.  In  general, 
investigating Aram Chaos may explain more clearly which processes formed the current 
Martian surface (e.g. flowing water, tectonics, volcanism, impact cratering). If flowing 
water occurred, and the Martian climate was once warmer, with a thicker atmosphere, life 
could possibly have evolved. Investigating the surface of Mars for signs of past or present 
water may also help to answer this question.
The goals of this research are:

1. Build a planetary GIS with all available image (MOC, THEMIS, HRSC), mineral 
maps (OMEGA) and elevation (MOLA and HRSC DTMs based on stereopairs) 
data of Aram Chaos.

2. Perform a geological, morphological, spectral and structural (lineament) analysis 
of Aram Chaos and surrounding area using a GIS.

3. Unravel the relative time relations of the defined units and geological events.
4. Investigate which processes formed the observed fracture patterns and the chaotic 

terrain.
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2. Mars Background 
 
2.1. Introduction 
This section summarizes the current knowledge about Mars. It emphasises the role of 
water in the formation of chaotic terrains (Figure 2.1) like Aram Chaos. 
Mars has been of scientific interest since the advent of the telescope. In the 1960’s and 
1970’s Mariner and Viking spacecraft were sent to Mars and sent back pictures from 
orbit and from the surface. Viking 1 landed in Chryse Planitia (22.3ºN-311.8ºE), Viking 
2 landed in Utopia Planitia (47.7ºN-134.1ºE) (Figure 2.2). From the late 1990’s onward a 
new class of satellites and landers have been sent to Mars. It is mostly their data which I 
am going to study. 
In July 1997 the Mars Pathfinder lander from NASA landed on Mars (at 19.3ºN-
326.4ºE), near the mouths of the outflow channel Ares Vallis (Figure 2.2). Ares Vallis is 
the outflow channel of which Aram Chaos is a source region (Figure 2.3). 
In September 1997 the Mars Global Surveyor (MGS) from NASA arrived at Mars and is 
currently still operational. It’s payload includes: 

1. The Mars Orbiter Camera (MOC) which consists of a Narrow Angle (NA) high 
resolution (1.4–1.6 m/pixel) and a Wide Angle (WA) medium resolution (240 
m/pixel) camera. 

2. The Mars Orbiter Laser Altimeter (MOLA). The derived topography data has a 
nominal 463 m/pixel (128 pixel/degree) resolution. 

3. The Thermal Emission Spectrometer (TES) with a 3 km/pixel resolution. It 
consists of three parts: (1) a Michelson interferometer measuring the thermal IR 
wavelength range from 6 to 50 microns, with a 5 and 10 cm-1 spectral sampling, 
(2) a broadband radiance sensor which measures radiance in a single band from 
5.5 to 100 microns, and (3) a solar reflectance sensor which measures from 0.3 to 
2.7 micron. 

4. The Magnetometer/Electron Reflectometer (MAG/ER) and the Radio Science 
Subsystem (RSS) which have been used to derive the magnetic field and the 
gravity field, respectively. 

In October 2001 the 2001 Mars Odyssey (MO) from NASA arrived at Mars and is 
currently still operational. Its payload includes: 

1. The Thermal Emission Imaging System (THEMIS) which consists of a 5-
wavelength visual (VIS) imaging system (18 m/pixel) and a 9-wavelength 
infrared (IR) imaging system (100 m/pixel). 

2. The Gamma Ray Spectrometer (GRS) including neutron detectors to analyze the 
chemical composition of the Martian surface. 

In December 2003 the Mars Express (MEX) from ESA arrived at Mars and is currently 
still operational. It’s payload includes: 

1. The High Resolution Stereo Camera (HRSC) (2 and 10 m/pixel) which takes 
multiple images at different angles, making 3D analysis and the derivation of 
elevation data possible. 

2. The Visible and Infrared Mineralogical Mapping Spectrometer (OMEGA) (100 
m/pixel) measuring visible and infrared light in the wavelength range 0.5-5.2 
microns. 
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3. The Sub-surface Sounding Radar Altimeter (MARSIS) to map the sub-surface 
structure to a depth of a few kilometres. It has recently been found that MARSIS 
can also be used to measure the local magnetic field strength (Gurnett et al., 
2005). 

4. Three atmospheric instruments: the Planetary Fourier Spectrometer (PFS), the 
Ultraviolet and Infrared Atmospheric Spectrometer (SPICAM) and the Energetic 
Neutral Atoms Analyser (ASPERA). 

In Januari 2004 the Mars Exploration Rovers Spirit (MER-A) and Opportunity (MER-B) 
from NASA landed on Mars (at 1.9ºS-354.5ºE and 14.6ºS-175.5ºE respectively) and are 
currently still operational. Opportunity landed in Meridiani Planum (Figure 2.2) where, 
together with Aram Chaos, hematite has been found with TES (Christensen et al., 2001), 
Spirit landed in the 140 km Gusev Crater (Figure 2.2). 
Mars has a complex evolution in which tectonics, impacts, volcanism and erosion played 
a role. Mars was most active in the Noachian, although episodes of volcanic activity 
continued until a few Ma ago (Neukum et al., 2004). I will focus on the evolution of Mars 
relevant to the context of Aram Chaos. 
The following sections will describe (1) a chronology system used for Mars, essential to a 
geological investigation, (2) Global Mars, the global martian features that influence any 
geological study of Mars and (3) the generalized evolution of Mars using the previously 
described chronology system. 
2.2. Mars stratigraphy and crater chronology 
In order to determine the evolution of the Martian geology a means to measure time, a 
chronology system, is required. Tanaka (1986) proposed a relative chronology system, 
using a combination of stratigraphic superposition relations and crater counts (Table 2.1). 
This system divides the surface of Mars, from old to young, in a Noachian, Hesperian and 
Amazonian Period. The periods were named after the Noachis Terra, Hesperia Planum 
and Amazonis Planitia type locations. Each period was subsequently divided in an Upper, 
Middle and Lower epoch (Table 2.2). 
An absolute Martian chronology system can only be devised when a sample return 
mission brings back samples from different type locations on Mars. This has not been 
undertaken. However, the ages of specific events, which occurred on Mars, have been 
determined using Martian meteorites found on Earth. They are accepted to have formed 
on Mars because they contain gasses with the same isotopic signature as the Martian 
atmosphere (determined by the Viking landers) (Nyquist et al., 2001). The oldest 
meteorite, named ALH84001, formed ~4.5 Ga ago, providing evidence that the Martian 
crust had formed at that time (Hartmann, 2005). A group of Martian meteorites, the 
nakhlites, crystallized 1.3 Ga and show evidence for igneous processes. Some contain 
evaporate minerals and one nakhlite, named Lafayette, contains weathered minerals and 
was exposed to liquid water ~670 Ma. Another group, the basaltic shergottites, show 
evidence for basaltic lava flows hundreds of millions of years ago. 
An approximate absolute geochronology system is determined by extrapolating the 
known cratering flux of the Lunar mare surfaces to Mars. In the 1960’s and 1970’s 
Russian robotic and NASA manned and robotic missions landed on the relatively smooth 
mare surfaces of the Moon and brought back samples. These samples were dated using 
K-Ar dating and it was determined that the mare surfaces formed ~3.4 billion years ago 
(Ga). Hartmann and Neukum independently performed crater density counts for these 
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lunar mare surfaces. They counted craters of specific diameters and plotted their crater 
densities (craters/km2) against crater diameter (Figure 2.4). Each subsequently 
determined a best fit function of the data. This is called the production function for 
cratering, which is the number of craters/km2 for a certain time period as a function of the 
crater diameter D (Hartmann and Neukum, 2001). Hartmann fitted a powerlaw and 
Neukum a polynomial fit (Figure 2.4). 
The production function is extrapolated to Mars by using knowledge of asteroid 
populations in the Solar System to derive a Mars/Moon ratio (Ivanov, 2001). Neukum 
defined a time dependence of the Lunar cratering rate which is used to extrapolate to 
different ages (Hartmann and Neukum, 2001). The result, the lunar mare production 
function scaled to Mars and to a certain time, is called an isochron. An isochron diagram 
shows isochrons of specific ages (Figure 2.5). 
The age of surface units on Mars can be determined by plotting their crater counts in an 
isochron diagram. This results in a crater retention age, which is defined as the average 
time interval during which craters of diameter D are preserved on a given surface 
(Hartmann and Neukum, 2001). For old surfaces, where there has been enough time for 
craters to erode or fill, the derived age is D-dependent. Young surfaces on the other hand, 
will not have lost many craters so the crater retention age is most likely their absolute 
surface age. Using crater counts from the type localities defined by Tanaka (1986) (Table 
2.1, 2.2) Hartmann and Neukum (2001) calculated the epoch boundary ages (Table 2.3). 
The ages calculated by Hartmann are younger than the Neukum ages (Head et al., 2001). 
There are some limitations and uncertainties of the methods described above (Hartmann 
and Neukum, 2001; Hartmann, 2005): 

1. Until ~3.85 Ga both the Moon and Mars suffered a period of intense impact 
cratering (Figure 2.6) (Strom et al., 2005). Therefore crater count ages before 
~3.85 Ga are not reliable (Solomon, personal communication 2005). 

2. Mars compared to the Moon: 
a. Extrapolation from the Moon to Mars gives rise to uncertainties. 
b. Mars compared to the Moon has been much more geologically active (and 

still is). 
c. On a given area on Mars a much larger range in ages is possible. 

3. Crater origin: 
a. Small craters on Mars can either be primary or secondary craters. Many 

smaller secondary craters surround large craters. Determining the 
secondary crater distribution by using statistics or image observation 
reduces the primary crater count and thus influences the crater retention 
age. 

b. Pseudocraters of a possible phreatomagmatic origin have been observed 
(e.g. Mouginis-Mark, 1985). 

4. Mapping: 
a. Recent thin lava flows are difficult to date because observed craters could 

be situated below or on top of the flows. 
b. More than one definition exists for a given stratigraphical boundary. 

5. Statistics: 
a. The isochron method uses least squares statistics which has a 10% error. 
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b. The derived absolute ages are estimated to have a 1-σ (standard deviation) 
uncertainty of a factor 2 (Hartmann and Neukum, 2001) 

c. A large amount of craters have to be counted for good statistics. Therefore 
young and/or small units have greater errors. 

 
2.2.1. Crater recognition techniques 
Manual crater counting is a painstaking business which is nowadays more and more 
being automated. A variety of methods and software programs have been developed to 
recognize crater forms. Plesko et al. (2003a) developed the GENetic Image Exploitation 
package (GENIE) software which uses a a genetic algorithm to recognize craters. The 
genetic algorithm is a learning process which results in a crater recognition algorithm to 
evolve towards a best fit. Earl et al. (2005) developed a so called Radial Consistency 
algorithm which can detect partially circular features. Magee et al. (2003) used multiple 
methods to detects craters: 

1. For small craters they extracted a template of one small crater from the image and 
cross-correlated it with each location of the image to find comparable craters. 

2. They used edge-detection techniques involving the direction of the sun in the 
image. 

3. They used a Circular Hough Transform. A Hough Transform can identify lines in 
an image, but can be extended to identify other shapes, like circles and ellipses. 

Other methods are being developed to measure the crater shape. Mouginis-Mark et al. 
(2004) for example developed an interactive software program called IMPACT which 
can measure the geometry of impact craters. This can be used to compare different 
regions or analyse degradation of craters. Plesko et al. (2003b) combined the GENIE 
software with models of the impact process in 3D to investigate the surface response to 
impacts, which tells something about the underlying geology. 
 
2.3. Global Mars 
This section will describe the global martian features, (1) topography, gravity and crustal 
thickness, (2) surface composition, (3) magnetism, (4) orbital behavior and (5) the 
atmosphere. 
 
2.3.1. Topography, gravity and crustal thickness 
The MOLA instrument on board the MGS was the first to measure the global topography 
variation of Mars. Mars’ topography shows three global scale features, (1) a difference in 
elevation between the northern and southern hemispheres called the dichotomy, (2) an 
enormous topographical high called the Tharsis Bulge and (3) The ~2000 km diameter 
Hellas Basin impact crater (Figure 2.7). 
The southern hemisphere of Mars is topographically 2-4 km higher (therefore referred to 
as the southern highlands) than the northern hemisphere (referred to as the northern 
lowlands). The southern highlands are mostly Noachian in age with a rugged relief, and 
saturated by impacts. The northern lowlands are smoother and have less impacts, making 
them mostly Hesperian in age. 
The Tharsis Bulge is a ~10 km high region over 30 × 106 km2. It started forming in the 
Noachian and lava flowed probably until a few Ma (Neukum et al., 2004). It formed 
either by (1) isostatic uplift and flexural loading, (2) magmatic intrusion or (3) volcanic 
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loading and was possibly caused by one or more mantle plumes (Zuber, 2001) or a 
combination. The loading of the lithosphere by the Tharsis Bulge created a 
topographically lower region around it referred to as the Tharsis trough (Phillips et al., 
2001). 
The Radio Science Subsystems on board the MGS, MO and MEX can be used to derive 
the gravity field of Mars. According to Smith et al. (1999) the largest free-air gravity 
anomalies on Mars are more than 10 times larger than terrestrial anomalies of the same 
scale. They attribute this to the ability of the thicker Martian lithosphere to support larger 
stresses and prevent isostatic readjustment. They found a smooth gravity signature for the 
southern highlands which suggests the southern highlands are isostatically compensated. 
The northern lowlands show more anomalies, and possible buried impact craters. 
Phillips et al. (2001) used gravity and topography data and found that loading of the 
lithosphere by the Tharsis Bulge is able to explain global scale gravity and topography. 
Tharsis Bulge loading for example explains the Tharsis trough and the Arabia Terra 
topographic high, opposite to Tharsis. The dichotomy was not included in the loading 
model. 
Combining gravity and topography data the spatial variation of the crustal thickness can 
be derived (Figure 2.8) (Neumann et al., 2004). The method assumes a specific constant 
density of the mantle and the crust and a mean crustal thickness. If the mean crustal 
thickness is chosen to small, negative values would be obtained beneath the large impact 
basins (Nimmo and Tanaka, 2005). Zuber et al. (2000) used a mean crustal thickness of 
~50 km, a constant crustal density of 2900 kg/m3 and a constant mantle density of 3500 
kg/m3 and derived a crustal thickness variation between 3 and 92 km. Neumann et al. 
(2004) found mean crustal thicknesses of 32 km in the northern lowlands and 58 km in 
the southern highlands, indicating the dichotomy is not only a topographical but also a 
crustal feature. Three hypotheses for the formation of the crustal dichotomy have been 
postulated (Nimmo and Tanaka, 2005; Head et al., 2001): 

1. An endogenic process, f.e. plate tectonics or long wave-length mantle convection. 
2. One giant impact. 
3. One event of several overlapping large impacts. 

Frey (2005) identified Quasi-Circular Depressions (QCDs) in MOLA data from Early 
Noachian terrain, which he suggests, are buried possibly pre-Noachian impact basins. 
According to his N(>200) crater chronology the dichotomy formed around 4.08-4.18 Ga 
or earlier, by multiple impacts which formed the Utopia, Acidalia and Chryse basins in 
the northern lowlands. Solomon et al. (2005) however argues that the dichotomy, because 
of its global scale, is 4.5 Gyr in age. Similar in age as when the stable crust formed, 
evidenced by Martian meteorite ALH84001. They therefore favor an endogenic origin for 
the dichotomy. 
Clifford (1993) proposed that the upper part of the crust is ice-enriched and remains 
permanently frozen. He estimated this cryosphere to be ~2 km at the equator and ~6 km 
at the poles. 
 
2.3.2. Surface composition 
The global composition of the surface and subsurface of Mars is investigated using 
different remote sensing techniques. Data from TES on board the MGS for example 
suggest primarily basaltic compositions for the Martian highlands and more siliceous 
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andesite-like compositions for the Northern plains (Nimmo and Tanaka, 2005; Head et 
al., 2001). According to a study by Rogers and Christensen (2003) this is caused by a 
shift from basaltic volcanism (which formed the southern highlands) to andesitic 
volcanism (which covered most of the northern lowlands). The andesitic signature could, 
however, also have been caused by altered basalt (Nimmo and Tanaka, 2005). According 
to Bibring et al. (2005) preliminary results from OMEGA on board the MEX do not show 
evidence for this andesitic composition of the northern lowlands. However, they have 
found olivine concentrations in the floors and ejecta of specific craters in the northern 
lowlands. The size is these craters suggests they penetrate the ~100 m thick cover (the 
Vastitas Borealis Formation), exposing an olivine rich layer underneath. 
Remote sensing by the Gamma Ray Spectrometer on board the MO and by OMEGA led 
to the discovery of large amounts of surface and subsurface water ice in the polar regions 
of Mars (Boynton et al., 2002; Feldman et al., 2002; Mitrofanov et al., 2002; Bibring et 
al., 2005). The occurrence of rampart craters is also possible evidence for present or past 
subsurface ice on Mars. Rampart craters have an ejecta blanket with a flow morphology 
suggesting the impact occurred onto a water or ice-rich surface (Zuber, 2001). Impact 
simulation experiments at the NASA-Ames Vertical Gun facility resulted in similar 
morphologies (Masson et al., 2001). OMEGA however did not find enrichment in 
hydrated minerals in rampart craters (Bibring et al., 2005). 
Minerals associated with liquid water are sulfates, carbonates, hematite and 
phyllosilicates (clay minerals). OMEGA detected sulfates within Valles Marineris, Terra 
Meridiani, Aram Chaos and in the North Polar Region, but did not observe carbonates 
(Bibring et al., 2005). Phyllosilicates were also detected by OMEGA, mainly associated 
with Noachian aged surfaces (Poulet et al., 2005). TES detected small concentrations of 
carbonates, mostly magnetite, in dust covered regions of Mars (Bandfield et al., 2003). 
Hematite has been detected by TES in Valles Marineris, Terra Meridiani and Aram 
Chaos (Christensen et al., 2001). 
 
2.3.3. Magnetism 
The MAG/ER instrument on board the MGS measures the magnetic field of Mars and 
can detect magnetic anomalies larger then ~200 km (Nimmo and Tanaka, 2005). 
Presently Mars doesn’t have an internal magnetic field caused by a core dynamo. 
MAG/ER however measured a remanent crustal magnetization, caused by iron-bearing 
minerals in the Martian crust, such as magnetite and hematite (Zuber, 2001). Overall the 
magnetic anomalies on Mars are 10 times more intense than terrestrial magnetic 
anomalies (Connerney et al., 2005). A remanent magnetization occurs when magnetic 
minerals are formed, or cooled below the Curie temperature (580°C for magnetite) in the 
presence of a prevailing magnetic field (assuming Mars had a geodynamo in the past). 
The most recent magnetic field map of Mars, published by Connerney et al. (2005), is 
derived from two Mars years of observation (Figure 2.9). It shows no, or very low 
magnetic anomalies at the Utopia, Hellas, Argyre, Chryse and Isidis impact basins which 
suggests the core dynamo was lost when these impacts formed in the Early Noachian. On 
Earth the Vredefort meteorite crater in South Africa also shows a lower then usual 
magnetic intensity when observed using remote sensing (Carporzen et al., 2005). The 
rocks on the ground however show higher then normal magnetic intensities. These 
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intensities are randomly oriented and cancel each other out. Therefore the conclusion that 
the impact basins formed later then the extinction of the geodynamo may be incorrect. 
Volcanic regions such as Elysium, Olympus Mons, the Tharsis Montes, and Alba Patera 
almost completely lack magnetic anomalies. They are observed on the flanks of the 
Tharsis Bulge which suggests that initial volcanism occurred when the core dynamo was 
still active (Nimmo and Tanaka, 2005). 
The magnetic field map also shows a pattern of magnetic lineations with an alternating 
positive and negative polarity (Connerney et al., 2005). This has been interpreted as the 
result of crustal spreading contemporary to a reversing core dynamo, as observed on 
Earth’s ocean floor, although larger in scale. The pattern is strong in the southern 
highlands but weak in the northern highlands, indicative of a buried Noachian basement. 
Connerney et al. (2005) also observed offsets of the lineations which they interpret as 
transform faults. Other interpretations for the lineations are large-scale dike intrusions, 
accretionary terrains and hydrothermal metamorphism, which is used to explain an 
apparent correlation between magnetic anomalies and valley networks (Nimmo and 
Tanaka, 2005; Solomon et al., 2005). 
 
2.3.4. Orbital behavior 
The Martian orbit can vary in three ways: (1) eccentricity, which is a measure of the 
ellipticity of the orbit, (2) obliquity, which is a measure of the tilt of the rotation axis and 
(3) precession, which is the variation of the rotation axis tilt direction relative to the orbit 
plane (Figure 2.10). 
The current Martian orbit is highly elliptical, with an eccentricity of 0.0935 and a mean 
radius of 1.52 AU. One complete orbit (a Martian year) lasts 687 Earth days. The 
obliquity of the Martian rotation axis is 25°. One rotation (a sol) takes 24 hours and 37 
minutes. The current high eccentricity and high obliquity causes Mars’ seasons to differ 
in length. The southern summer is 24 sols shorter than the northern summer.  
A combination of eccentricity, obliquity and precession cycles (Milankovitch cycles) 
cause changes in insolation and are known to have influenced the climate on Earth. 
According to Laskar et al. (2002) these cycles possibly also influenced the deposition of 
the polar caps on Mars. They found a correlation between calculated insolation 
parameters and a sequence of bright and dark layers of the northern cap. The 350m thick 
layer was found to be deposited in 0.9 Myr. 
Laskar et al. (2004) calculated the insolation parameters for Mars for the last 250 Ma. 
Mars’ obliquity was found to be highly variable and can vary in time between 0º and 
more than 60º. A change to a high obliquity (>40°) would influence the climate. 
Modeling showed that polar ice would sublime and deposit in the equatorial regions. 
There is evidence that this has happened during the Late Amazonian (300 – 600 Ma until 
present). Recently multiple stages of glacial activity were discovered at the base of 
Olympus Mons (18ºN) and east of the Hellas basin (39ºS to 43ºS) (Head et al., 2005; 
Neukum et al., 2004). 
The Gamma Ray Spectrometer on board MO detected large amounts of near surface ice 
at high latitudes (Levrard et al., 2004). This led Levrard et al. (2004) to propose that 
during low obliquity (<25°) deposits of equatorial ice, earlier deposited during high 
obliquity, would sublime and deposit at high latitudes. This cycle of deposition and 
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sublimation at the Equatorial and Polar Regions could have been active throughout 
Martian history. 
Mars has a fast rotation rate and large-scale topography such as the dichotomy and the 
Tharsis Bulge. A rotating body is most stable when most mass is farthest away from the 
rotation pole. Therefore it is possible that true polar wander, a change of the geographic 
location of the Martian rotation axis, occurred in the past. Sprenke et al. (2005) used 
gravity data to investigate possible polar wander caused by the emplacement of the 
Tharsis Bulge. They found that the current pole position would make pre-Tharsis Mars 
rotationally unstable, which suggests the Tharsis Bulge formation caused a gradual 15º-
90º polar wander. The polar radius of Mars is ~22 km smaller than the equatorial radius. 
This large ellipticity suggests Mars’ current geographical orbit orientation is very old 
(Sprenke, 2004). 
There is also geomorphologic evidence for true polar wander, (1) the non-circular 
morphology of the polar caps of Mars led Murray and Malin (1973) to suggest that a 
gradual polar wander of 10º–20º occurred in the last 100 Myr, (2) the hiatus between 
Hesperian aged material and Late Amazonian polar deposits led Fishbaugh and Head 
(2001) to suggest polar wander brought the poles to their current position and (3) Schultz 
and Lutz (1987) observed possibly very young anti-podal deposits near the equator, 
similar to current polar deposits. 
 
 
2.3.5. The atmosphere 
Currently Mars has a surface temperature varying between 300 and 140 K (on average 
220 K). Its CO2 dominated atmosphere (95%) has an average surface pressure of 6.5 
mbar. It varies 20% each year by condensation of CO2 at the poles.  
A Hadley type circulation, including trade winds, occurs in the Martian atmosphere 
(Leovy, 2001). It is stronger during northern winter than during southern winter. This is 
caused by the current high eccentricity. During the northern winter bright streaks on the 
surface show the Hadley circulation pattern of the surface winds. 
The atmospheric temperature is controlled by suspended dust (Leovy, 2001). The amount 
of dust in the atmosphere increases during northern winter when the distance to the Sun is 
smallest. This causes dust storms, mostly occurring at mid latitudes. They can become 
global dust storms, completely covering the planet surface. 
 
2.4. Mars Global evolution 
 
2.4.1. The Noachian Period 
 
2.4.1.1. Early Mars 
Physical modeling and data from Martian meteorites suggest that the core, mantle and 
crust of Mars formed over a period of ~50-100 My, around 4.5-4.6 Ga (Stevenson, 2001; 
Solomon et al., 2005). Mars is 6800 km in diameter, about half the size of Earth, with two 
times the amount of surface area per volume, making it easier to release heat. Therefore 
Mars probably was most active during its first billion years (Solomon et al., 2005). 
Numerical modeling by Van Thienen et al. (2005) showed that plate tectonics or flood 
volcanism could only have occurred during an early episode of rapid cooling (> 200 
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K×Gyr-1), after which cooling mainly occurred conductively through Mars’ lithosphere. 
From ~4.5 Ga to ~3.85 Ga Mars and Earth suffered a period of intense impact 
bombardment (Strom et al., 2005). During this period the major impact basins formed, 
e.g. Isidis, Hellas, Argyre, Chryse, Utopia and the south polar Prometheus Basin. It ended 
abruptly after a 10 to a 100 Myr final period of cratering called the Late Heavy 
Bombardment (Strom et al., 2005). The oldest surface unit mapped, the Hellas impact 
material, is around 4.05-4.13 Ga or older (Frey, 2005). 
 
2.4.1.2. Tectonics and volcanism 
According to Nimmo and Tanaka (2005), Head et al. (2001) and Tanaka et al. (1992) 
most tectonic activity occurred during the Noachian. Mainly extensional, f.e. grabens 
(fossae) and troughs, although compressional structures (wrinkle ridges) also occurred. 
Tectonics and volcanism in the Noachian is mostly associated with the construction of 
the Tharsis Bulge. The Tharsis related extension and compression are perpendicular to 
each other (Figure 2.11). Parts of the dichotomy boundary also experienced tectonic 
activity. 
 
2.4.1.3. A Warmer Period? 
An important question is if Mars was once warmer with a thicker atmosphere. During the 
Noachian Tharsis related volcanism probably put a large amount of CO2 and water in the 
atmosphere resulting in a thicker atmosphere protected from atmospheric erosion by a 
global magnetic field (Jakosky and Phillips, 2001; Nimmo and Tanaka, 2005). However, 
the higher cratering rate during the Noachian also influenced the atmosphere, a 50 – 90% 
loss of the atmosphere for example occurred in the Early Noachian due to impacts 
(Jakosky and Phillips, 2001). By correlating magnetic data with crater counts of QCDs, 
Frey (2005) placed the death of the global magnetic field at 4.10-4.21 Ga or older, 
occurring earlier than the oldest Noachian surface units. The occurrence of the light gas 
Xe, trapped in Martian meteorite ALH84001 3.9 Ga, is used to argue that the stripping of 
the atmosphere of Mars occurred 3.9 Ga or later (Jakosky and Phillips, 2001). An 
explanation for this difference in time is the presence of enough remanent magnetic 
anomalies which would have stalled the atmospheric stripping. 
According to Baker (2001), Jakosky and Phillips (2001), Head et al. (2001), Masson et al. 
(2001) and Poulet et al. (2005) there is geological evidence for a warmer period with an 
active hydrological cycle during the Noachian: 

1. The high erosion rates determined for Noachian surfaces (102-104 mm per 106 
years) compared to the Hesperian and Amazonian surfaces (10-1–10-2 mm per 106 
years). 

2. Thick sequences of layered sediments occur all over the Noachian highlands. 
3. Valley network systems, with a dendritic spatial pattern, occur in the Noachian 

highland (Figure 2.12), with 63% having a Noachian age, 25% a Hesperian age 
and 12% an Amazonian age, although their small size makes it difficult to derive 
crater count ages. 

4. The recent detection, using OMEGA data, of phyllosilicates, including clays, in 
outcrops of mainly Noachian age (Poulet et al., 2005). 
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Currently there are three valley network formation hypotheses, (1) a thicker atmosphere 
resulting in precipitation and surface runoff, (2) a globally higher heat flow and (3) 
localized hydrothermal systems (Gulick, 2001; Jakosky and Phillips, 2001).  
According to Baker (2001), Gulick (2001) and Masson et al. (2001) the valley network 
morphology is best explained by groundwater sapping processes from localized 
hydrothermal systems, releasing subsurface water. This is supported by the lack of 
bedforms in the valley networks, indicative for surface fluid flow (Masson et al., 2001). 
However, the groundwater sapping hypothesis does not explain the high amount of 
recharge necessary to form the valley networks (Craddock and Howard, 2001). 
According to Jakosky and Phillips (2001) it is generally agreed that in any case a gradual 
process of water flow, not a catastrophical process is necessary to form the valley 
networks. 
There is increasing evidence pointing in the direction of surface water flow during the 
Noachian and even Hesperian: 

1. A complex of distributary, channelized, meandering flow landforms of Noachian 
age in the Erythraeum region observed by Malin and Edgett (2003) which they 
interpret as a fluvial distributary fan (Figure 2.13). 

2. Dendritic valleys occurring within Late Hesperian units in the Valles Marineris 
region are interpreted to be formed by atmospheric precipitation (Mangold, 2004). 

3. The MER rover Opportunity in Meridiani Planum found evidence of aqueous 
subsurface and surface water processes in exposed beds. The Meridiani plains lie 
on top Middle to Late Noachian material (Squyres et al., 2004; Squyres and 
Knoll, 2005). 

The Noachian Period ended around 3.5 – 3.7 Ga when the cratering rate decreased 
dramatically (see Figure 2.6) (Hartmann and Neukum, 2001). During this time or early in 
the Hesperian the formation of valley networks ended abruptly indicating a change to a 
colder and drier climate (Jakosky and Phillips, 2001). 
 
2.4.2. Hesperian Period 
The Hesperian Period is a transition period between the high cratering and volcanic 
activity in the Noachian and the overall lower cratering and volcanic activity of the 
Amazonian (Head et al. 2001). It started 3.5 – 3.7 Ga and ended 2.9 – 3.3 Ga (Hartmann 
and Neukum, 2001). 
 
2.4.2.1. Volcanism and tectonics 
During the Early Hesperian there was a peak in volcanic activity (Nimmo and Tanaka, 
2005), which resulted in smooth volcanic flood plains, like Hesperia Planum. According 
to Head et al. (2001) these plains covered more than 40% of the Hesperian surface, 
including the northern lowlands, where they are now covered by younger material. Frey 
et al. (2002) interpreted MOLA data and suggested that the volcanic plains in the 
northern lowlands could be 1-2 km thick. Tanaka et al. (2003) however state that no 
evidence for volcanic vents and flows have been found in the oldest exposed northern 
plains material. 
According to Head et al. (2001) the volcanic plains were subsequently compressed 
forming long, sinuous wrinkle ridges. On a regional scale wrinkle ridges in a concentric 
pattern formed around the Tharsis Bulge. Mangold et al. (2000) found evidence for one 
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single global event of compressional deformation in the Late Hesperian which created 
wrinkle ridges in Noachian and Hesperian aged terrain. According to Tanaka et al. (2003) 
however most highland wrinkle ridges were formed during the Late Noachian to Early 
Hesperian and most lowland wrinkle ridges are Late Hesperian to Early Amazonian in 
age. 
From the Late Hesperian onwards volcanism was mainly concentrated at the Tharsis 
Bulge and the Elysium Rise (Nimmo and Tanaka, 2005; Head et al., 2001). According to 
Neukum et al. (2004) the Martian shield volcanoes erupted episodically. Olympus Mons 
for example, on the Tharsis Bulge, started forming 3.4 Ga followed by episodes of 
eruptions, even possibly up to 5 Ma. 
The enormous Noctis Labyrinthus-Valles Marineris rift system on the southeast slope of 
the Tharsis Bulge initiated during the Late Noachian and Early Hesperian and continued 
rifting during the Late Hesperian (Head et al., 2001; Tanaka, 1986). The opening was 
probably influenced by tensional stresses associated with Tharsis (Lucchitta et al., 1992). 
Valles Marineris rifted through thick layers of Noachian aged flood basalts, which were 
identified in its walls (McEwen et al., 1999). The rifting formed chasmata and troughs, 
which transitioned into outflow channels towards the east (Lucchitta et al., 1992). 
Chasmata (singular chasma) are deep, elongated, steep-sided depressions. 
Unconformably overlying the chasmata floors of Valles Marineris Internal Layered 
Deposits (ILD) occur. According to Masson et al. (2001) the ILD could be sediments 
deposited in former lakes. According to Montgomery and Gillespie (2005) the ILD have 
been eroded and stratigraphically underlie Hesperian aged lava flows. They propose the 
ILD are evaporite deposits with dewatered after the deposition of the lava. This resulted 
in catastrophic outflow of water. This hypothesis is strengthened by the detection of 
hydrated sulfates within the ILD by OMEGA (Gendrin et al., 2005). 
 
2.4.2.2. Outflow channels 
During the Hesperian and into the Amazonian episodically outflow channels formed 
(Masson et al., 2001). These channels are tens of kilometers wide and thousands of 
kilometers in length with an anastomosing pattern and with almost no tributaries (Figure 
2.14). Bedforms include teardrop-shaped islands and scour marks around obstacles (f.e. 
craters). Terraces in some channels suggest that these channels were active multiple times 
(Tanaka, 1986). 
The outflow channels have been interpreted to be caused by catastrophic outflow of a 
material behaving as a fluid (Masson et al., 2001, Baker, 2001; Baker et al., 1992). A 
variety of materials have been suggested to have eroded the channels: 

1. Hoffman (2000) proposed a model in which Mars is dominated by CO2 processes. 
Catastrophic degassing of liquid CO2 would then create a ‘cryoclastic flow’, a 
CO2 gas-supported density flow, which formed the outflow channels. 

2. Nummedal and Prior (1981) and Tanaka (1997) favor mass flows or water floods 
saturated by sediments. 

3. Jakosky and Phillips (2001), Head et al. (2001) and Baker et al. (1992) favor 
catastrophic outflow of water to explain the observed channel morphology. A 
terrestrial analog are the Channeled Scablands in the USA which were formed by 
large-scale erosion due to high velocity turbulent water flow (Baker, 2001; 
Masson et al., 2001). Kleinhans (2005) modelled water flow and sediment 
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transport of Martian outflow channels. He suggests that the formation of channels 
took around ten thousand to ten million years. 

4. Other agents include SO2, lava, glaciers or ice streams, winds and liquid 
hydrocarbons. 

The largest system of outflow channels on Mars occurs around Chryse and Acidalia 
Planitia, the so-called circum-Chryse channels (Figure 2.15) (Masson et al., 2001; 
Phillips et al., 2001). Other locations where outflow channels occur are Amazonis, 
Elyseum and Hellas Planitia (Figure 2.15). Using MOLA data Dohm et al. (2001) 
discovered possible gigantic outflow channels, 1.2–2.4 km deep and 100–700 km wide. 
They occur on the west flank of the Tharsis Bulge and are defined as northwestern slope 
valleys (NSVs) (Figure 2.15). The NSVs flowed into the northern lowlands and are 
presently covered by volcanic and aeolian deposits. All locations show signs of volcanic 
activity. The formation of outflow channels was mostly restricted to the Hesperian Period 
but episodically continues until very recently (see 2.2.6.1. Recent and present day Mars) 
(Head et al., 2001). 
Three types of outflow channel source regions can be observed: chaotic terrains (such as 
Aram Chaos), Valles Marineris chasmata and extensional tectonic features (Hanna and 
Phillips, 2005) (Figure 2.16). Most outflow channels originate from chaotic terrains, of 
which they emanate ‘full born’ (Max and Clifford, 2001). 
 
2.4.2.3. Chaotic terrain 
According to Sharp (1973) chaotic terrain (Figure 2.1) is an area consisting of up to tens 
of kilometers sized slumped and collapsed blocks. It has possibly subsided, which could 
have been caused by the removal of water, magma or sediments (Sharp, 1973; Nummedal 
and Prior, 1981). Wang et al. (2005) attribute the “checkerboard patterns of gaps between 
blocks” to lateral spreading and collapse. The blocks form an arcuate fracture pattern 
which extends into the surrounding undisturbed terrain (Sharp, 1973). Chaotic terrains 
are generally irregular in shape. In some occasions it is confined by a possible impact 
crater, as is the case with Aram Chaos (Figure 2.3) (Chapman and Tanaka, 2002). Most 
chaotic terrains are bounded by a sharp escarpment (Baker et al., 1992) and some form 
systems of terraces (Tanaka, 1986; Rodríguez et al., 2005a). According to Nummedal and 
Prior (1981) collapsed blocks tend to be smaller away from the main collapse 
escarpment. 
Most chaotic terrain appears at outflow channel heads (Baker et al., 1992) and are 
therefore interpreted to be the collapsed source regions for the outflow channels. Aram 
Chaos for example is one of the possible source regions of the Ares Vallis outflow 
channel (Figure 2.3). Current consensus is that chaotic terrain subsided after a 
catastrophic release of water (e.g. Masson et al., 2001; Baker, 2001). The water was 
possibly released do to pore pressure buildup (Carr, 1979) or liquefaction (Nummedal 
and Prior, 1981) and fluidization (Komatsu et al., 2000). Liquefaction is the collapse of 
grains of water-saturated sediment. Fluidization is the fluid like behavior of water-
saturated sediment when the grains become suspended in the stream. 
The water could have been stored as: 

1. Ice. 
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2. Liquid water in a high-pressure confined aquifer below the cryosphere (Carr, 
1979) or in a cavern system of fractures formed by impacts (Rodríguez et al., 
2005a) 

3. Bounded within evaporite deposits (Montgomery and Gillespie, 2005), methane 
hydrate (Max and Clifford, 2001) or CO2 clathrate (Komatsu et al., 2000). When 
heated these materials would dewater and/or degas resulting in volumetric 
expansion and subsequent explosive release. 

According to Max and Clifford (2001) various triggers for the catastrophic events have 
been proposed: global or regional warming, subsurface igneous activity, local deposition 
or erosion, impacts or tectonic activity. Wang et al. (2005) proposed that impacts 
producing craters larger then 100 km in diameter could trigger liquefaction of water 
saturated sediments on a global scale, resulting in catastrophic release of ground water. 
Mouginis-Mark (1985) and Chapman and Tanaka (2002) favor volcano-ice interactions 
as the trigger for catastrophic outflow. Heat from volcanic activity could melt subsurface 
or ground ice and thin the cryosphere (Masson et al., 2001) triggering catastrophic 
release. Catastrophic outflow itself could perhaps also trigger new outflow: according to 
Coleman (2005) catastrophic outflow from Aromatum Chaos (Figure 2.1) carved into the 
cryosphere, forming Ravi Vallis. This lowered the overpressure, triggering the formation 
of secondary chaotic terrain downstream (Iamuna Chaos, Oxia Chaos and an unnamed 
chaotic terrain). 
The location of chaotic terrain could be structurally controlled. According to Schultz et 
al. (1982) chaotic terrain preferentially occur in concentric weakness zones of 
multiringed impact basins. Cabrol et al. (1997) proposed that the intersection of Tharsis 
related concentric wrinkle ridges and radial normal faults caused weakness zones where 
the cryosphere was penetrated by magmatic material.  Aqueous fluids and/or magma are 
both likely to follow pre-existing fracture systems. Rodríguez et al. (2005a) for example 
proposed that the hydrogeology of Mars was significantly influenced by impact craters 
and their associated radial and concentric fracture systems.  
Chaotic terrains lie 1−2 km below the surrounding undisturbed terrain (Masson et al., 
2001) and could perhaps also have been depositional environments. Ori and Mosangini 
(1998) for example investigated Hydraotes Chaos (Figure 2.1). They found it first formed 
as a chaotic terrain but changed into a depositional environment. This occurred when its 
associated channels were captured by catastrophic water release from the Valles 
Marineris chasmata. 
Not all areas defined as chaotic terrain are favorably formed by subsidence due to 
catastrophic outflow. Howard and Moore (2004) for example investigated Gorgonum 
Chaos in Terra Sirenum (Figure 2.1). They found that the, previously as ‘chaos’ defined, 
flat-topped mesas, originated from a continuous unit. This unit was subsequently 
preferentially eroded at linear zones of weakness, possibly cracks caused by an 
overburden of ice. 
According to Baker et al. (1992) chaotic terrain cannot account for the amount of 
material needed to form the outflow channels. An explanation could be the erosion of 
earlier chaotic terrain by later outflow events. Or perhaps a recharge mechanism was 
active. Recharge by groundwater flow from a higher topographical region, such as 
Tharsis (Harrison and Grimm, 2004) or the South Pole (Clifford, 1987; Masson et al., 
2001) have been proposed. Rodríguez et al. (2005a,b) proposed a model of enormous 
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subsurface impact fracture controlled caverns which episodically released water, possibly 
due to magmatic heating. 
For a summary of all the mentioned chaotic terrain hypotheses and their predictions see 
Table 2.3. 
 
2.4.2.4. A possible ocean and lakes? 
According to Masson et al. (2001) calculations show that the catastrophic floods released 
at least 6 × 106 km3 of water into the northern lowlands (Figure 2.17). The floods around 
Chryse Planitia alone carried 6 × 106 km3 of eroded sediments. Under current conditions 
it is possibly that the freezing of so much water would form an ice cover, protecting 
against further evaporation (Masson et al., 2001). It is possible that this water remains as 
subsurface ice deposits or it sublimed and is now redistributed. 
The existence of the outflow channels flowing into the northern lowlands led to the 
suggestion that an ocean or multiple lakes existed during the Hesperian (Masson et al., 
2001). This is evidenced by ridges on the dichotomy boundary, interpreted as possible 
shorelines (Head et al., 2001). The presence of these possible shorelines is however still 
under debate, a study of high-resolution MOC images for example did not confirm the 
shoreline interpretation (Baker, 2001) and Withers and Neumann (2001) studied MOLA 
data of possible shorelines and interpreted these as wrinkle ridges. 
During the Late Hesperian until the Early Amazonian the ~100m thick Vastitas Borealis 
Formation (VBF) was deposited in the northern lowlands, covering 17.6 × 106 km2 (12% 
of the surface of Mars) (Figure 2.18) (Tanaka et al., 2003). The VBF has been interpreted 
as sediment (deposited in an ocean or by a debris flow) or as lava flows (Nimmo and 
Tanaka, 2005; Fishbaugh and Head, 2001). On parts of its surface 3 to 20 km sized 
polygonal patterns occur, which have been explained related to (1) tectonic uplift, 
perhaps caused by a disappearing load of water or (2) cooling of wet catastrophic flood 
deposits above frozen ground (Baker, 2001; Masson et al., 2001). 
There is evidence for Late Hesperian to Middle Amazonian lakes in a large number of 
impact craters in the southern highlands, connected to valley networks and channels 
(Cabrol and Grin, 1999; Baker, 2001; Head et al., 2001). One such possible crater lake 
lies within Gusev crater, where the MER Spirit landed. Spirit however mostly found 
basaltic rocks, although one rock provides evidence for water alteration (Haskin et al., 
2005). 
Recently the MARSIS radar on board MEX identified a 250 km diameter subsurface 
crater within Chryse Planitia, not visible in satellite images and MOLA data, which has a 
~1 km thick water ice deposit (Picardi et al., 2005). 
 
2.4.3. Amazonian Period 
The Amazonian Period started 2.9 – 3.3 Ga (Hartmann and Neukum, 2001) and continues 
until today. Volcanism, tectonics and water flow were active in the Amazonian but on a 
much more limited scale then during the two previous periods and occurring episodically. 
Volcanism mainly occurred at the Tharsis Bulge (Alba Patera, the Tharsis Montes, 
Olympus Mons) and at Elysium Mons (Tanaka et al., 1992). According to Neukum et al. 
(2004) Olympus Mons for example episodically erupted 900, 400 and 50 Ma. Overall 
they found evidence for repeated volcanic activity on Mars the last billion years. 
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Catastrophic outflow channels and some valley networks formed during the Amazonian, 
mostly associated with volcanic activity (Head et al., 2001). 
During the Late Amazonian, which started 0.3 – 0.6 Ga (Hartmann and Neukum, 2001), 
Polar Layered Deposits formed on top of DAF in the South Polar Region and VBF in the 
North Polar Region (Head et al., 2001). DAF and VBF are Hesperian aged surfaces, 
which implies a hiatus of perhaps billions of years. Head et al. (2001) suggest polar 
deposit formation and destruction occurred multiple times. Fishbaugh and Head (2001) 
suggest perhaps polar wander brought the poles to their current position. 
 
2.4.3.1. Recent and present day Mars 
According to Hartmann (2005) the youngest lava flows, younger then 50 Ma occurred at 
Elysium Planitia, Olympus Mons on the Tharsis Bulge and Amazonis Planitia. Neukum 
et al. (2004) found ages as recent as 2.4 Ma for lava flows at Olympus Mons. According 
to Head et al. (2001) volcanism at Elysium Planitia is associated with recent activity (10 
Ma or less) of the Marte and Athabasca Valles outflow channels. At the foot of 
Athabasca Vallis, Murray et al. (2005) found evidence for a 3-7 Myr old ice-covered lake 
measuring 72 × 104 km2 and possibly 45 metres deep. On a smaller scale Malin and 
Edgett (2000) observed numerous gullies on hillslopes on MOC images. They attribute 
these to recent groundwater seepage and surface run-off. Hartmann (2001) suggests the 
gullies result from geothermal heating which melts subsurface ice layers producing 
aquifers. OMEGA however did not detect hydrated minerals within the gullies (Bibring 
et al., 2005). 
Although volcanism and water flow probably have occurred in the recent past, aeolian 
activity is currently the dominant process on Mars. This is evidenced by the occurrence 
of global dust storms, dust devils, wind streaks and numerous dune fields, including an 
enormous dune sea in the north (Fishbaugh and Head, 2001). The dunes are very recent, 
less then 1 Myr old (Hartmann, 2005). The surface of Mars today is around 40% 
Noachian in age and around 50% is of volcanic origin (Solomon et al., 2005; Head et al., 
2001). 
 
2.5. Summary 
The different events previously discussed have been summarized in Figure 2.19. 
 

23



3. Regional geology 
 
3.1. Introduction 
Aram Chaos is a chaotic terrain (Figure 2.1) located 2.5ºN and 338.5ºE, in the Xanthe 
and Margaritifer Terrae (XMT) region (Figure 3.1). In the Hesperian and into the 
Amazonian the XMT region has been dissected by six of the circum-Chryse outflow 
channels: Shalbatana, Simud, Tiu, Ares and Mawrth Valles (Figure 3.1). This section will 
describe the regional geological history of XMT and the more detailed geological history 
of Aram Chaos. 
 
3.2. Regional History 
The XMT region has been mapped by Scott et al. (1987) (1:15M scale), Rotto and 
Tanaka (1995) (1:5M), Tanaka (1997), Nelson and Greeley (1999) (1:2M) using Viking 
images. Tanaka et al. (2003, 2005) (1:15M to 1:7.5M) used Viking, MOC and THEMIS 
visible and infrared images, MOLA elevation and TES multispectral data to map part of 
the XMT region focusing on the evolution of the northern lowlands (Figure 3.2). Tanaka 
(1997) elaborates on the USGS map by Rotto and Tanaka (1995). For this regional 
history I will refer mainly to the most recent study, Tanaka et al. (2005). 
 
3.2.1. The Noachian 
Tanaka et al. (2005) distinguishes between two Noachian aged units in XMT, the Libya 
Montes unit (Nl), of Early to Middle Noachian age, and the Noachis Terra unit (Nn), of 
Middle to Late Noachian age (Figure 3.2). Nn is highly degraded by impacts and is 
dissected by valley networks. It embays the older higher relief Nl, which is also highly 
degraded by impacts. Nl completely surrounds Aram Chaos. They interpreted Nn and Nl 
to be volcanic and sedimentary material. 
North of XMT the Chryse Planitia 1 unit (HNCc1) occurs, which is Late Noachian to 
Early Hesperian (Figure 3.2). It embays Nl and Nn and it is interpreted to be a mass 
wasting deposit. It is covered by wrinkle ridges. 
 
3.2.2. The Hesperian and Amazonian 
Three Late Hesperian aged flooding related units occur around Aram Chaos (Figure 3.2): 

1. The Simud Vallis unit (HCs) 
2. The Ares Vallis unit (HCa) 
3. The Chryse Planitia 4 unit (HCc4) 

HCs is the most widespread in XMT and forms Simud, upper Tiu, Shalbatana Valles and 
Hydraotes, Hydaspis and Aram Chaos. It cuts into HNCc1 and grades into HCc4 towards 
Chryse Planitia (Figure 3.2). HCa forms deposits in Ares and lower Tiu Valles, southern 
Chryse Planitia and Iani Chaos. Its surface is covered by irregular pits, linear scarps and 
grooves. HCa is interpreted to be of possible igneous origin, because of its olivine-rich 
TES signature. The observed pits could be caused by thermokarst processes. HCc4 also 
forms part of the Ares Vallis floor where it embays HCa. It is interpreted to be a deposit 
from Simud and Tiu Valles flows. 
The crater floor unit (AHcf) of Early Hesperian to Early Amazonian age covers some 
crater floors, including Aram Chaos, where it is layered (see 3.4. Geology of Aram 
Chaos). According to Glotch et al. (2005) layered deposits similar to Aram Chaos occur 
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in Aureum, Iani and Arsinoes Chaos. The Early Hesperian to Late Amazonian Crater unit 
(AHc) forms the ejecta, rim, and floors of craters. 
 
3.3. Regional Igneous Activity and Structural Geology 

1. Using MOLA data Rodríguez et al. (2005b) identified a transition from highland 
terrain to lower elevated chaotic terrain. They attribute this transition to different 
degrees of ground subsidence due to withdrawal of water from a subsurface 
linked impact fracture system (Rodríguez et al., 2005a). 

2. According to Schultz et al. (1982) Chryse basin is a multiring impact basin which 
influenced the formation of Valles Marineris and controlled the location of 
chaotic terrain. These form preferentially at locations concentrically to Chryse 
and intersecting Valles Marineris and other impact basins (Figure 3.3). 

3. Lanz and Jaumann (2001) identified cone-shaped hills in Aram Chaos which are 
up to 2 km in diameter and several hundreds of meters high. They interpreted 
these to be possible magmatic intrusions. 

4. Rodríguez et al. (2005b) observed 'quasi-circular structures', ~1 km in diameter, 
in the eastern part of Hydaspis Chaos (around 2.6719°N, 334.5755°E), which they 
interpret as resembling ring dikes. 

5. Olivine was detected on the floor of Ares Vallis, NE of Aram Chaos (Rogers et 
al., 2005) 

 
3.4. Regional Geophysics 
A negative gravity anomaly has been observed at Valles Marineris, Chryse Planitia, into 
the northern lowlands (Smith et al., 1999) (Figure 3.4). The negative anomaly over 
Chryse Planitia is interpreted to be caused by the removal of ~2 km of material by 
outflow channel erosion. According to Smith et al. (1999) Chryse Planitia does not show 
the same anomaly as other northern hemisphere impact basins. According to Phillips et 
al. (2001) Chryse Planitia is part of the Tharsis trough, a topographical low surrounding 
the Tharsis Bulge, caused by the loading of the lithosphere by the Tharsis Bulge. 
Chryse Planitia, like the Hellas, Argyre, Isidis and Utopia impact basins doesn’t show 
remanent magnetization. The ridged plains of the Tharsis Bulge near Valles Marineris 
also do not show magnetization (Connerney et al., 2005). The heavily cratered terrain of 
XMT however are magnetic. 
Recently the MARSIS radar on board MEX identified a 250 km diameter subsurface 
crater within Chryse Planitia, not visible in satellite images and MOLA data, which may 
have a ~1 km thick water ice deposit (Picardi et al., 2005). 
OMEGA detected phyllosilicates (montmorillonite) in light toned Noachian aged 
deposits near, and in the flanks of Mawrth Vallis (between elevations -3200 and –2700 
m) (Poulet et al., 2005). 
 
3.5. Geology of Aram Chaos 
 
3.5.1. Introduction 
Aram Chaos is a 280 km diameter circular chaotic terrain, located within a 550 km in 
diameter multiringed impact basin, Aram Basin (Schultz et al., 1982). Ori et al. (2004) 
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observed that the chaotic terrain cut into the crater rim, enlarging the inner depression. 
They didn’t observe a central crater peak. 
Aram Chaos is interpreted to be one of the Ares Vallis outflow channel source regions. It 
is connected to Ares Vallis via a 15 km wide, 2.5 km deep channel (Glotch and 
Christensen, 2005). Cabrol and Grin (2002) observed a possible sublacustrine delta 
structure at in the Aram Chaos part of the channel (Figure 3.5). 
According to Nelson and Greeley (1999) 1.9 × 105 km3 material was eroded and removed 
from Ares Vallis alone and its chaotic terrain, and the floods could have reached a rate of 
7 × 107 m3/s. Mars Pathfinder landed on the mouth of Ares Vallis. Boulders of 7 m in 
diameter were identified by the Pathfinder Camera Team and possibly conglomerates. 
Outflow rates at the landing site were estimated between 106 and 107 m3/s. 
 
3.5.2. Previous mapping 
Schultz et al. (1982) created a simple terrain map of the Aram Chaos region using Viking 
data (Figure 3.6). Detailed mapping of Aram Chaos, using TES, THEMIS, MOLA and 
MOC data, was performed by Glotch and Christensen (2005). They distinguish between 
two classes, disrupted (chaotic) terrain and nondisrupted (layered) terrain. The emphasis 
of their research is on the evolution of the layered terrain, in which a hematite signature 
was detected (see 3.4.1. Hematite formation). The layered terrain are interpreted to be 
deposited after the formation of the chaotic terrain.  
Glotch and Christensen (2005) divide the chaotic terrain into three, possibly lateral units 
(Figures 3.7 and 3.8): 

1. The largest unit, the Fractured Plains unit (Cf), almost completely surrounds the 
crater rim. It consists of up to tens of kilometers sized slumped blocks forming a 
curvilinear fracture pattern. 

2. The second largest unit, the Knobby Terrain unit (Ck and Ckh, containing 
hematite), occurs in the central part of Aram Chaos and at some locations 
surrounds the crater rim. It consists of km scale irregular blocks (“knobs”). 

3. The High Thermal Inertia Chaotic Terrain unit (Cht and Chth, containing hematite) 
occurs in the central part of Aram Chaos. Using superposition relationships 
Glotch and Christensen (2005) interpreted it to underlie outcrops of layered 
material. 

The layered terrain are divided into five units, from lowest to highest, which form a dome 
(Figures 3.6 and 3.7N): 

1. The Cap unit (Pc), which has a relatively high thermal inertia. MOC images show 
it to have an etched surface on which dark sand is trapped. Pc was observed to be 
~200 m thick at the top of the dome and it is thinning to the west. 

2. The Subdued unit (Ps) and the Primary Hematite unit (Ph), which are possibly 
laterally connected. They differ in the presence of hematite. The thickness of Ph is 
100-150 m. Ph has the highest hematite abundance compared to the other hematite 
units. 

3. The Secondary Hematite unit (Ph2), is interpreted to be draped onto older terrain 
(it occurs within a ~500 m elevation difference), containing transported hematite. 

4. The Non-Hematite unit (Pnh) lies below Ph and is observed to be 
geomorphologically the same as Ph. TES however indicates it is mineralogically 
the same as Ps. It is however thicker then Ps and has more distinct layering. 
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A sixth non-chaotic unit is the Outflow Plains unit (Po). This occurs at Aram Chaos side 
of the 15 km wide channel connecting Aram Chaos with Ares Vallis. It contains 200-300 
m deep tributaries. 
Using remote sensing a variety of minerals have been detected within the layered 
material. A ~5000 km2 deposit of grey crystalline hematite has been detected using TES 
data (Glotch and Christensen, 2005). Glotch and Christensen (2005) favor an aqueous 
deposition model for the formation of the hematite. OMEGA did not detect grey 
crystalline hematite at Aram Chaos, although red particulate hematite has been observed 
(Combe et al., 2005). OMEGA also detected hydrated minerals and sulfates in the layered 
deposits (Bibring et al., 2005; Gendrin et al., 2005). 
 
3.5.3. Hematite formation 
Crystalline gray hematite (α-Fe2O3) has been detected by TES in Aram Chaos, Meridiani 
Planum, Valles Marineris (associated with its Internal Layered Deposits) and Aureum 
Chaos (Christensen et al., 2001; Glotch et al., 2005). 
According to Christensen et al. (2001) hematite can form by three processes: (1) 
acqueous or hydrothermal deposition, (2) laterite-style or subareal weathering or (3) 
thermal oxidation of Fe-rich lavas. Weathering mostly forms red hematite and lava flows 
have not been observed at the Mars hematite locations. Therefore they favor acqueous or 
hydrothermal deposition. Catling and Moore (2003) studied Aram Chaos and performed 
geochemical modelling. They favor formation of the Aram Chaos gray hematite in a 
hydrothermally charged aquifer with 100ºC or greater temperatures. 
The MER rover Opportunity found a large amount of spherical hematite concretions 
(“blue berries”) in an outcrop in Meridiani Planum (Squyres and Knoll, 2005). The 
outcrop occurs in the walls of the 150 m diameter and 20 m deep Endurance crater. It 
consists of an at least 7 m thick sedimentary sulfate-rich aeolian sand stone formation 
(Burns formation). In some units large scale cross bedding occurs, interpreted to be 
caused by subaqueous deposition. The whole formation is interpreted to be formed in an 
arid environment. Occasionally surface water flow and pooling occured after which the 
water evaporated. The formation of the spherical hematite concretions is attributed to 
ground water alteration after deposition of the sands. 
 
3.6. Scenarios 
Two main sources for the fluvial activity within the XMT region have been described: 

1. A Vallis Marineris source. Nelson and Greeley (1999) for example identified 
multiple stages of channel floods in the XMT region, starting with a sheetwash 
flowing from Valles Marineris into Chryse Planitia. This was possibly triggered 
by early Vallis Marineris rifting. According to their study Ares Vallis was active 
during multiple stages with subsequent erosion and redeposition. 

2. An Argyre Planitia source. Parker et al. (2000) and Grant and Parker (2002) 
describe a channel system, starting at Argyre Planitia and flowing towards Chryse 
Planitia via Ares Vallis (Figure 3.9). According to their study the water ponded in 
Margaritifer Basin, south of Aram Chaos (Figure 3.10). This water was 
subsequently released carving Ares Vallis. According to Nelson and Greeley 
(1999) multiple episodes of Ares Vallis channel formation occurred. 
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Schultz et al. (1982) devised a typical cross section for multi-ring impact basins on Mars, 
larger then 300 km in diameter, such as Aram Basin (Figure 3.11 and Table 3.1). They 
interpreted the Aram Chaos chaotic terrain to be occurring, within a ring graben, in zone 
D of the cross section (Figure 3.11 and Table 3.1). The fault between zone D and E 
(Figure 3.11 and Table 3.1) is interpreted to provide a conduit for extrusive and intrusive 
volcanism and associated hydrothermal activity. According to Schultz et al. (1982) no 
large-scale extrusive volcanism occurred at Aram Chaos. The hydrothermal activity 
caused the release of ‘hydrothermal slurries’, which led to the chaotic terrain collapse, 
and the formation of outflow channels. 
They proposed that impact related concentric weakness zones influenced the spatial 
pattern and location of Aram Chaos, Ares Vallis and two nearby chaotic terrain: Iani and 
Hydaspis Chaos. Iani and Hydaspis Chaos both sourced Ares Vallis. 
Glotch and Christensen (2005) proposed that Aram Chaos underwent multiple stages of 
development (Figure 3.12): 

1. The chaotic terrain was formed by catastrophic outflow from a subsurface aquifer. 
The triggering event of the chaotic terrain formation is unknown. Possibly 
volcanism underneath Aram Chaos triggered the catastrophic outflow. The three 
chaotic terrain units are interpreted to have a different disturbance, with Cf the 
least disturbed, then Cht and Ck the most disturbed. According to Glotch and 
Christensen (2005) this could be caused by: 

a. Differences in the pre-chaotic terrain composition. 
b. Lateral differences in the subsurface water content. 
c. Different chaotic terrain processes in time. 

2. The layered material was subsequently deposited in a lacustrine environment. 
3. A doming event tilted the chaotic terrain and layered material. This fractured the 

layered material causing resurfacing of chaotic terrain at some locations. 
 
3.7. Discussion 
This section discusses the hypotheses described in 2. Mars Background and in this 
section, which are of importance to the formation of Aram Chaos. Table 2.3 summarizes 
all the chaotic terrain formation hypotheses and their predictions described in the 
literature. The following predictions can possibly be identified using geological mapping: 

1. (Subice) volcanism and/or (dike) intrusion (hypotheses 1, 3, 4, 5, 6, 8, 9 of Table 
2.3). 

2. Uplift prior to subsidence (2, 3, 5, 7). The fracture patterns of uplift type fractures 
(f.e. salt domes) and collapse/subsidence type fractures (f.e. calderas) will be 
compared with the observed chaotic terrain fracture patterns. 

3. Chaotic terrain occuring preferentially in low elevations (2, 3, 5, 7). This can be 
verified using MOLA and/or HRSC DTM data. 

4. A gradient in topography causing failure (3). 
5. A high water content of sediment (3, 6, 10) can perhaps be identified using 

OMEGA data and/or geomorphological observations. 
6. Chaotic terrain at crossing of perpendicular lineaments (5) 
7. Chaotic terrain similar to terrestrial analogs (6, 7). The different fracture patterns 

will be compared. 
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8. Dewatering of evaporite deposits (9) can perhaps be identified using OMEGA 
data. 

9. Chaotic terrain within outflow channel (11). 
10. Attempting to prove that chaotic terrain formed by impacts causing seismic 

activity (2, 3, 7, 10) is considered futile due to the occurrence of chaotic terrain in 
impact saturated Noachian terrain. 
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4. Methodology 
 
4.1. Introduction 
This section will describe the different methods used to map and investigate Aram Chaos. 
The image data had to be processed before it could be used. This included the 
georeferencing of the data so that each image pixel correlates with a coordinate. The data 
was subsequently imported into a Geographical Information System (GIS) created using 
the software product ESRI ArcGIS. This software was used to perform the mapping and 
analysis. 
 
4.2. Software 
The following software was used for the investigation: 

1. Integrated Software for Imagers and Spectrometers (ISIS) v2.1 from the USGS 
(Linux/Unix) (http://isis.astrogeology.usgs.gov) 

2. VICAR routines created by DLR to manage HRSC data (Linux/Unix) 
3. IDL routines created by the OMEGA science team to manage OMEGA data 

(Linux/Unix) 
4. IDL/ENVI from RSI (Windows/Unix) 
5. ENVI reader for ArcGIS v1.1 (http://www.ittvis.com/download/download_splash 

.asp?wdiid=548). 
6. ESRI ArcGIS (Windows) 
7. ImageMagick (http://www.imagemagick.org) to create JPEG2000 files from tiffs 

(Linux/Unix/Window). 
8. PEDR2TAB program (http://pds-geosciences.wustl.edu/missions/mgs/mola 

software.html#PEDR2TAB) to handle MOLA PEDR files. 
9. GEOrient to create Rose Diagrams (Windows) 
10. Windows driver to access Linux partition (http://www.fs-driver.org/ 

download.html) 
11. Bzip2 for windows (http://gnuwin32.sourceforge.net/packages/bzip2.htm), to be 

able to unpack the HRSC data in windows. 
12. Wget for windows. This software is standard in Unix/Linux but has to be 

downloaded for windows (http://www.interlog.com/~tcharron/wgetwin.html). 
13. Geospatial Data Abstraction Library (GDAL) included in the FWTools package 

(http://fwtools.maptools.org/) 
 
4.2.1. ArcGIS arcscripts and addons 

1. ArcMap tweaks to enhance your productivity (http://arcscripts.esri.com/ 
details.asp?dbid=13306) 

2. Shapefile Repair Tool (http://arcscripts.esri.com/details.asp?dbid=13733) 
3. Create and add shapefile (http://arcscripts.esri.com/details.asp? dbid=11652) 
4. Overview window (http://arcscripts.esri.com/details.asp?dbid=11965). It creates a 

small overview window in the lower left of the ArcMap screen. It uses the lowest 
layer in the ArcMap table of contents as its background. 

5. Bookmarks2Shapefile (http://forums.esri.com/Thread.asp?c=93&f=1730&t=1884 
69#558092) 
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6. Copy & Paste Image Symbology (w/ Nulls) to Images and/or ImageCatalogs 
(http://arcscripts.esri.com/details.asp?dbid=13128) 

7. Geodesic (True) Distance Tool for ArcMap 8 or 9 (http://arcscripts.esri.com/ 
details.asp?dbid=12819) 

8. Lon/Lat Readout in Projection ArcMap 8.x or 9.x (http://arcscripts.esri.com/ 
details.asp?dbid=12841) 

9. Add X and Y Coordinates (Enhanced) for 9.x (http://arcscripts.esri.com/ 
details.asp?dbid=13618) 

10. Add Area and/or Length (http://arcscripts.esri.com/details.asp?dbid=12524) 
11. Find Polyline Angle (http://arcscripts.esri.com/details.asp?dbid=14234) 
12. Profile Tool v1.1 (http://arcscripts.esri.com/details.asp?dbid=14064) 
13. XTools Pro (http://www.xtoolspro.com) 
14. List MXD Sources (ver.2) (http://arcscripts.esri.com/details.asp?dbid=13780) 
15. Add Points At Crossings (http://arcscripts.esri.com/details.asp?dbid=13208) 
16. Circular Regression (http://arcscripts.esri.com/details.asp?dbid=14629) 

 
4.2.2. Adding and using arcscripts in ArcGIS 
Acrscript addons for ArcGIS come in the form of Visual Basic for Applications (VBA) 
macros, .dll files and ArcToolbox scripts. ArcToolbox scripts can be added to the 
ArcToolbox by right-clicking ArcToolbox and selecting Add Toolbox. 
The .dll files can be added to ArcMap, ArcScene or ArcCatalog via Tools > Customize > 
Add from file... In the Commands tab of the Customize window one or more new 
commands will appear (if not the appropriate category has to be selected). Each 
command can now be dragged and dropped to a toolbar, becoming a button. You can 
choose to save the new configuration in either the normal.mxt template or your current 
project .mxd file. 
VBA macros can be added to the project via Tools > Macros > Visual Basic Editor. In 
the left part of the VBE window a table of contents is located consisting of normal.mxt 
and your project .mxd file. Right click on one of them and select Insert > Userform or 
Insert > Module. Inserting the macro in your normal.mxt file means that the script is 
always available from ArcMap. The modules are .bas files, the userforms are .frm files. 
The userforms consist of the windows, buttons and events and the modules consist of the 
underlying code. The macros can be executed via Tools > Macros > Macros. They can be 
dragged to a toolbar as a button by choosing the Macros category in the Commands tab of 
the Tools > Customize window. 
 
4.3. Mars GIS definitions 
A GIS coordinate system consists of two parts, a geographic and a projected coordinate 
system. The geographic coordinate system is the representation used to model the planet. 
The projected coordinate system is the projection used to represent the data. 
 
4.3.1. Geographic coordinate system 
In 1971 the International Astronomical Union (IAU) defined two possible Mars 
geographic coordinate systems (Duxbury et al., 2002): 

1. East positive longitude and planetocentric latitude. Longitude is measured 
positive eastward, in the direction of Mars’ rotation. The planetocentric latitude of 
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a specific point on the surface is defined as the angle between the equatorial plane 
and a line from the center of Mars to that point (Figure 4.1). 

2. West positive and planetographic latitude. The planetographic latitude of a 
specific point on the surface is defined as the angle between the equatorial plane 
and the normal to an elliptical representation of Mars at that point (Figure 4.1). 

Two representations of Mars are possible, a sphere or an ellipse. In 2000 the IAU defined 
the geographic coordinate system for Mars to be a best-fit ellipse with a semi-major axis 
of 3396.19 km and a semi-minor axis of 3376.20 km. When a spherical representation is 
chosen planetocentric and planetographic latitude are the same, so planetographic latitude 
only makes sense when using an elliptical representation of Mars. 
The longitude system can be further refined. It can either be defined between 0° and 360° 
or between –180° and 180°. According to Trent Hare (personal communication) most 
GIS software prefer a 180° longitude system with a 0° central longitude. ArcGIS works 
with this combination and with the 360° longitude system, 180° central longitude 
combination (Figure 4.2) Two types of ArcGIS ready MOLA data for example can be 
downloaded from the USGS, a version using -180° to 180° and the 0° longitude as central 
longitude (central meridian) and a version using 0° to 360° and the 180° longitude. The 
two images are thus shifted 180 degrees. The prime meridian 0° longitude of Mars is 
defined as the middle of the Airy-0 crater (Malin et al., 2001). 
 
4.3.2. Projected coordinate system 
The most common projection type for Mars is ‘Simple Cylindrical’ (also called 
‘Equirectangular’ or ‘Equidistant Cylindrical’) and is a cylinder wrapped around Mars. 
The tangent line chosen here is the equator. An example is the USGS ArcGIS ready 
MOLA data. It is a Simple Cylindrical projected representation of the surface of Mars 
from 88N tot 88S (22528x46080 pixels), with a resolution of ~463 m/pixel (128 pix/deg). 
The geographical representation of Mars used is a sphere of 3396.19 km. It is referred to 
as the Mars_2000_Sphere model of Mars (the IAU2000 ellipse is referred to as the 
Mars_2000 model). 
With this projected coordinate system the equatorial region has the least latitude 
distortion and the polar region the most. Therefore special Polar Stereographic projected 
MOLA data can be downloaded from the USGS. Polar Stereographic projected data is 
projected on a plane with a normal parallel to the polar axis (Figure 4.3). The Mars 
Global Surveyor orbiter carrying the MOLA instrument is in a polar orbit and therefore 
the polar region has the highest data density (the highest resolution data is ~115 m/pixel 
(512 pix/deg)). The USGS Polar Stereographic projected MOLA data are projected onto 
a sphere with the Mars polar radius (semi-minor axis) of 3376.20 as radius. 
 
4.3.3. In practice 
In practice the IAU2000 elliptical standard is not widely used. This is due to some issues: 

1. The raw MOLA data, which has a global coverage, was measured relative to a 
sphere of 3396 km. Most planetary scientists use this data as the base in their GIS 
on which they project the other data. The USGS ArcGIS ready MOLA data was 
created by reprojecting the raw data on the 3396.19 Mars_2000_Sphere model.  

2. ISIS, the software used to create ArcGIS ready map projected MOC and THEMIS 
data only supports a spherical representation of Mars for the Simple Cylindrical 

32



projection equation (see http://isis.astrogeology.usgs.gov/Isis2/isis-bin//pdfs2.cgi? 
mappars). The VICAR software which was used to project the HRSC data 
however was able to project the data onto an ellipse. 

3. In ArcGIS the Simple Cylindrical projection equation uses a sphere, even if you 
define an ellipse. Polar Stereographic and Sinusoidal projections however do use 
the ellipse in their equations 

For my research I chose the -180 to 180 east positive longitude system which one version 
of the USGS MOLA data uses. The data uses the Mars_2000_Sphere model although in 
the label the Mars_2000 model was mentioned. Therefore I presumed the data used the 
IAU2000 ellipse. I also assumed the ISIS processed data used the IAU2000 definition. I 
assigned the IAU2000 projection for these data in ArcMap but because ArcMap only 
supports a sphere for Simple Cylindrical projected data only the 3396.19 km sphere 
radius was used, which was in agreement with the actual projection of the data. The 
VICAR processed HRSC data were reprojected using the IAU2000 definitions and 
therefore did not correlate well with the MOLA and THEMIS data. Therefore I propose 
to use the Mars_2000_Sphere model for all data. 
 
4.4. Image processing 
 
4.4.1. THEMIS processing 
 
4.4.1.1. The THEMIS data 
The THEMIS imager on board 2001 Mars Odyssey consists of a visual wavelength (VIS) 
and infrared wavelength (IR) camera. The VIS data has 5 bands and the IR data 9 bands. 
The data is available online (http://themis-data.asu.edu) as .QUB files, which are three-
dimensional data cubes. The first two axes form 2D images and the third axis are the 
different bands. The .QUB files used have been radiometrically calibrated and are named 
XoooooiiiRDR.QUB. RDR stands for Reduced Data Record. The Xoooooiii format 
makes the image id, with X either V (for VIS) or I (for IR), ooooo the orbit number and 
iii the image number. 
 
4.4.1.2. Selection and downloading 

1. THEMIS footprint shapefiles for ESRI ArcGIS were downloaded from 
ftp://ftpflag.wr.usgs.gov/dist/pigpen/mars/themis/footprints. They were created by 
Trent Hare from the USGS. I used the April 2005 release. The zipfile on the ftp 
site contains a THEMIS IR day, IR night and VIS footprint shapefile.  

2. Only the footprints covering the area of interest were selected and saved into new 
shapefiles. 

3. The attribute tables of the shapefiles contain the image numbers. These were 
extracted into textfile lists. 

4. Using a perl script (see Appendix A.1) ‘http://themis-data.asu.edu/img/browse/’ 
was added in front of each image number in the textfiles creating an image 
preview download list. 

5. The perl script download.pl (Appendix A.2) was used to download the image 
previews. It uses wget to download.. The downloaded images are .png images but 
do not have an extention, so in DOS ‘ren *. *.png’ was performed. 
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6. The image previews were visually examined and bad images were deleted. 
7. A .QUB file download list of the remaining images was made: 

a. In DOS ‘ren *.png *.’ and ‘dir/b *.>list’ was performed creating an image 
name list of the remaining images.  

b. The perl script thmurl.pl (Appendix A.3) was executed to create the .QUB 
file download list. These were subsequently downloaded using 
download.pl. 

 
4.4.1.3. Processing 

8. The .QUB files were processed to level 2 (map projected and radiometrically 
corrected) using Integrated Software for Imagers and Spectrometers (ISIS) 
version 2.1 from the USGS (http://isis.astrogeology.usgs.gov/Isis2/isis-
bin/isis.cgi) which works in Unix/Linux. 8-bit jpg images were created which can 
be used in ArcMap. For each .QUB file the following procedures were performed 
(for the script see Appendix A.4): 

a. The thm2isis program from ISIS, which converts the QUB files into an 
ISIS format. The files were given a .QUB.l1 extention. For KERNLST 
$ISISM01DATA/thm_kernels_both.def.N (N was at the time 8) was used 
containing the SPICE kernels (camera pointing data). This specific file 
uses fake pointing data if real pointing data isn’t available for an image. 
This is explained further in Mars Odyssey THEMIS Geometry Processing 
With ISIS section 12 (http://isis.astrogeology.usgs.gov/Isis2/isis-
bin//themis_processing.cgi). For LONSYS 180 was used and for LATSYS 
OCENTRIC (which is default).  

b. The dsk2dsk program from ISIS, which was used to extract one band from 
the multiband .QUB.l1 files. For IR day band 9 was used, for IR night 
band 2 and for VIS band 3. The resulting files were named .QUB.l1.1b. 

c. The thmirmc (for IR day and night) or the thmvismc (for VIS) programs 
from ISIS, which creates level 2 map projected files. The filenames have 
.irmc.cub or .vismc.cub extentions. MAPPARS was set to 
SIMP:0,OCENTRIC. For KMRES 0.1 was used for IR images and 0.019 
for VIS images. 

d. The dform program from ISIS, which was used to convert the 32-bit data 
to 8-bit .tif images and to extract location information to create .tfw world 
files. 

9. The convert program from ImageMagick was used within a perl script (Appendix 
A.5) to convert the .tif files to .jpg files with a jpeg2000 compression. The .tfw 
files were copied to .jgw files. 

10. The resulting .jpg and .jgw files were visually examined and divided in ‘normal, 
‘bad’ and ‘large’. The large images form the base of the mosaic. The ‘bad’ images 
were too bright, too dark or broken. They were only included if they covered 
otherwise uncovered terrain. The normal images were included if they covered 
otherwise uncovered terrain and if they had better quality then the large images.  

11. The images were ordered by location using a perl script (see Appendix A.6). 
12. The images were loaded in ArcMap. The best images were put on top and bad 

images were excluded. Using the arcscript ‘List MXD Sources’ a text file was 
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created of the Table of Contents of ArcMap containing the image numbers. A perl 
script created a list textfile of the irmc.cub or vismc.cub files (mc.lst) (for the 
script see Appendix A.7).. 

13. For IR day mosaicking the following procedures were performed (for the script 
see Appendix A.8): 

a. The b4equal program from ISIS, which calculates and puts statistical 
information in the vismc.cub or irmc.cub files. The MODE argument was 
set to SD, which means standard deviation is used to calculate the mean 
brightness of the overlap area of overlapping images. 

b. The equalizer program from ISIS, which will attempt to remove seams 
between images. It uses the information added by b4equal to calculate a 
best fit for brightness values of two overlapping images. 

c. The corrections are written into an ISIS script, which was executed. This 
creates new image files with a vismc.cub.l4 or irmc.cub.l4 extension. 

d. Because the files in the mc.lst are in a specific order ‘ls –1 *.l4>l4’ cannot 
be used within Unix. A perl script was used to rewrite mc.lst to l4.lst 
keeping the specific order (Appendix A.9). 

e. The noseam routine from ISIS, which uses a high pass and low pass 
boxfilter to remove seams of images before mosaicking. The program 
needs the latitude and longitude range, the boxfilter size in line and sample 
direction (11 was used for both). The TOP argument was set to NO which 
means that the first processed image is put on the top of the mosaic and 
the next image is put below this image, etcetera. 

f. Dform and convert were used to create a .jpg image mosaic and 
accompanying .jgw file. 

14. For IR night mosaicking the following procedures were performed (for the script 
see Appendix A.10): 

a. For IR night images mosaicking was performed using a perl script 
(Appendix A.11) which calls for the mosaic program without applying the 
noseam filters. This way the brightness variation is not distorted. 

b. Dform and convert were used to create a .jpg image mosaic and 
accompanying .jgw file. 

15. The mosaic.jpg file can now be opened in ArcMap. 
 
4.4.1.4. New release of THEMIS data 

1. The Januari 2006 release from ftp://ftpflag.wr.usgs.gov/dist/pigpen/mars/themis/ 
footprints was downloaded and both the April 2005 and Januari 2006 releases 
were opened in ArcMap. Only the newer footprints were selected by first 
selecting all the footprints in the new shapefile which were identical to the old 
shapefile. This was done using the Select By Location window (Selection > 
Select By Location). By right clicking the new shape file and choosing Selection 
> Switch Selection the new footprints were selected. 

2. The new images were downloaded, examined, processed to level 2 and converted 
to .jpg using the method described in the two previous sections. 

 
4.4.1.5. Difficulties 
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1. The computer crashed during b4equal processing. Next attempt halted with error 
that FILE_STATE=DIRTY. This can be bypassed by setting ‘setenv 
ISIS_IGNORE_INTEGRITY TRUE’ in the c shell 
(http://isis.astrogeology.usgs.gov/Isis2/isis-bin/isis_arch.cgi#9). 

2. The amount of THEMIS VIS was too big for selection so the individual map 
projected images were opened in ArcMap. 

3. It was attempted to create a seamed IR night mosaic (using the ISIS noseam 
routine) but this resulted in a black image. Therefore they were simply mosaicked 
together to create the THEMIS IR night mosaic. 

 
4.4.2. HRSC processing 
 
4.4.2.1. The HRSC imager 
The High Resolution Stereo Camera on board the European Space Agency (ESA) Mars 
Express (MEX) satellite is active since December 2003. The imager is a stereo camera, 
which means it contains multiple imagers, creating multiple images from different angles 
at the same time. These images can be combined to create anaglyphs and DTMs. 
Especially the possibility to create DTMs is valuable because the results are 1) more 
detailed then current MOLA DTMs and 2) each pixel is a true measurement, whereas the 
MOLA data is an interpolation of laser points. The highest resolution images are the 
nadir images (the imager points directly downwards to the surface). They can achieve a 
resolution <10 m/pixel. 
 
4.4.2.2. The HRSC data 
The HRSC images I used were not all available on the ESA Planetary Science Archive 
(http://www.rssd.esa.int/psa/). Most images had only just recently been acquired. The 
PSA on the other hand is updated every 6 months. The non-PSA images were provided 
internally by ESA. See Table 4.1 for a list of all the HRSC images used. 
A complete set of HRSC data consists of a high resolution nadir image, two stereo 
images, a red, green, blue and infrared wavelength image and two photometry images. 
The photometry images are no different then the stereo images. 
Most orbits I used contain a complete set of images. For some orbits however, due to a 
limiting data transfer rate, only the nadir and stereo images were taken so at least a DTM 
can be created. 
I used level 4 HRSC data, which is 8-bit and is orthorectified using a derived HRSC 
DTM. The processing level which is available on the PSA is level 2 and level 3. Level 2 
is unprojected 16-bit image data, level 3 is sinusoidal map projected 8-bit image data 
(and polar stereographic for the polar regions). The DTMs and level 4 data are not 
available on the PSA. 
All the level 2 and level 4 data available from Aram Chaos were acquired. The files have 
a bzip2 compression (.bz2 extension) and had to be decompressed (for windows ‘bzip2 
for windows’ was used). The level 2 data was used to create anaglyphs (see 4.4.2.4. 
Anaglyph creation). 
 
4.4.2.3. HRSC processing for ArcGIS 
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The specific processing described here is only possible at institutions/organizations where 
the VICAR routines from DLR are available, such as ESTEC. 

1. The VICAR environment was started (see Appendix A.12). The DLR specific 
routines were loaded by typing ‘dlr’ in the unix/linux shell. 

2. Level 4 infrared images (ir4) were downloaded and used as quick previews, to 
find out the data coverage. They were reprojected to Simple Cylindrical 
projection using the VICAR DLR program DLRMAPTRAN. The VICAR 
program VTIFF2 and the convert program from Imagemagick were used to create 
tiff (.tif) and jpeg2000 (.jpg) files, respectively (see Appendix A.13). A script was 
used to create world files for the jpg images (.jgw) (see Appendix A.14).  

3. The images were opened and observed in ArcMap. The orbits with a good 
coverage were selected. Of these orbits the highest resolution nadir (nd4) were 
acquired. Also the nadir data from orbits where no ir4 was taken were acquired.  

4. The images were reprojected and saved as jpg files. Some images resulted in 
oversized jpg files which could not be opened. For these images the reprojected 
data was split up in smaller files using DLRMAPTRAN (for the script see 
Appendix A.15). World files were created for each jpg image. 

5. For the easy observation of the PSA HRSC data in ArcGIS a hrsc2arcgis 
perlscript was created (see Appendix A.16) 

 
4.4.2.4. Anaglyph creation 

1. A script was used to create for each level 2 nadir (nd2) and stereo 1 (s12) pair 
stereo images (Appendix A.17). This script converts the data to 8-bit after which 
it is processed to level 3. First the s12 data is processed to level 3 (s13). The nd2 
data is then fitted to the s13 image during the level 3 processing. The script uses 
the following VICAR routines: HRFILL, DLRTO8, HRORTHO and VTIFF2. All 
except VTIFF2 are available in mini-vicar (http://pds-
imaging.jpl.nasa.gov/data/mex/mex/hrsc/mexhrsc_0001/software/minivicar.zip) 
(Linux/Unix).  Mini-vicar provides another program to convert to tiff or jpg. 

2. The image pair jpg files were opened in PhotoShop. Both images were copied and 
paste as layers in a new RGB image. Using the Levels window (CTRL-L) the nd2 
layer was set to only show green and blue. The s12 layer only showed red. In the 
Layers window ‘normal’ was changed to ‘screen’. 

3. A worldfile was extracted from the level 3 data so the anaglyph could be used 
within ArcMap. 

4. In ArcMap the resulting image has to be rotated 90 degrees to see 3D using 
red/blue or red/green glasses. The ‘Data Frame Tools’ toolbar was activated. This 
makes it possible to rotate the Data Frame so the HRSC anaglyphs can be easily 
observed. 

 
4.4.2.5. HRSCDTMs 

1. Accompanying HRSC DTMs (dt4) were downloaded and decompressed. The 
hrscdtm2arcgis.pl script was started which extracts header and georeference 
information and assigns correct elevation values (for the script see Appendix 
A.18). 
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4.4.3. MOC processing 
 
4.4.3.1. MOC within ArcGIS 

1. MOC footprint shapefiles for ESRI ArcGIS were downloaded from 
ftp://ftpflag.wr.usgs.gov/dist/pigpen/mars/moc/footprints. They were created by 
Trent Hare from the USGS. I used the Januari 2006 release, which is a reissue of 
the October 2005 release, using updated SPICE kernels (camera pointing data).  

2. I added the MOC_0_100m_SPICECORRECTED shapefile to ArcMap. 
3. In the Display tab of the Layer Properties window I checked ‘Support Hyperlinks 

using field:’ selecting ‘WEB_LINK’ and ‘URL’.  In the Fields tab all fields but 
the WEB_LINK field were turned off. 

4. The footprint can be clicked upon using the Identify button in the Tools toolbar. 
This opens a small window which shows the associated URL of the MOC image. 
By clicking on the URL a new browser window is opened. 

 
4.4.3.2. MOC georeferencing 
The attribute table of a selection of MOC footprints was saved to a text file. A perl script 
was created (see Appendix A.19) which downloads MOC images from www.msss.com 
and processes them to a map projection. Some MOC images are already processed and 
available online. Most MOC images however were available only as non map-projected 
images. Georeference and reprojection information was calculated using the latitude and 
longitudes of the image corners and the images widths and heights. The reprojection was 
performed by connecting to the ArcGIS geoprocessor within perl. Also the gdal_translate 
program from GDAL was used in the processing. 
 
4.4.4. MOLA processing 

1. MOLA Precision Experiment Data Records (PEDR) files were downloaded from 
the Planetary Data System (PDS) website (http://pds-
geosciences.wustl.edu/geodata/mgs-m-mola-3-pedr-l1a-v1/mgsl_21xx/data/). 

2. The PEDR2TAB program was downloaded and the pedr2tab.prm file was 
rewritten to contain the correct latitude and longitude extent. 

3. The ~22 GB of data was subsequently handled by PEDR2TAB which created a 
textfile with latitude, longitude and elevation columns. 

4. A perl script was written to convert the textfile to a CSV style (comma delimited) 
text file with X, Y, LON, LAT and Z columns (Appendix A.20). The X and Y are 
the coordinates of the MOLA points in the Simple Cylindrical projection used. 

5. The text file was added to ArcMap via Tools > Add XY Data., and was exported 
to a point shapefile. The MOLA point data was used to find the best cross section 
profile locations and to provide an estimate of the accuracy of the cross sections. 

 
4.4.5. OMEGA processing 
 
4.4.5.1. The OMEGA spectrometer 
The OMEGA (Observatoire pour la Minéralogie, l’Eau, les Glaces et l’Activité) imaging 
spectrometer on board the Mars Express is active since Januari 2004. With the OMEGA 
the identification of the mineralogical and molecular composition of the surface and 
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atmosphere of Mars is possible (Bibring et al., 2004, 2005). The orbit of Mars Express 
has a 86º inclination (almost a polar orbit) and an eccentricity of 0.6 (elliptical orbit). 
Because of this high elliptical orbit the OMEGA spatial resolution varies between 4 
km/pixel and 300 m/pixel. The high resolution observations lie close to the periapsis 
(nearest point) of the Mars Express orbit. OMEGA works only during the daytime. 
OMEGA is a hyperspectral scanner and acquires for each pixel 352 spectral channels 
(spectels) from the visible (0,36 μm) to the Thermal Infrared (TIR) (5,2 μm). This makes 
it possible to look at absorption features in the solar reflected spectrum and in the 
planetary thermal emission (4 μm and higher) (Bibring et al., 2005) (Figure 4.4). An 
increasing amount of spectels are not fully reliable, due to detector degradation by cosmic 
rays. 
OMEGA consists of three parts, a VNIR (Visible and Near Infra Red) and two SWIR 
(Short Wavelength IR) spectrometers. VNIR observes from 0.36 to 1.07 μm, with a 
spectral sampling of 7 nm. SWIR uses two spectrometers to observe from 0.93 to 2.7 μm 
(spectral sampling 14 nm) and from 2.6 to 5.2 μm (spectral sampling 20 nm). To be able 
to create one continuous spectrum the three different observations overlap. 
VNIR uses the pushbroom technique where pixels are acquired line per line, with a 8.8º 
field of view (FOV). It has 40 operation modes, for example a nominal (spatial × 
spectral) mode (128×96 with summation of 3×3 pixels), a high spectral resolution mode 
(64×144) and a high-speed mode (16×96) (Bibring et al., 2004). SWIR uses the 
whiskbroom technique where a scanning mirror moves crosstrack and can acquire 16 to 
128 pixels (1.1º to 8.8º FOV), dependent on the elevation above Mars. 
 
4.4.5.2. The OMEGA data 
The OMEGA data available for Aram Chaos was downloaded from the Planetary Science 
Archive (http://www.rssd.esa.int/index.php? project=PSA) from ESA. It consists of a 
QUB file and a NAV file. For each orbit on average 4 to 7 QUB and NAV files are 
generated, which are named ORBNNNN_1, ORBNNNN_2, etcetera, with NNNN the 
orbit number. The QUB file is a so called data cube, a 3 dimensional array of spatial (x 
and y) and spectral (λ) data. The spectral data consists of 352 spectral channels, divided 
in three overlapping parts belonging to the three OMEGA spectrometers, an IR C (128 
values), an IR L (128 values) and a VIS (96 values) part (also in this exact order in the 
QUB file). Each channel is 12-bit, which means it can have a brightness value between 0 
and 4095. 
The NAV file is also a data cube (geocube) and contains spatial (x and y) and geometry 
information. It contains for example for each data pixel the longitude, latitude, altitude 
from Mars’ center and altitude above the MOLA elevation. Because the IR C, IR L and 
VIS parts are measured by three different spectrometers they also have their own 
positioning information. There is also an offset of a couple pixels between the VIS 
channel and the IR C channel. This implicates that when the latitude and longitude from 
the IR C part is used to create a projected hyperspectral image of all the 352 channels the 
VIS part doesn’t have to belong to that pixel, it could be a couple of pixels offset. 
 
4.4.5.3. Atmospheric correction 

1. IDL routines (SOFT03) were provided by the OMEGA science team. The 
routines perform a radiometric calibration, which is the conversion of the digital 
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numbers (DNs) into radiance (Wm-2sr-1) and ground reflectance. This results in 
“idat” data of which the spectrum looks like the solar irradiance curve (Figure 
4.5). The so called “jdat” data results after dividing the “idat” data by the solar 
irradiance curve. The result is now representative for the radiation at the top of the 
atmosphere. 

2. An atmospheric correction IDL routine was provided by the OMEGA science 
team. The routine only corrects the IR channels and does not correct for dust in 
the atmosphere. It only corrects for a small part of the atmospheric column (from 
the base to the top of the 27 km high Olympus Mons volcanoe on Mars). The 
purpose of atmospheric correction is to re-scale the “jdat” radiance data to “kdat” 
reflectance by correcting for atmospheric influences and shifting all spectra to 
nearly the same albedo. The result is a dataset in which each pixel can be 
represented by a reflectance spectrum which can be directly compared to 
reflectance spectra of rocks and minerals acquired either in the field or in the 
laboratory (Van der Meer and De Jong, 2003). 

 
4.4.5.4. OMEGA to IDL/ENVI 

3. The write_envi.pro IDL routine was provided by the OMEGA science team to 
create ENVI files. 

4. The omega_path file was edited to contain the correct location of the QUB and 
NAV files. 

5. The readomega.pro IDL routine was edited to handle command line execution 
(e.g. readomega.pro,’ORBNNNN_#’, to execute the atmospheric correction 
routine and to execute write_envi.pro to write all the data to ENVI format. This 
resulted in ORBNNNN_#_kdat files. 

 
4.4.5.5.  Splitting OMEGA 

6. Only the IR-C part of the data (0.93 to 2.7 μm) was used, which has 128 bands. 
The first band and last two bands were deleted because they had poor quality. 
Therefore 125 bands remained. The perl script OMEGAsplit.pl (Appendix A.21) 
was written to automatically split the OMEGA data in its IR-C, IR-L and VIS 
parts. Executing the script creates omegasplit.pro which has to be executed in 
IDL/ENVI. It creates ORBNNNN_#_kdat-IR-C, ORBNNNN_#_kdat-IR-L and 
ORBNNNN_#_kdat-VIS files. 

 
4.4.5.6. OMEGA Georeferencing 

7. A perl script writeOMEGAproj.pl (Appendix A.22) was written and executed 
which generates for each OMEGA set in the directory an IDL routine to 
automatically project the data. The projection parameters were set to a 
Equirectangular projection using a 3396190.0 m sphere. 

8. The following line was added to the map_proj.txt file in the 
IDL<version>\products\envi<version>\map_proj directory: 17, 3396190.0, 0.0, 
0.0, 0.0, 0.0, Mars Aram Chaos Equirectangular Sphere 

9. The batch of projection routines were saved by writeOMEGAproj.pl into 
OMEGAproj.pro which was subsequently executed in IDL (ENVI needs to be 
started also), creating ORBNNNN_#_PROJ files. 
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a. It uses ORBNNNN_#_lonlat (C channel footprint) to create 
ORBNNNN_#_GLT containing a Geographic Lookup Table (GLT) which 
is a projected ‘footprint’ of the data. The routine uses an automated 
version of the ENVI function ‘Build GLT’ (Map > Georeference from 
Input Geometry > Build GLT). 

b. It uses ORBNNNN_#_kdat and ORBNNNN_#_GLT to create the 
projected data. The routine uses an automated version of the ENVI 
function ‘Georeference from GLT’ (Map > Georeference from Input 
Geometry > Georeference from GLT). 

10. In ENVI via Basic Tools > Mosaicking > Georeferenced all the projected 
OMEGA data could be merged into one mosaic. 

 
4.4.5.7.  OMEGA in ArcGIS 

11. ENVI reader for ArcGIS (http://www.ittvis.com/download/download_splash 
.asp?wdiid=548) was installed which makes it possible to add ENVI data to 
ArcGIS. The ORBNNNN_#_PROJ files need to have an extension .DAT for 
ArcGIS to recognize the data. 

12. The whole dataset can be loaded into ArcMap, which makes it possible to show 
an RGB color composite of 3 bands by right clicking the OMEGA data layer > 
Properties > Symbology. One single band can be loaded into ArcMap by double-
clicking the OMEGA data in the Add Data dialog window and selecting the band. 

13. Within ArcMap a ‘History Equalize’, ‘Minimum-Maximum’ or ‘Standard 
Deviations’ stretch needs to be implemented to be able to show the data 
(otherwise the data is completely black). 

 
4.5. Mapping methodology 
 
4.5.1. Prior to mapping 

1. Prior to mapping the ‘ArcMap tweaks to enhance your productivity’ arcscript was 
installed. This enabled a variety of handy tools and shortcuts such as the 
possibility to open a shapefile in the Editor by right clicking the shapefile in the 
table of contents and selecting ‘Start editing this layer’. 

2. The ‘Create and add shapefile’ arcscript was installed so shapefiles could be 
easily creating within ArcMap. 

3. The Overview window arcscript was installed which enabled a small overview 
window showing the image at the bottom of the table of contents. The window 
shows the current view screen as a box. This box can be relocated and/or resized. 

4. The projection parameters were set to the projection the USGS MOLA data uses. 
 
4.5.2. Mapping 

1. Mapping was performed on a variety of line shapefiles. Distinct features were 
mapped on different shapefiles, e.g. ejecta blankets, fractures, craters and crater 
remnants, wind indicators, etcetera. Each shapefile had a Notes field in the 
Attribute Table where remarks and notes were added. 
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2. Interesting locations were saved using Bookmarks > Create. The 
Bookmarks2Shapefile arcscript was used to create a shapefile of the acquired 
bookmarks. 

3. The Lon/Lat Readout in Projection ArcMap 8.x or 9.x arcscript was used to easily 
find the latitude and longitude of a specific location. 

4. The boundaries of non disturbed and disturbed terrain and the channel boundaries 
were drawn. These are mostly escarpment boundaries. When mapping a boundary 
as an escarpment, the cliff itself belongs to the higher elevated unit. Therefore the 
boundary is drawn at the bottom of the escarpment. HRSC anaglyphs were used 
when available (see HRSC coverage). The data frame was rotated 90 degrees 
using the Data Frame Tools toolbar so that the HRSC anaglyphs could be used 
within ArcGIS. 

5. The HRSC data and THEMIS/MOLA are not aligned very well. The alignment is 
best in the middle of the map, and the southern and northern parts have the 
highest offset. Therefore shapefiles specific for HRSC and for THEMIS were 
used for mapping. 

6. Albedo differences occur in the Aram Chaos area. Albedo is possitively correlated 
with dust content of the surface. Only when albedo correlates well with 
differences in thermal inertia or with geomorphology it will be used to distinguish 
units. 

7. Thermal inertia is high for rocky surfaces and low for dusty surfaces. Most bright 
regions in the Aram Chaos area are escarpments, which are suspected to be rocky. 
Most dark regions are flat, which are suspected to be dusty. 

8. When there is no HRSC anaglyph available THEMIS and MOLA were used. 
9. Interesting locations were saved as ‘spatial bookmarks’. The VBA script 

Bookmarks2Shapefile was used to create a point shapefile containing the spatial 
bookmarks locations and their names in the Attribute Table. 

10. THEMIS IR day 50% visible above colored MOLA data were used as a means to 
include 3D information at locations where no HRSC Anaglyphs were available. 

 
4.5.3. Creating polygons 

1. The boundary lines were combined in one shapefile which was subsequently 
converted to a polygon shapefile. 

2. In ArcCatalog using ArcToolbox the line shapefile containing all the unit 
boundaries was converted to a polygon shapefile using ‘Data Management Tools’ 
> ‘Features’ > ‘Feature To Polygon’. For Cluster Tolerance 500 m was used. 

3. In ArcCatalog the polygon shapefile was given an appropriate name. By right 
clicking the layer and selecting Properties the Shapefile Properties window was 
opened. In the Fields tab ‘Unit’, ‘Name’, ‘Definition’ and ‘Notes’ were added in 
Field Name with Text as Data Type. 

4. The polygon shapefile was opened in ArcMap. The Properties window was 
opened by right clicking the layer and selecting Properties. In the Symbology tab 
‘Catagories’ was selected in ‘Show:’. In ‘Value Field’ Unit was selected and the 
‘Add Values’ button was clicked. In the Add Values window the numbers 1 to 10 
were added. The colors of the different unit numbers were adjusted. 
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5. The Editor toolbar was started for the polygon layer by right clicking the layer 
and selecting ‘Start editing this later’. In the Editor toolbar the Attributes button 
was pressed. The ‘Edit Tool’ was used to select a polygon. In the Attributes 
window for each polygon ‘Unit’ was give the appropriate number. 

 
4.5.4. Creating cross sections 

1. Simple profiles within ArcMap can be created using the 3D Analyst toolbar and 
the MOLA elevation data. Within the 3D Analyst toolbar the Interpolate Line 
button is clicked and a profile line is drawn in the view screen (one click creates a 
new line segment, double-click finishes the line). The Create Profile Graph button 
in the 3D Analyst toolbar draws the profile. The minimum and maximum 
elevation of the profile is needed for the cross section. All North to South cross 
sections follow MOLA tracks for highest data density. 

2. The Profile Tool v1.1 arcscript will be used to create geological cross sections. 
The downloaded .zip file contains Profile_Tool_v1.1.mxd which was started. This 
ArcMap project file contains a ProfileTool toolbar. The tool needs a polygon 
shapefile and elevation raster data. The mapping shapefile and MOLA elevation 
layer were added to the project and the NewProfile button in the ProfileTool 
toolbar was clicked. 

3. The cross sections are chosen using the MOLA point data such that less MOLA 
covered locations were avoided. By clicking the beginning and ending of the 
desired cross section line in the view screen the Profile Exporter window is 
opened. Division is chosen so that the profile is divided into ~500m parts (the 
resolution of the MOLA data). Vertical exaggeration is set to 10, ‘draw graphic 
for profile line’ is deselected, Map Base Units is set to meters and Build a profile 
box is selected. 

4. In the Setup Profile Box window the maximum and minimum elevation is 
provided and Use profile length is selected. Vertical and horizontal tick spacing 
are set to 500 and 5000, respectively (it will create a square box because the 
vertical exaggeration is set to 10). The Continue button is clicked, closing the 
Setup Profile Box window and ‘next step’ is clicked in the Profile Exporter 
window. 

5. The MOLA data, the mapping shapefile and the field indicating the geological 
units are set, the export folder is set to the desired folder and ‘last step’ is clicked. 

6. In the export folder three shapefiles have been created. 
a. Profile_line contains the lateral profile line and can be added to the 

project. 
b. Profile_intersection_points contains the points on Profile_line where 

geological boundaries occur. 
c. Profile_profile is the cross section itself and when added to the project will 

be visualized using North-South = Z, East-West = cross section line. 
7. The Profile_profile and Profile_line shapefiles were added to the project. In the 

Symbology tab of the Layer Properties window of the Profile_profile layer for 
Show ‘Categories’ was selected. For Value Field ‘Geology’ and ‘Add All Values’ 
was clicked. 

8. The Fractures line shapefile was added to the project. 
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9. The Add Points At Crossings macro was added to the project and in the Visual 
Basic Editor the first lines of the code where changed into: 
   Public Sub Example_AddPointsAtCrossings() 
          Call AddPoints("Fractures", "Profile_line") 
   End Sub 

10. A new point shapefile was added to the table of contents and the editor was 
started using Properties > ‘Start editing this layer’ by right clicking the point layer 
in the table of contents. The macro was started and the intersections where added 
to the point layer. 

11. New point shape files were added and points were created manually at the 
intersections of the line and the Light Toned Deposits and Small Scale Hills 
shapefiles. 

12. By only showing the Profile_line and Profile_box shapefiles in the viewscreen 
and selecting File > Export Map the cross section was exported to a 300 dpi .pdf 
file. The profile line and the Fracture intersections were similarly exported to .pdf. 
Some cross sections were alligned long MOLA tracks, therefore the screen was 
rotated using the Data Frame Tools toolbar until the cross section was horizontal. 

13. In Adobe Illustrator the .pdf files were opened and the intersections were fitted to 
the cross section. The cross section was further refined in Illustrator. 

 
4.5.5. Crater counting 

1. A multipoint shapefile is created in ArcCatalog by right-clicking > New > 
Shapefile and selecting MultiPoint as Feature Type. The shapefile is loaded into 
ArcMap and the Editor is started. 

2. For each crater 3 points along the rim are created. By double-clicking each third 
point the 3 point feature is created. 

3. The Circular Regression ArcToolbox is started with the shapefile as input and a 
text file as output. 

4. The output text file can be opened in excel as a comma-delimited text file and 
contains the X, Y and radius of the two centers of the ellipse. Because only three 
points where used the radii are almost the same and either one is chosen or the 
mean of both is taken. 

5. The resulting data can subsequently be further analysed using the XCage 
program. 

 
4.5.6. Mapping using OMEGA data 

1. OMEGA data covering the Aureum Chaos Deposits (ORB0456_1), the Iani 
Chaos Deposits (ORB0353_2) and the Aram Chaos Formation (ORB0401_3) 
were downloaded and processed (see 4.4.5. OMEGA processing). 

2. Because Mars is very dusty it was decided to divide the spectra by a mean dust 
spectrum. Regions with a bright albedo are high in dust. Therefore for each orbit a 
ROI of the brightest region was created (Figure 4.6) and a mean spectrum was 
saved to a library. The IDL function ‘Divide_By_Spectrum’ was created by 
Harald van der Werff which divides each pixel spectrum by a mean spectrum 
(Appendix A.23). To accomplish this the following steps were taken in 
IDL/ENVI per orbit: 
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a. In ENVI ‘File > Export to IDL Variable’ the image cube and the spectral 
library containing the mean dust spectrum were saved to IDL variables. 

b. In IDL the Divide_By_Spectrum function was loaded and compiled. 
c. In the IDL command line ‘result = 

Divide_By_Spectrum(image,spectrum)’ was executed which created the 
‘result’ IDL variable. 

d. In ENVI ‘File > Import from IDL Variable’ the RESULT was added to the 
‘Available Bands List’ window. 

3. The three dust and atmosphere corrected orbits were georeferenced and opened in 
ArcGIS. Per orbit a shapefile of the outcrops which cover the orbit was created, 
derived from the mapping (the shapes need to be inside the orbit extent). 

4. In IDL/ENVI the shapefiles were converted to ROI (Figure 4.7) and mean spectra 
were calculated: 

a. The georeferenced orbits were opened one at a time. 
b. Via Vector > Open Vector File > Shapefile the appropriate shapefile was 

opened. 
c. In the ‘Import Shapefile File Parameters’ window the output result is set to 

memory and ‘Mars Aram Chaos Equirectangular Sphere’ is selected as the 
projection. 

d. In the ‘Available Vectors List’ window the vector is loaded into the image 
display window (most likely Display #1). This opens the ‘Vector 
Parameters: Cursor Query’ window. Here the vector is exported to a 
Region of Interest (ROI) via File > Export Active Layer to ROIs > 
Convert all vectors to one ROI. 

e. In the image display window Tools > Region of Interest > ROI Tool is 
selected which opens the ROI Tool window. Here the mean spectrum of 
the ROI can be derived by clicking ‘Mean’. 

5. Band ratios of distinct absorption features within the mean spectra were created in 
IDL/ENVI using Band Math ((b1+b3)/2*b2) (Figure 4.8). The resulting images 
show high values where the absorption features are strongest. Only if the high 
value areas correspond with the ROIs you can use the OMEGA data for mapping 
purposes. 

 
4.6. Lineament Analysis 
 
4.6.1. Lineaments in ArcGIS 

1. Lineaments were drawn in ArcMap onto a polyline shapelayer. 
2. In ArcCatalog using ArcToolbox the multipart lines were split into single lines 

using ‘Data Management Tools’ > ‘Features’ > ‘Split line at Vertices’. 
3. The ‘Find Polyline Angle’ arcscript needs to be altered before it can be used 

because the current script rounds the angles to whole numbers. In the Visual Basic 
Editor (Tools > Macros > Visual Basic Editor) the FindPolylineAngle module is 
selected. 
o Dim getAngle As Integer, iAriAngle As Integer, iGeoAngle As Integer is 

changed into Dim getAngle As Double, iAriAngle As Double, iGeoAngle As 
Double. 
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o The occurrences of .Type = esriFieldTypeInteger are changed into .Type = 
esriFieldTypeDouble 

4. The ‘Find Polyline Angle’ arcscript is started. The Editor needs to be started 
before this script can be used and all lineaments have to be selected with the ‘Edit 
Tool’ button. The script adds an ARIANGLE and GEOANGLE field to the 
Attribute Table. The GEOANGLE field contains the correct angle. The edit needs 
to be saved via Editor > Save Edits. Sometimes the angles are not saved, check in 
the Attribute Table, and repeat the angle creation. 

5. The ‘Add Area and/or Length’ arcscript is started. The Editor needs to be closed. 
It adds a Length field to the Attribute Table. 

6. Using the ‘Add Points At Crossings’ arcscript the X and Y of the lineament center 
points were added to the Attribute Table. 

7. Lineaments were selected via the ‘Edit Tool’ and in the Attribute Table the 
selection was exported to a text file. 

 
4.6.2. Creating Rose Diagrams 

1. To create Rose Diagrams the software program GEOrient 9.2 is used. 
2. The software is started and the Rose Diagram button was selected. 
3. The text file exported by ArcMap is selected which opens the ‘File structure and 

data conventions’ window. In the ‘Plot as’ tab the ‘Primary data set’ is set to 
Directions. In the ‘Data Formats’ tab ‘Delimiter’ is set to comma and ‘First row 
contains column headings’ is selected. The column containing the directions is set 
to the GEOANGLE column number. 

4. In the ‘Appended Data’ tab ‘Numeric value’ was selected and set to Length. The 
column number is set to the Length column number. 

5. In the ‘Plot as’ tab the Lines button is pressed. This opened a new window in 
which the ‘Rose Type’ is set to ‘Length – Azimuth’ and the GO button is pressed. 
This creates a length-weighted Rose Diagram. 

 
4.6.3. Concentricity / Radiality 

1. This method uses the lineament shapefile with the GEOANGLE, Length and X, Y 
of the midpoint fields from 4.7.1. Lineaments in ArcGIS. 

2. The Concentricity / Radiality (C/R) of a lineament is defined as the angle between 
the lineament and a line through the lineament mid point and a specific location 
(f.e. the center of the Aram Chaos crater) (Figure 4.9). When this angle is 90 the 
lineament is concentric to the location, when this angle is 0 the lineament is radial 
to the location.  

3. A point shapefile is created and using the Editor the location of interest is added 
as a point. A copy of the fractures shapefile is added to ArcMap and in the Editor 
all the lineaments are selected. The Select By Location window is opened via 
Selection > Select By Location and all the lineaments outside a certain radius 
from the location in the point shapefile are removed from the selection. Via Edit > 
Cut all the selected lineaments are removed from the shapefile after which the edit 
is saved. 

4. The C/R of lineaments is calculated within ArcMap using a VBA script 
(Appendix A.24). Within the Attribute Table of the lineament shapefile a new 
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column is created via Options > Add Field (the Editor needs to be closed). By 
right clicking on the new field header and selecting Calculate Values the Field 
Calculator window is opened. ‘Advanced’ is selected and the script is pasted in 
the ‘Pre-Logic VBA Script Code’ textbox. In the lower text box Concentricity is 
typed. The script has to be altered to contain the correct Xcenter and Ycenter 
values of the midpoint to which the C/R is relative. 

5. The attribute table was exported to a .dbf file and opened in excel. In excel via 
Tools > Data Analysis > Histogram a histogram was created of the C/R. The Bin 
Range was set to a column with numbers ranging from 5 to 90, per 5 degrees. 
This created a new table showing 18 bins (0 to 5, 5 to 10, etcetera) with their 
respective lineament frequency. 

6. A length-weighted C/R histogram was created by multiplying for each bin its 
frequency with the summed lineament length of the bin divided by the total 
lineament length. 

 
4.6.4. Fracture Density 

1. The fracture density can be calculated using Spatial Analyst via Spatial Analyst > 
Density. For ‘Density Type’ simple is chosen. The resulting density raster has 
units of length per square kilometer. Per pixel the length of all the lineaments 
within a certain radius is divided by the area of the circle. By default the search 
radius is 1/30 and the cell size is 1/250 of the layer extent. 

 
4.7. Spatial Analysis 
 
4.7.1. Deriving the thickness of the Intermediate and Upper Aram Chaos Formation 

1. Using the MOLA processing method described in 4.4.4. MOLA processing a text 
file was generated of all the MOLA points surrounding the Aram Chaos LTD 
between 0.7 and 5.0 °N and -22.8 and -18.6 °E. The text file was imported in 
ArcMap via Tools > Add XY Data. The Editor was started and all the MOLA 
points were selected. 

2. The mapping polygon shapefile was added to ArcMap and the ACF polygons 
were selected (via Select > Select by Attributes). 

3. Via Selection > Select By Location the MOLA points contained by the ACF 
polygons were removed from the selection (Figure 4.10). A buffer of 500 m was 
applied. 

4. The selected MOLA points were exported to a shape file. 
5. The data was interpolated using Natural Neighbors, with a pixel size of 450 

m/pixel. NN has been used before to interpolate MOLA data (see 
http://pirlwww.lpl.arizona.edu/~abramovo/MOLA_interpolation/interpolation.htm
l). 

6. The polygons of the ACF were saved into a shapefile and the shapefile was 
subsequently converted to a raster via Spatial Analyst > Convert > Features to 
Raster. 

7. An estimation of the thickness of the ACF was calculated in the Raster Calculator 
(Spatial Analyst > Raster Calculator) using the following calculation: 
merge([MOLA] - [InterpolationRaster] – [ACFRaster], [InterpolationRaster] / 
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[InterpolationRaster]). This creates a raster with only thickness information at the 
raster pixels covering the ACF, the other pixels have value 1 (caused by 
[InterpolationRaster] / [InterpolationRaster]). The extent of the raster is the same 
as InterpolationRaster. 

 
4.7.2. Deriving the volume-loss of Aram Chaos 

1. Through visual inspection of profiles a pre-collapse crater depth between -1500m 
and –2000 was chosen (Figure 5.2.18) 

2. Using the Raster Calculator a new raster is created using [MOLA] < -1500. 
3. The raster is converted to a polygon shapefile using Spatial Analyst > Conversion 

> Raster to Features. 
4. The resulting shapefile is opened in the Editor and using the Cut Polygon Features 

Task one polygon is created which overlaps the Aram Chaos crater. The other 
polygons are deleted from the shapefile. 

5. The resulting single polygon shapefile is converted to a raster via Spatial Analyst 
> Conversion > Features to Raster using a Cell Size of 500m. 

6. Using Spatial Analyst > Reclassify the raster is given a value of 0. 
7. In the Raster Calculator [MOLA] – [Result of (6)] results in a raster with only 

MOLA values within the Aram Chaos crater. 
8. Via 3D Analyst > Surface Analysis > Area and Volume, using the result of (7) 

and the volume below -1500 m, an estimate of the volume-loss of Aram Chaos is 
derived. 

9. Via 3D Analyst > Surface Analysis > Area and Volume, using the Aram Chaos 
LTD thickness raster and the volume above 0 m, an estimate of the volume of the 
Aram Chaos LTD is derived. 
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5. Results 
 
5.1. Mapping 
 
5.1.1. Background 
Mapping (whether it is geological or geomorphological) is the classification of units. It is 
the best tool we have to derive a history of events which led to the current observable 
surface. Geological units are defined as deposited layers of material of the same age 
(Figure 5.1.1). They could vary in composition laterally. Geomorphology is defined as 
the surface expression. A depositional feature on the surface (e.g. a dune) is considered 
geology and geomorphology, an erosive feature (e.g. a channel) is only considered 
geomorphology (Figure 5.1.1). Mapping was performed using GIS software (ESRI 
ArcGIS) which makes it possible to integrate observations made using different datasets 
(images, elevation data, hyperspectral data). See 4.5. Mapping in ArcGIS for an 
explanation how mapping was done. 
The mapping resulted in a map. Allaby and Allaby (1999) define a geological map as “a 
map which shows the surface distribution of rock types, including their ages and 
relationships, and also structural features”. A geomorphological map shows different 
landforms and their relationships. In reality a clear distinction between geology and 
geomorphology when mapping a planetary surface is difficult. Therefore the resulted map 
is considered to be a combined (structural) geological and geomorphological map. 
 
5.1.2. Unit naming, classification and coloring 
The unit names were either adopted from previous studies (e.g. Highland Terrain, 
Chaotic Terrain) or new names were devised. The unit naming convention used for the 
latter encompassed the use of 1) specific locations which encloses the unit (e.g. Aram 
Chaos Formation) or 2) specific features the unit exhibits (e.g. Small-scale Fractured and 
Chaotic Terrain). The latter immediately suggests the existence of other units (Fractured 
Highland Terrain and Chaotic Terrain). The units were mapped as 1) geological, 2) 
geomorphological and/or 3) structural geological units (Type column in Table 5.1). 
The units were mainly distinguished using image data (mainly HRSC nadir and THEMIS 
VIS). A sense of 3D was created using HRSC anaglyphs (see f.e. Figure 5.2.28) or by 
combining color-coded MOLA elevation and THEMIS IR day (Figure 5.1.2). OMEGA 
hyperspectral data was only used in a late stage to verify the occurrence of the LTD (see 
5.5.6. Integrating OMEGA data). Albedo differences are mostly attributed to dust content 
and were not used to map units. Thermal Inertia can be used to distinguish between rocky 
(high TI) and dusty (low TI) surfaces. The walls of mesas are mostly rocky whereas the 
tops are dusty. Two units were mapped using TI, the deposits in the Chaotic Terrain (e.g. 
Aureum Chaos Deposits, Iani Chaos Deposits, Aram Chaos Formation) and the Ares 
Vallis Channel Deposits. They show relatively high values. TI can also be used to 
distinguish between relatively fresh (low TI and dust content) and older (high TI and dust 
content) surfaces. A possible volcanic deposit was mapped this way, showing a decrease 
in TI farther away from a possible volcanic construct (Figure 5.1.3). 
The unit coloring was an attempt to make the units easily distinguishable. Lateral units 
have the same color but a different texture (f.e. the smooth, fractured and broken Lower 
Aram Chaos Formation). 
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5.1.3. Mapping results 
The units described are a combination of (structural) geological and geomorphological 
units. The results of the mapping: 

1. Figure 5.1.4 shows the resulted (structural) geological and geomorphological map 
of Aram Chaos and surrounding area. 

2. Figure 5.1.5 shows the resulted (structural) geological and geomorphological map 
of Aram Chaos. 

3. Figure 5.1.6 and 5.1.7 shows the resulted (structural) geological and 
geomorphological map of Aureum Chaos and The Iani Chaos, respectively. 

4. Figure 5.1.8 shows the occurrence of the Small-scale Hills Terrain unit. 
5. Figure 5.1.9 shows the mapped lineaments. 
6. Figure 5.1.10 shows the unit type locations. 
7. Figure 5.1.11 shows the occurrence of a possible volcanic deposit. 
8. Figure 5.1.12 shows mapped highly degraded impact crater remnants. 
9. Table 5.1 describes the units. 
10. Table 5.2 describes the unit boundaries. 
11. Table 5.3 describes the definitions which will be used in the following sections. 

 
5.1.3.1. OMEGA mapping results 
The Aureum Chaos Deposits (ACD), Iani Chaos Deposits (ICD) and the Aram Chaos 
Formation (ACF) were investigated using OMEGA data (orbits ORB0456_1, 
ORB0353_2 and ORB0401_3, respectively) (see 4.5.6. Mapping using OMEGA data). 
The following results were obtained: 

1. Figures 5.1.25 to 5.1.29 show the resulting mean spectra for the different 
outcrops. For each mean spectrum two absorption features (red and blue) and a 
larger spectral feature (the three green dots) were selected. See Table 5.4 for the 
wavelengths used for the band ratios. 

2. Figures 5.1.30 to 5.1.34 show the band ratio maps belonging to two absorption 
features and a large spectral feature. 

The absorption features are relatively small (3 to 7 times the spectral resolution of 14 
nm). The absorption feature band ratio maps show much variation, as much as most 
bands themselves, and they do not show high values at the different deposit outcrops. 
Therefore these absorption feature band ratios cannot be used in mapping. 
The large spectral features band ratios result in much noisier maps. Only the large 
spectral features band ratios of the smooth LACF and IACF result in corresponding high 
values over these deposits. The mean spectra of the smooth LACF and IACF are almost 
similar which explains why the bright region consists of smooth LACF and IACF. The 
other deposits do not show up in the resulting band ratio maps. 
 
5.2. Geological observations and interpretations 
This section describes the various geological observations gathered during mapping and 
the resulting interpretations and their significance. The section is divided in a regional 
and an Aram Chaos part. Figure 5.2.1 shows the observation locations. The numbers in 
the figure refer to the observation numbers. 
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5.2.1. Regional 
 
5.2.1.1. Channeling 

1. In the Flooded Highland Terrain (FHT) multiple stages of channel outflow can be 
observed (Figure 5.2.2). This suggests that multiple episodes of outflow from the 
Chaotic Terrain took place. The outflow terraces, which cross-cutting 
relationships show to be the oldest features, suggest that prior to the Ares Vallis 
incision sheet floods occurred. 

2. In Northern Iani Chaos HT with a channel morphology has been cross cut by 
chaotization (Figure 5.2.3). This indicates at least at this locality channeling 
occurred prior to chaotization. It suggests the chaotization destroyed outflow 
channels. 

3. The Aram Chaos channel links Aram Chaos with Ares Vallis (see the Regional 
and the Aram Chaos Geological Map, Figures 5.1.4 and 5.1.5). This suggests a 
sheet flood (see Observation 1) originating from Iani Chaos flowed over the rim 
into Aram Chaos after which the channel was incised. However, no clear flow 
patterns were observed. High-resolution MOC images of this location were not 
available. The sheet flow hypothesis is strengthened by the occurrence of the 
Aram Ares Channel Deposits (AACD) (see Observation 25) and the occurrence of 
material with a morphology similar to the AACD on the terraces of Ares Vallis, 
North of Aram Chaos (compare Figure 5.2.4 with Figure 5.1.10j). 

 
5.2.1.2. Cratering 

4. Within the Highland Terrain and Chaotic Terrain different types of craters occur 
(Figure 5.2.5), 1) unfractured craters within the unflooded HT, 2) unfractured 
craters within the flooded HT, 3) fractured craters within the HT (e.g. Aram 
Chaos) and 4) fractured crater remnants within the CT. Most unfractured craters 
within the flooded and unflooded HT (types 1 and 2) have a relatively flat and 
smooth crater floor surface, which suggest they were filled with material. The 
relatively smooth crater floors of the fractured craters and the crater remnants are 
interpreted to be the result of fracturing and collapsing of the crater floor material. 
If this smooth surface were a surface representation of a distinct deposit within 
the crater the following scenario is proposed for types 3 and 4 (Figure 5.2.6): 1) 
Crater formation, 2) deposition of material within the crater with a high water 
content, 3) deposition of a cap deposit within the crater, 4) Fracturing, collapse of 
the cap material and the (explosive) release of water. 

5. The Chaotic Terrain are observed to contain fractured impact crater remnants 
(Figure 5.1.12). See also Cross Section III of Aureum Chaos (Figure 5.3.2). This 
suggests the Chaotic Terrain fractures are structurally controlled by impact 
craters. See Figure 5.2.7 for an example of an impact remnant within Aureum 
Chaos. 

6. Figure 5.2.8 shows the depth vs. diameter of 45 craters in my research area 
(including Aram Chaos). The measured crater depth could be different then the 
actual crater depth due to deposition within the crater and/or erosion of the 
surrounding terrain. This most likely affected craters in the Flooded Highland 
Terrain. The diagram doesn’t show a clear distinction between fractured and non-
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fractured craters. This indicates the fracturing did not involve subsidence or the 
subsidence was relatively small (more likely a collapse type of subsidence, see 
Observation 4). Almost all measurements are considerably lower then the power-
law relationships derived by Garvin et al., (1999, 2000). This also suggests crater 
fill and/or erosion of the surrounding surface occurred. 

 
5.2.1.3. Fracturing 

7. In Aureum and Aram Chaos pit crater chains occur along the fault trace (Figure 
5.2.9). Only at two locations craters pits were observed. According Ferrill et al. 
(2004) pit crater chains form by dilational normal faulting and appear to be very 
young. They could even be actively forming. The rareness of crater pits in my 
area suggests most fractures are old features with currently practically no new 
fractures forming. 

8. Along the Northern border of Iani Chaos fracture ridges occur in the HT (Figure 
5.2.10). These fracture ridges are interpreted to be the result of compression prior 
to or during chaotization. These specific ridges have only been observed at this 
location and could 1) never have formed at other locations or 2) have been 
destroyed in the chaotization. 

9. In Iani Chaos a HT region partly bounded by large-scale fractures has a smaller-
scale fracture pattern on its surface (Figure 5.2.11). The smaller-scale fractures 
have a smaller width and subsequent smaller fracture valley depth (visible in 
MOLA data) compared to the large-scale fractures in the vicinity. The smaller-
scale fractures grade into large-scale fractures, which indicates both patterns are 
connected, and a localization of fracturing occurred. This suggests multiple events 
of fracturing occurred. 

10. Highland Terrain fractures are observed to continue into Chaotic Terrain  (Figure 
5.2.12 and 5.2.13a). The fractures within the CT are less easily distinguishable. 
The CT consist of km-scale hills, which are interpreted to be fault bounded. This 
high amount of fracturing within the CT is interpreted to be analogues to 
brecciation. Breccia is a rock so fractured it has lost coherence. 

11. Two possible fracture offsets have been observed, one in Aureum Chaos and one 
in Iani Chaos (Figure 5.2.14). The rareness of offsets could be explained by 1) a 
single event of regional stress, or 2) multiple localized fracturing events with no 
regional stress. 

12. A possible 20 by 30 km strike-slip duplex system has been observed in the HT, 
south of Aram Chaos, (Figure 5.2.15), connecting two HT fractures. It could be 
contractional with sinistral movement because it is located on a positive 
topographical feature (~200 m high). The fractures inside the duplex however are 
not observed to be thrusts (Figure 5.2.15c). Other observations which contradict 
the duplex-system hypothesis: 1) The two HT fractures are not observed to offset 
other fractures. 2) A smaller set of fractures located on a positive topographical 
feature occurs outside the duplex system (arrow in Figure 5.2.15b). 

 
5.2.1.4. Highland Terrain 

13. High-resolution HRSC nadir images show the Highland Terrain surface 
morphology to be varying (Figure 5.2.16a and b). Especially many crater floor 
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surfaces have a smoother surface then surrounding HT (for example see 4 in 
Figure 5.2.16b) which suggest they are the surface representation of a distinct 
deposit within the crater. However these smooth surfaces also occur within the 
surrounding HT (3 in Figure 5.2.16b). Within Aram Chaos also more rugged HT 
surface morphology occurs (7 in Figure 5.2.16c). Therefore the HT surface 
morphology variability is interpreted to be caused by relatively thin deposits of 
different age (e.g. volcanism, impact ejecta). 

 
5.2.2. Aram Chaos 
 
5.2.2.1. Large scale 

14. Figure 5.2.17 shows the rings of the Aram Chaos multiring crater. The crater 
consists of three visible (using MOLA data) rings with a ~150 km (inner ring), 
~280 km (middle ring) and ~500 km (outer ring) diameter. The rings of crater 
basins on a number of terrestrial planets are spaced at a constant factor of √2 
(Spudis, 1994). This means that the diameter Dn of different rings is related to the 
basin rim diameter through: Dn = (√2)N D, with N an integer (1,2,3,4, etcetera). 
The rings of Aram Chaos approximately follow this ‘√2 rule’ (280 / 2 = 140 
which is ~150 km and 500 / 2 = 250 which is ~280 km). Within the inner ring the 
Aram Chaos Formation is formed (see Figure 5.1.5, the Geological Map of Aram 
Chaos). Between the inner ring and middle ring fractured HT and CT occurs. The 
outer ring consists of 1) Ares Vallis, which bends around Aram Chaos, 2) 
Hydaspis Chaos, 3) the channel branch linking Hydaspis Chaos to Ares Vallis, 4) 
the upper part of Iani Chaos and 5) a small fractured crater south of Aram Chaos. 
This suggests the locations of the channeling, fracturing and chaotization around 
Aram Chaos were structurally controlled by the Aram Chaos multiring crater 
(Schultz et al., 1982). 

15. When assuming 1) the Highland Terrain within Aram Chaos subsided (see 
Observation 17) and 2) the pre-subsidence Aram Chaos HT was a relatively flat 
surface (see Observation 4) the amount of subsidence can be estimated. This 
estimation can subsequently be used to calculate an estimate of the volume of 
material which was withdrawn (see 4.7.2. Deriving the volume-loss of Aram 
Chaos). A pre-subsidence Aram Chaos HT elevation between –1500 and –2000 m 
was estimated through image and MOLA elevation analysis (Figure 5.2.18). The 
volume of subsidence was subsequently 70274 km3 (for –1500 m) and 40852 km3 
(for –2000 m). This estimation did not take into account the volume of the Aram 
Chaos Formation (6222 km3) (see Observation 29). The total subsidence volume 
estimation is calculated by adding the ACF volume: 76496 km3 (for –1500 m) and 
47074 km3 (for –2000 m). 

 
5.2.2.2. Aram Chaos Highland Terrain 

16. Tearing of Highland Terrain is observed at the Aram Chaos rim (Figure 5.2.13b). 
This is interpreted to be caused by subsidence of the Aram Chaos HT. The tearing 
has implications for the strength of the HT material. 

17. Highland Terrain is observed to continue into Aram Chaos, where it has a lower 
elevation and has been fractured (Figure 5.2.13c). This suggests subsidence took 
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place of the HT material within Aram Chaos. Material must have been withdrawn 
underneath, resulting in subsidence. The HT is subsequently interpreted to be a 
thick (perhaps a km thick) deposit which was deposited on top of the Aram Chaos 
crater and the paleosurface it formed upon. This is also suggested by Observation 
16. This leads to the following possible sequence of events (Figure 5.2.19): 1) 
Aram Chaos crater formation, 2) deposition of material within the crater with a 
high water content, 3) deposition of the HT material, 4) withdrawal and 
(explosive) release of the water rich material and 5) Fracturing and subsidence of 
the HT. This scenario is different then the proposed scenario for the other 
fractured craters and crater remnants (see Observation 4). Because Aram Chaos is 
the biggest of the fractured craters in my research area it is also most likely the 
oldest. This could explain the occurrence of overlying HT deposits. 

18. The Aram Chaos HT collapse is varying, showing an undulating topography 
(Figure 5.2.13). This could be either due to 1) collapse and localized upward 
movements (popup), 2) collapse of the HT onto a subsurface topography or 3) a 
combination. In any case the resulting topography is best described as a draping 
of the fractured HT mesas (Figure 5.2.20b). Whether upward movements caused 
this, or subsidence or a mix remains unknown. One specific feature is a circular 
elevated area consisting of HT blocks (Figure 5.2.13d). This could perhaps be 
caused by 1) part of an Aram Chaos crater ring uplift, 2) volcanism underneath, 3) 
lateral differences in water content or 4) a popup structure formed by high water 
pressure underneath. 

19. Radial fracture patterns can be observed within the Aram Chaos fracture pattern 
(Figure 5.2.21). This suggests the Aram Chaos pattern originated from specific 
areas of high stress within Aram Chaos. 

20. Parts of the rim of Aram Chaos consists of small arcs (Figure 5.2.22). This 
suggests the Aram Chaos HT rim subsidence is influenced by more then one 
crater. After the Aram Chaos crater formed, smaller craters could have impacted. 

21. On the edge of the Aram Chaos Chaotic Terrain a HT mesa occurs with a smaller 
scale fracture pattern on its surface (A in Figure 5.2.23). Next to it, within the CT 
a similar sized higher elevated region visible in MOLA occurs (B in Figure 
5.2.23). Image data show it consists of small hills (Figure 5.2.23b). It is therefore 
interpreted to be a chaotisized HT mesa. This suggests the following sequence of 
events occurred: 1) large scale fracturing resulted in HT mesas, 2) within the 
current CT region the mesas subsequently underwent fracturing of a smaller scale 
(see also Observation 9) and 3) erosion related to the fracturing produced the 
current relief of small hills. Some of the fractured mesas were not chaotisized (f.e. 
A in Figure 5.2.23). 

22. A half crater occurs at the boundary between the fractured HT and the LACF 
(Figure 5.2.24). This boundary can be observed in MOLA data as the inner ring of 
the multiring Aram Chaos crater (see Observation 14). The boundary is, at least at 
this location, interpreted to consist of a normal fault (See cross section in Figure 
5.2.24). Broken LACF is observed at the down faulted part of the normal fault. 
This suggests the following scenario: 1) the HT within the inner ring of the crater 
has been subsided, 2) the LACF was deposited within the inner ring and 3) 
ongoing subsidence resulted in the LACF fracturing. 
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5.2.2.3. The Eastern part of Aram Chaos 

23. In the Eastern part of Aram Chaos no concentric crater ring fractures were 
observed (Figure 5.2.25a). In the North the inner and middle crater ring (see 
Observation 14) fractures converge and die out. In the South the outer crater ring 
fracture dies out at the mouth of the channel connecting Aram Chaos and Ares 
Vallis (the Aram Chaos channel), where a delta-shaped feature (see Observation 
25) is located. It is therefore interpreted that no concentric crater ring fractures 
developed in the Eastern part of Aram Chaos. Overlying deposits, such as the 
Aram Ares Channel Deposits could not have obscured such a large topographical 
feature. This suggests no collapse and subsidence has occurred in the Eastern part 
of Aram Chaos. However, the Eastern part of Aram Chaos could perhaps have 
bended inward without fracturing. 

24. Chaotization occurred at the Eastern part of Aram Chaos (Figure 5.2.25b), with 
the fractures penetrating ~500 m deep. The ~500 m deep fracturing is inferred 
from the relatively smooth base on top of which the mesas occur (Profile A in 
Figure 5.2.25b). The outer parts (relative to the crater center) are best described as 
Small-scale Fractured and Chaotic Terrain, but the inner parts are best described 
as Intermediate Chaotic Terrain, suggesting a decrease in fracture penetration 
depth crater outward. 

25. The Aram Ares Channel Deposits have been cut by the Aram Chaos channel 
(Figure 5.2.25c, see also Cross Section I, Figure 5.3.1). This implies the AACD 
material was deposited prior to the formation of the main channel. The AACD is 
observed to cap elongated streamlined HT mesas (Figure 5.2.25c). It forms 
multiple terraces and a delta-shaped feature at the mouth of the Aram Chaos 
channel (Figure 5.2.25c). Approximately 100 m AACD layering has been 
observed in the Aram Chaos channel wall (Figure 5.2.25d). The delta-shaped 
feature is interpreted to be both erosional (the streamlined HT mesas, the Aram 
Chaos channel) and depositional (the ACCD). The occurrence of the AACD 
suggest first deposition occurred crater inward, by incision of the Aram Chaos 
channel. Subsequently flow occurred crater outward, through the Aram Chaos 
channel into Ares Vallis, suggested by the streamlined HT mesas and the cross 
cutting of the AACD by the Aram Chaos channel. The channel could have incised 
due to the subsidence of the Aram Chaos crater. This leads to the following 
possible sequence of events (Figure 5.2.26): 1) overflow of Aram Chaos, forming 
the Aram Chaos channel (see also Observation 3), 2) and 3) deposition of the 
AACD and continued incision of the Aram Chaos channel (also cutting through 
AACD) due to Aram Chaos subsidence, and 4) incision of the Aram Chaos 
channel by crater outward flow forming the streamlined HT mesas and eroding 
AACD. 

 
5.2.2.4. The Aram Chaos Formation 

26. A ~350 m high mesa of fractured Lower Aram Chaos Formation (LACF) is 
situated on top of a HT window within the LACF (Figure 5.2.27). This 
observation is used to infer a thickness for the LACF between ~250-500 m (see 
Cross Sections I and II) (Figure 5.3.1). The window is mapped HT because it is 
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different in morphology then the surrounding LACF material. However, it 
contains fractures of the same scale as the LACF fractures. It is still mapped as 
HT because of its size and HT mesa geometry (it is bounded by valleys, most 
likely fracture valleys), which corresponds with other fractured HT mesas in 
Aram Chaos. 

27. The smooth LACF is observed to be a draping (Figure 5.2.28, see also Cross 
Section I, Figure 5.3.1). It is interpreted to drape over underlying fractured 
Highland Terrain. The Highland Terrain fractured and subsided prior to or during 
the deposition of the LACF. 

28. A window of Highland Terrain located in the LACF has a rim of fractured LACF 
on its south side (Figure 5.2.29). The HT window is interpreted to be a fracture 
bounded mesa which has been rotated due to collapse. 

29. Using MOLA elevation data it is possible to derive an estimate of the thickness of 
the Aram Chaos Formation (see 4.7.1. Deriving the thickness of the Intermediate 
and Upper Aram Chaos Formation). A Nearest Neighbor interpolation of all 
MOLA points except those that covered the Intermediate and Upper Aram Chaos 
Formation, was subtracted from the MOLA data to derive an estimate of the 
combined IACF and UACF thickness (Figure 5.2.30). The combined volume was 
calculated using ArcGIS to be 1260 km3. The volume of the Lower Aram Chaos 
Formation (4962 km3) was estimated by multiplying the area of the complete 
ACF (19848 km2) by a mean thickness of 250 m (a rough estimate). The total 
volume of the Aram Chaos Formation is subsequently 6222 km3. 

30. Some LACF fractures have raised rims and some show small thrusts at the base of 
the rim (Figure 5.2.31). This can either be explained by 1) lateral compression due 
to subsidence and collapse of HT blocks underneath, 2) localized upward 
movement of water. The fractures form linear patterns of the same scale as the HT 
fractures (see the Aram Chaos Geological Map, Figure 5.1.5). This suggests HT 
blocks influenced the LACF fracture pattern. Upward movement of water using 
HT fractures as pathways could perhaps explain the raised rims. The broken 
LACF could be the locations where water was released to the surface, because the 
LACF is thinnest there (Table 5.2, Boundary 2). 

 
5.3. Cross sections 
Cross sections are used to visualize the stratigraphical relations of mapped units and their 
derived thicknesses. See 4.5.4. Creating cross sections how they were derived. Four cross 
sections have been made, two through Aram Chaos, one through Aureum Chaos and one 
through Iani Chaos. The cross sections were created using unit descriptions and unit 
boundary descriptions (Tables 5.A and 5.B) and relevant geological observations and 
subsequent interpretations. The cross section profile lines were chosen to go through the 
different mapped deposits within the Chaotic Terrain (e.g. Aram Chaos Formation, 
Aureum Chaos Deposits, Iani Chaos Deposits). The cross sections are 10 times 
exaggerated in elevsation. 
The creation of the cross sections encompassed the following issues: 

1. A realistic fault interpretation was attempted. The largest shoulder of a fracture 
valley was used to define the dip direction. The faults are visualized as black 
lines. Not observed, but interpreted faults were visualized using a dashed pattern. 
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The fault scarps have likely been affected by erosion and cannot be simply used 
as fault orientation indicators. The faults are interpreted to be normal faults and 
are therefore more then 60° relative to the surface. Because the cross sections are 
10 times exaggerated this results in approximately 85° vertical fault orientations 
in the cross sections. 

2. The ICT and CTF are considered HT material which have undergone 
chaotization, making them geomorphologically and structurally distinct 
(Boundary 1 in Table 5.2). The boundary between HT, ICT and CTF is visualized 
using a wave pattern. It was decided not to use a fault boundary because this 
would imply a distinct boundary whereas the boundary is more transitional (the 
amount of chaotization). 

3. The lower boundary of the cross sections is arbitrarily chosen and does not 
visualize a geological boundary. The buried crater floor of Aram Chaos is not 
shown in Cross Sections I & II. 

4. The Cross Sections are constructed from geological observations, by using the 
principle of superposition and by assuming layers are continuous. 

 
5.3.1. Aram Chaos (Cross Sections I & II) 
A West to East (Cross Section I) and a North to South (Cross Section II) cross section 
were created through Aram Chaos (Figure 5.3.1). The following assumptions and 
observations were used to create Cross Sections I & II: 

1. The AACD is observed to cap elongated streamlined HT mesas (Boundary 5 in 
Table 5.2). See also Observation 25. 

2. The fractured LACF thickness was inferred from a ~350m LACF mesa 
(Observation 26). 

3. The occurrence of HT fractured mesas underneath the LACF was inferred from 
HT windows in the LACF (Observations 26 and 28). 

4. The smooth LACF is interpreted to be draped over the HT and/or CT (Boundary 4 
in Table 5.2 and Observation 27) 

5. The boundary between the fractured LACF and HT is interpreted to be a thinning 
of the LACF towards the HT, and the occurrence of broken LACF (Boundary 2 in 
Table 5.2). 

6. The smooth LACF and the fractured LACF are mapped as lateral units, although 
their exact relation is unclear (Boundary 3 in Table 5.2). 

 
5.3.2. Aureum Chaos (Cross Section III) 
A South to North (Cross Section III) cross section was created through Aureum Chaos 
(Figure 5.3.2). The following assumptions and observations were used to create Cross 
Section III: 

1. Two impact remnants in Aureum Chaos are covered (see Observation 5). 
2. The ACD are thick deposits on top of the CT in Aureum Chaos, forming distinct 

hills with escarpments (Boundary 9 in Table 5.2). 
 
5.3.3. Iani Chaos (Cross Section IV) 
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A South to North (Cross Section IV) cross section was created through Iani Chaos 
(Figure 5.3.3). The following assumptions and observations were used to create Cross 
Section IV: 

1. The boundaries of the ICD (Boundary 10 in Table 5.2) 
 
5.4. Stratigraphy 
Stratigraphy deals with the correlation of stratified rocks from different localities (Allaby 
and Allaby, 1999). A stratigraphical column shows the layering of rocks at a certain 
location. Layer thicknesses, composition and possible erosion surfaces are depicted. 
Fracturing has been depicted by black lines or dotted lines for possible fracturing. The 
thickness of the layers is a mean thickness. Sets of stratigraphical columns have been 
created along Cross Sections I to IV: 

1. Stratigraphical columns along the W-E and N-S Aram Chaos cross sections 
(Figure 5.4.1). Location 7 is divided in two possible stratigraphical columns. This 
refers to the unresolved issue of Boundary 3 of Table 5.2. 

2. Stratigraphical columns along the Aureum and Iani Chaos cross sections (Figure 
5.4.2). 

 
5.5. Lineament Analysis 
Lineament Analysis was performed on the digitized fracture patterns. The width of the 
fractures was not taken into account. Rose Diagrams (RD) were created to determine the 
possible presence of preferred orientations. Concentricity was used to determine the 
structural control by crater structures on the fracture pattern. The Concentricity of a 
lineament is defined as the angle between the lineament and a line through the lineament 
mid point and a specific location (f.e. the center of the Aram Chaos crater) (Figure 4.I). 
When this angle is 90 the lineament is concentric to the location, when this angle is 0 the 
lineament is radial to the location (for the method see 4.6.3. Concentricity / Radiality). 
 
5.5.1. The Aram Chaos fracture pattern 
The Aram Chaos fracture pattern has been investigated using RDs and the Concentricity 
method. Major questions are: 

1. Is the fracture pattern influenced (structurally controlled) by the crater. 
2. Is the fracture pattern controlled by the largest chaotisized area in Aram Chaos. 

The following results have been obtained: 
1. Figures 5.5.1 and 5.5.2 show length-weighted RDs and Concentricity of different 

locations in Aram Chaos. The blue lineaments (within Circle 2) in Figure 5.5.1 
mostly consist of fractures in the Aram Chaos Formation. The RD shows two 
faint Preferred Orientations (PO) (NNWSSE and NE-SW). Their Concentricity 
(relative to the center of the Aram Chaos crater) in Figure 5.5.2 show an almost 
even distribution. Therefore the inner ring fractures do not seem to be strongly 
structurally controlled by the crater. The red lineaments occur between the 1st and 
2nd ring and mostly consist of Highland and Chaotic Terrain fractures. The RD 
does not show PO's. The Concentricity shows a relatively high distribution of 
concentric fractures. This is interpreted to be caused by structural control of the 
crater. The 4 RD of the N, S, W and E corners of Aram Chaos do show distinct 
PO's. The N and W corners have their major PO concentric to the crater. The S 
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corner has a distinct set of PO's. The Concentricty relative to this location (Circle 
3) shows a relatively high amount of radial fractures. The S corner of Aram Chaos 
is the most chaotisized part of Aram Chaos and is interpreted to be a focussed 
zone of subsidence. The E fractures, compared to the N, S and W fractures are 
relatively small. The E part of Aram Chaos does not contain a major concentric 
rim fault (see Observation 23, Figure 5.2.25a). 

2. Figure 5.5.3 shows length-weighted RDs and Concentricity of two craters (Craters 
1 and 2, 72 km and 48 km in diameter respectively) near Aram Chaos (see Figure 
5.5.4). Crater 1 shows three distinct PO’s, Crater 2 shows 2 distinct PO’s and 
some smaller ones. Only the ~N-S PO’s correspond. Both Concentricity’s only 
show high values near 90 degrees, making both crater fracture patterns highly 
concentric. 

 
5.5.2. The regional fracture pattern 
The regional fracture pattern has been investigated using Rose Diagrams (RD), the 
Concentricity method and by creating a fracture density map (Figure 5.5.5). The fracture 
density is used to define structural domains. Major questions are: 

1. What are the preferred orientations of the different high fracture density areas? Is 
there a trend? 

2. What are the preferred orientations of the low fracture density surroundings? 
3. Are the fracture patterns in the chaotic terrain influenced by crater impacts? 

The following results have been obtained: 
1. Figure 5.5.6a shows lineament domains of chaotic terrain derived from the 

lineament density map and their length-weighted Rose Diagrams. It also shows 
RD’s for Small-scale Fractured and Chaotic Terrain (SFCT) (blue), Craters 1 and 
2 (purple) and Aram Chaos (orange). 

2. Figure 5.5.6b shows all the lineaments in the Highland Terrain between the four 
Chaotic Terrain in my research area (Aram, Iani, Aureum and Hydaspis Chaos) 
and the low-fracture density Chaotic Terrain and the resulting RD. The lineaments 
show a weak PO ~NNW-SSE and a second ~E-W. 

3. Figure 5.5.7 shows length-weighted Concentricity of the centers of Hydaspis, 
Aureum and Iani (East and West) Chaos. 

The weak ~NNW-SSE and ~E-W PO’s of the lineaments in the Highland Terrain 
between the four Chaotic Terrain could suggest regional stress was active. The different 
high density Chaotic Terrain RD’s however do not show a clear trend. The PO’s seem to 
be influenced mostly by the shape of the chosen structural domain itself (the orientation 
of the elongation defines the PO). It is therefore concluded that the Chaotic Terrain 
fracture pattern was not influenced significantly by regional stress. 
The two central SFCT RD’s show PO’s parallel to the outflow (see Figure 5.5.5b) The 
left RD is derived from fractures confined to the 130 km in diameter Galilaei crater. The 
PO is approximately parallel to the small channel connecting the crater to the outflow 
channel (see the Regional Map Figure 5.1.4). Therefore the PO’s are interpreted to be 
mostly influenced by the direction of the outflow. The right SFCT RD has a PO of NEE-
SWW. The area of which the RD was derived is very broken and the orientations of the 
numerous small mesas where not mapped. A more thorough lineament mapping is 
needed to define PO’s for this area. 
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Figure 5.5.7 shows four circular areas within the Chaotic Terrain of which the 
Concentricity was calculated. The radius of each area was chosen arbitrarily by 
observation. Only area D shows a distinct difference in radial and concentric fracture 
distribution (high amount of radial fractures). The center points where also chosen 
arbitrarily, after visual inspection of concentric and radial patterns. 
 
5.5.3. Other lineament patterns. 

1. Figure 5.5.8 shows the mapped wind directions and a Rose Diagram. Wind 
directions were obtained by mapping the directions of wind streaks outside 
craters. These originate because crater impacts cause relatively easily erodable 
material to resurface in the crater walls. These materials are subsequently 
transported by wind (Figure 5.5.9). 

2. Figure 5.5.10 shows the mapped wrinkle ridges and a Rose Diagram of all the 
wrinkle ridges. Some wrinkle ridges inside the Flooded Highland Terrain could be 
eroded crater ejecta blankets. Almost no wrinkle ridges have been observed 
within the HT mesas of the Chaotic Terrain (only one has been observed, in Aram 
Chaos). This is most likely due to the degradation of the HT mesas. 
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6. Discussion

6.1. Introduction
In  this  section  the  results  will  be  discussed  and  compared  with  work  previously 
published. Figure 6.1 shows a Space-Time diagram of the discussed sequence of event 
concerning Aram Chaos. Two major assumptions are used in the discussion:

1. Water carved the outflow channels. A variety of outflow carving hypotheses have 
been stated (see 2. Mars Background) but catastrophic release of water is found to 
be  the  most  convincing.  A  terrestrial  analogue  is  the  Channeled  Scablands, 
formed by the catastrophic release of water when an ice dam broke at the end of 
the last ice age (Baker, 2001; Masson et al., 2001).

2. Craters were formed by impact events.

6.2. Geological evolution

6.2.1. Regional evolution
In this section the regional  evolution of my research area is  discussed.  The region is 
mainly composed of the thick (km scale) Highland Terrain material, of Noachian age. 
The  Highland  Terrain  has  been  degraded  into  Chaotic  Terrain.  Chaotic  Terrain  are 
densely  fractured  regions  which  are  the  source  regions  of  outflow  channels.  These 
outflow channels incised into the Highland Terrain. The evolutions of the Aram, Iani and 
Aureum Chaos Chaotic Terrain and deposits therein are discussed in detail in sections 
6.2.2 and 6.2.3.

6.2.1.1. Highland Terrain composition and structure
Previous mapping by Tanaka et al. (2005) interpreted the Highland Terrain (mostly their 
Libya Montes unit) to consist of “a mixture of impact breccia and melt, volcanic rocks,  
and clastic sedimentary rocks of aeolian, alluvial, mass-wasting, and other undetermined  
origins”. They performed crater counting and estimated the HT to be of Noachian age. 
My findings agree with this interpretation:

1. The  many impact  craters  covering  the  HT suggest  the  HT terrain  consists  of 
impact related materials (ejecta, breccia and melt)

2. 100-200m layering can be observed in the Ares Vallis escarpment (Figure 5.1.13),
3. HRSC data show that the current HT surface varies in ruggedness (Observation 

13)
4. A possible volcanic deposit occurs south of Aram Chaos (Figure 5.1.11).

Rodríguez  et  al.  (2005a)  investigated  an  area  in  the  Xanthe  and Margaritifer  Terrae 
region, including the western part of my research area. They observed crater remnants in 
different  gradations of degradation at  the boundary escarpments  between the HT and 
lower elevated outflow channels and CT. I agree with their interpretations:

1. The Highland Terrain is at least 1-2 km thick (see Boundary 1, Table 5.2).
2. Circular features visible in the Ares Vallis escarpment were observed interpreted 

to be exposed impact crater remnants (Figure 5.1.13).
3. Aureum  Chaos  is  observed  to  consist  of  multiple  impact  crater  remnants 

(Observation 5).
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Most of the volcanism and tectonics related to the Tharsis Bulge occurred during the 
Noachian  (see  Mars  Background).  This  could  have  caused  volcanism (intrusive  and 
extrusive) in the HT (Tanaka et al., 2005). Extensional and compressional Tharsis related 
fault  systems  are  expected  to  have  formed.  No  clear  extensional  faults  have  been 
observed on the HT surface in my study area, but could have been buried (see Regional  
stress). Compressional Tharsis related faults however are observed: wrinkle ridges occur 
on the surface of the HT in my area and their mean orientation is concentric to Tharsis 
(Figure 6.2). They are believed to be the surface representation of compressional faults 
(Nimmo and Tanaka, 2005). The thrust faults underneath the wrinkle ridges could have 
formed early in the HT formation, with older wrinkle ridges now being buried. 
Most workers agree the Noachian was a time of 1) intense cratering and 2) increased 
erosion and deposition suggesting a warmer climate with occasionally at least, flowing 
surface water (see  Mars Background).  In such an environment,  newly formed craters 
probably  contained  lakes,  or  were  filled  with  water  rich  material  (Rodríguez  et  al., 
2005a). Subsequent volcanic, sedimentary and/or impact related deposition buried these 
water rich bodies. The Chaotic Terrain morphology of subsided and collapsed HT blocks 
suggests the water was unstable and was released to the surface subsequently carving the 
outflow channels.
Understanding the formation of Chaotic Terrain can help to unravel the Highland Terrain 
composition  and structure.  In  my  Mars Background section multiple  Chaotic  Terrain 
formation hypotheses are described (Table 2.3). Sharp (1973) was the first to describe the 
CT and Carr (1979) first described a model.  He hypothesized that underneath the CT 
high-pressure confined aquifers occurred below a permafrost layer.  In the aquifers the 
pore pressure reached the lithostatic pressure, causing surface release of water. The most 
recent model of CT formation, using MOC, THEMIS and MOLA observations,  is by 
Rodríguez  et  al.  (2005a).  They hypothesized  that  within  the HT ‘cavernous  systems’ 
occur, which are assumed to be the result of combined fracture systems of many buried 
impact  craters.  The networks occur because radial  and concentric crater  fractures  can 
extend  up  to  1  crater  diameter  (D)  from  the  crater  rim.  Therefore  laterally  and 
stratigraphically nearby craters connect and form fracture networks. Water was deposited 
within the crater basins during HT formation. After the wet period in the Noachian the 
cryosphere (permanently frozen layer) thickened which confined the buried craters and 
their water ice deposits. Subsequent episodes of heating by endogenetic processes melted 
the water,  caused hydrothermal  circulation and started fluid flow through the fracture 
networks. Erosion by fluid flow excavated caverns in the high fracture density regions 
which  subsequently  filled  with  water.  When  the  hydrostatic  pressure  exceeded  the 
lithostatic pressure the caverns became unstable and water was released to the surface. 
This led to the collapse of the caverns and the formation of the Chaotic Terrain. This 
model is found to be the most detailed and thorough model yet of the CT formation and 
agrees with the findings of this study:

1. The occurrence of CT within the Aram Chaos crater.
2. The occurrence of fractured craters within the HT (Observation 4).

Figure 6.3 shows a schematized representation of the HT composition and structure. To 
summarize, the HT stratigraphy in the studied region is formed by a complex interplay 
between the processes of volcanism, cratering, erosion, deposition and fracturing. The 
HT stratigraphy most  likely consists  of many buried impact  craters,  which may have 
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undergone various degrees of erosion prior to burial. Each impact event deposited ejecta, 
formed  impact  breccias  and  produced  impact  melt.  Impact  related  fracture  systems 
dominate the HT structure. Fracture systems of large impacts will likely have the largest 
influence. During the Noachian the atmosphere may have been denser, and the climate 
warmer, resulting in water runoff systems (see Mars Background). Therefore it is likely 
river channels and crater lakes or water rich crater fill are buried within the HT. The 
formation  of  the  Tharsis  Bulge  probably  produced  volcanics  and  tectonic  structures. 
Therefore magmatic intrusions and layers of lava flows and ash deposits will probably 
occur within the HT stratigraphy. Also (subsurface) Tharsis related faults are expected. 
Subsurface structures (impact or tectonic related) could have been reactivated during the 
formation of the HT. 

6.2.1.2. Lineament Analysis
I  performed  Lineament  Analysis  of  the  mapped  fractures  to  determine  if  they  were 
influenced by regional  stress (using Rose Diagrams) and to quantify the influence of 
cratering  on  the  fracture  pattern  (using  Concentricity).  Lineament  Analysis  has  been 
applied  to  cratering  studies  before:  Baker  (1994)  performed  Lineament  Analysis  of 
lineaments from remote sensing data of the Sudbury crater, Canada. He observed two 
rings and therefore interpreted Sudbury crater to be a multi-ring crater.

6.2.1.2.1. Regional stress
The main question to be answered with the use of Rose Diagrams (RD’s) is if the HT and 
CT fracture pattern was influenced by regional stress. No Preferred Orientations (PO’s) 
were observed in the  bulk of  the lineaments  and within  the  CT.  The lack of  offsets 
(Observation 11) also suggests regional deformation did not occur when the fractures 
formed.
Other observations however do suggest the past presence of regional stress:

1. The weak ~NNW-SSE and ~E-W PO’s of the lineaments in the HT between the 
four CT (see 5.5.2. The regional fracture pattern).

2. According to Öhman et al. (2005) regional deformation controls crater shapes. 
Two pre-existing perpendicular fracture systems can lead to a hexagonal crater. 
Aram Chaos is observed to be hexagonal in shape (Figure 5.1.5). This suggests 
regional deformation of the HT occurred prior to the Aram Chaos impact.

3. The mean orientation of the wrinkle ridges in my research area is concentric to 
Tharsis (Figure 6.2) and therefore suggests a Tharsis related origin.

4. The possible strike-slip duplex system (Observation 12).
Rodríguez et al. (2005a) interpreted the linear shape of the chasmata in their research area 
(directly west of my research area) to be the result of structural control by fault systems 
radial  to  Tharsis.  According  to  Rodríguez  et  al.  (2005b)  the  fracture  systems  within 
eastern  Aureum  Chaos  are  remnants  of  extensional  fracture  systems.  This  suggests 
Tharsis related extensional fault systems also occur in my research area, although it is 
farther away from Tharsis. These systems could be subsurface faults, currently covered 
by later deposits, with no current surface representation.

6.2.1.2.2. Cratering
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I  devised  the  Concentricity  method  to  quantify  the  influence  of  preexisting  crater 
geometry on the lineament pattern. Radial and concentric faults are observed in impact 
craters (Rodríguez et al., 2005a). On Earth f.e., the Vredefort crater exhibits radial and 
concentric impact melt dikes (Grieve and Therriault, 2000). Other processes however can 
also  produce concentric  or  radial  patterns  and therefore  Concentricity  is  in  general  a 
method to quantify the occurrence of centralizations in the lineament pattern. An example 
is the relatively high amount of fractures radial to (compared to concentric to) the most 
chaotisized area within Aram Chaos (Figure 5.5.2c and Circle 3 in Figure 5.5.1). Two 
fractured craters in my study area showed a high amount of concentric fractures (Figure 
5.5.3 and 5.5.4). The HT fractures of Aram Chaos also have a relatively high amount of 
concentric fractures compared to radial fractures and are likely controlled by the crater 
structure.  I  also  investigated  Hydaspis,  Aureum  and  Iani  Chaos  using  Concentricity 
(Figure 5.5.7). Only one center, in Iani Chaos (D in Figure 5.5.7) had a relatively high 
amount  of  radial  fractures  compared  to  concentric  fractures.  It  is  concluded  that  the 
Concentricity method is a first approach to quantify lineament localizations. It has to be 
expanded by building an algorithm which automatically finds concentric and/or radial 
centers within the lineament data.

6.2.1.3. Volcanism
The scale of the ~3 km in diameter and 200 m high possible volcanic construct (see 
Figure  5.1.11)  in  my  study  region  is  comparable  to  the  scale  of  possible  volcanic 
structures identified by other workers:

1. 'Quasi-circular  structures',  ~1 km in diameter,  in  the  eastern part  of  Hydaspis 
Chaos  (around  2.6719°N,  334.5755°E),  observed  by  Rodríguez  et  al.  (2005b) 
which they interpret as resembling ring dikes.

2. Cone-shaped hills in Aram Chaos identified by Lanz and Jaumann (2001). They 
are up to 2 km in diameter and several hundreds of meters high. The hills are 
interpreted to be possible magmatic intrusions.

This would imply volcanism did occur in my region but of a small scale compared to the 
Tharsis volcanoes. However, volcanism of a larger scale could have occurred, now being 
buried within the HT. The age of the possible volcanic construct is unknown, but crater 
counting of the possible volcanic outflow could be performed.

6.2.1.4. Outflow episodes
According to a mapping study by Nelson and Greeley (1999), using Viking data, multiple 
episodes of Ares Vallis channel formation occurred. The occurrence of cross-cutting Ares 
Vallis  channels  (Observation  1)  is  consistent  with  this  interpretation.  The  Flooded 
Highland Terrain is interpreted to be formed by an early sheet wash from Iani Chaos or 
upstream,  prior  to  incision.  The  Aram  Ares  Channel  Deposits  and  similar  looking 
deposits  on an Ares Vallis  terrace (Observation 3) could have been deposited in this 
period. Subsequent flooding and incision likely eroded other occurrences of this deposit.
According to Nelson and Greeley (1999) the first episode in the XMT region flooding 
history was a sheet wash from Vallis Marineris, also covering my study region (their 
Early Hesperian Hpls unit, consisting of reworked plateau material).  Therefore, what is 
now mapped  as  non-flooded  Highland  Terrain  in  my  area,  could  have  been  flooded 
because  it  is  in  the  direct  path  of  the  Vallis  Marineris  outflow system (Figure  3.1). 
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However, no flow related morphology in the non-flooded HT was observed. Still, almost 
all  measured crater  depths  in  my area  are  considerably  lower  then power-law crater 
diameter-depth relationships derived by Garvin et al., (1999, 2000) (Observation 6). This 
suggests crater fill and/or erosion of the surrounding HT surface occurred, potentially 
related to such flooding events.

6.2.2. Evolution of Aram Chaos
This section will discuss the evolution of Aram Chaos by comparing the observations to 
the  literature,  mainly  Glotch  and  Christensen  (2005).  They  proposed  the  following 
sequence of events:

1. Formation of the Aram Chaos crater, in the Noachian.
2. Crater fill of water rich material.
3. Formation of aquifers according to the Carr (1979) model (see 6.2.1.1. Highland 

Terrain composition and structure).
4. A first release of water formed their Fractured Plains unit (the HT within the ~280 

km in diameter Aram Chaos middle ring). 
5. A second release formed their High TI Chaos (part of the LACF in this study), 

reworking the Fractured Plains.
6. A third and subsequent releases formed their Knobby Terrain (the Chaotic Terrain 

and  parts  of  the  broken  LACF in  this  study)  and  could  have  resulted  in  the 
deposition of the layered material in a sublacustrine environment.

7. A doming event of the Aram Chaos crater occurred, tilting the layered deposits.
8. Erosion of the layered deposits

The scenario proposed by Glotch and Christensen (2005) partly agrees with the mapping 
of this study and will be further discussed in the following subsections. Figure 6.1 shows 
a diagram of the evolution of Aram Chaos and will be referred to in the discussion. Key 
timing relations shown in Figure 6.1 will be represented by underline in the discussion.

6.2.2.1. Crater formation and early evolution
This  subsection  will  discuss  the  formation  of  the  Aram  Chaos  crater  and  its  early 
evolution,  prior to the fracturing,  collapse  and water outflow. The first  to investigate 
Aram Chaos was Schultz et al. (1982), using Viking data.  They interpreted the Aram 
Chaos crater to be a Noachian aged, 550 km in diameter multi-ringed basin. The current 
Aram  Chaos  morphology  however  is  found  not  to  correspond  with  the  general 
morphology of a multi-ringed basin:

1. The part of Aram Chaos within the middle ring of 280 km diameter has been 
fractured  and  has  subsided  and  collapsed  (Figure  5.2.17).  This  created  an 
approximately 2 km deep depression (see Cross Sections I and II, Figure 5.3.1). 
The middle ring is observed to have an elevated crater rim visible in MOLA data 
(Figure 5.1.2) which makes the middle ring more likely to represent the actual 
crater.  The  elevated  crater  rim,  however,  could  have  been  accentuated  by 
subsidence and erosion of the surrounding HT.

2. The outer ring is not formed by mountains (massifs) and higher relief, which is 
the case with other multi-ringed basins on Mars (Schultz  et  al.,  1982), but by 
channel morphology and chaotic terrain localities (Observation 14). The massifs 
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could have been eroded or buried (see  Outflow episodes). Also other structures, 
such as a possible center or ring uplift, could have been eroded or buried.

According to Schultz et al. (1982) the post crater formation evolution of the Aram Chaos 
crater involved erosion, deposition and ongoing cratering. Igneous activity localized at 
old  ring  faults  could  have  reactivated  crater  structures  and  could  have  localized 
hydrothermal activity. This agrees with the model of HT formation by Rodríguez et al. 
(2005a) and with most of my observations:

1. No Aram Chaos related ejecta has been observed.
2. The HT is observed to continue into Aram Chaos (Observations 16 and 17).
3. Parts of the rim of Aram Chaos consists of small arcs which suggests more craters 

formed after the formation of the Aram Chaos crater and influenced the fracturing 
and collapse within Aram Chaos (Observation 20).

4. The  Aram Chaos  crater,  due  to  its  size,  likely  formed  early  in  the  cratering 
history.

5. If the Aram Chaos crater formed late in the HT evolution it would have disrupted 
the formation of the water filled caverns proposed by Rodríguez et al. (2005a) 
(see Highland Terrain composition and structure).

There are two observations which could be interpreted contradictory to the scenario of a 
continued build-up of the HT after the Aram Chaos crater formation:

1. The current morphology of incised channels, including Ares Vallis, forming the 
outer ring (Observation 14). This suggests the HT morphology was affected by 
the impact of the Aram Chaos crater,  resulting in the incision of the channels 
concentric to Aram Chaos.

2. The middle ring is observed to have an elevated crater rim visible in MOLA data 
(Figure  5.1.2).  The  current  HT  surface  could  therefore  possibly  be  the 
paleosurface in which the crater impacted.

If the interpretation that the Aram Chaos crater is buried within the HT is correct, could 
the current surface and topography still have inherited the crater structure underneath? 
Perhaps ongoing crater modification and/or reactivation of crater structures during HT 
formation, causing the deposited material to inherit subsurface structures, could explain 
the observation. Perhaps ongoing HT formation encompassed mostly a draping style of 
deposition (e.g.  numerous  impact  ejecta  blankets)  which inherited  the  elevated crater 
rim? The first episode of Ares Vallis channelling is interpreted to be a sheet wash, after 
which incision occurred (Observation 1). This sheet wash could perhaps have removed 
HT material, possibly resurfacing terrain which was affected by the impact. Nevertheless, 
the scenario of ongoing HT deposition is found to be best in explaining the observations. 
The key observation in this regard is the observation the HT continues within the Aram 
Chaos crater (Observations 16 and 17).
Glotch and Christensen (2005) interpreted the Aram Chaos crater to be a filled crater, 
including  water  fill.  They  performed  mapping  using  THEMIS  IR,  THEMIS  VIS 
(comparable  in  resolution  to  the  high  resolution  HRSC),  MOC  images  and  MOLA 
elevation data. The findings in this study agree with their interpretation: the occurrence of 
fractures  and  the  observed  HT  subsidence  and  collapse  suggests  material  has  been 
withdrawn from underneath. Because CT are mostly source areas of outflow channels, 
this material is interpreted to be water. After its formation the Aram Chaos crater could 
have been filled up with water or water rich sediment. The HT collapse of Aram Chaos is 
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confined to the 280 km in diameter middle ring. This also suggests the actual crater size 
is 280 km in diameter.
By measuring over 1300 Martian craters using MOLA profiles Garvin et al. (1999, 2000) 
derived relations between crater diameter and depth and crater diameter and volume:

d = 0.98 x D0.18, with d the crater depth and D the crater diameter
V = 0.01 x D3.03 with V the volume of the crater

These relations can be used for the 280 km in diameter Aram Chaos crater to derive a 
depth of 2.7 km and a volume of 259949 km3. I estimate between 47074 km3 and 76496 
km3 material was removed from underneath Aram Chaos (Observation 15). The removed 
material is subsequently between 18% and 29% of the total crater volume. Modelling of 
large craters like Aram Chaos, however, is not well constrained yet (Barlow, personal 
communication). 
The 280 km in diameter  Aram Chaos crater is defined as a ‘proto-basin’ because the 
crater is larger then 90 km in diameter (Garvin et al., 1999). According to Spudis (1994) 
‘basins’ on the Moon are larger then 320 km in diameter. Proto-basin craters can have a 
ring uplift (peak ring) and/or have multiple rings. MOLA data does not reveal an Aram 
Chaos crater  central  or ring uplift  (see Cross Sections I  & II,  Figure 5.3.1).  The  HT 
collapse is observed to be varying, showing an undulating topography (Observation 18). 
This could be due to collapse and localized upward movements (popup) or the collapse of 
the  HT  onto  a  subsurface  topography.  The  latter  is  found  to  be  the  most  simple 
explanation. The origin of the subsurface topography could perhaps be caused by lateral 
differences in the water content of the HT ‘cavernous systems’ proposed by Rodríguez et 
al. (2005a).
The current structure of the 280 km in diameter Aram Chaos crater includes an inner ring 
of 150 km in diameter.  This could perhaps be due to the melt  sheet produced by the 
impact. Grieve and Therriault (2000) discussed the three largest known terrestrial impact 
basins,  Vredefort,  Sudbury  and  Chicxulub,  of  ~250-300,  ~250-300  and  ~180  km in 
diameter, respectively. They state that the thickness of the impact melt sheet is 1/50D and 
it extends 0.5D, with D the crater diameter. If these relations would also apply for Mars, 
the melt sheet of the 280 km in diameter Aram Chaos crater would have been 5.6 km 
thick and 140 km in diameter. This could perhaps have had a significant influence on 
subsequent  crater  infilling  and could  perhaps  have  structurally  controlled  the  current 
~150 km in diameter inner ring structure.
In  summary,  the crater  is  most likely 280 km in diameter.  When it  impacted,  in  the 
Noachian, the atmosphere may have been denser, and the climate warmer (see  6.2.1.1.  
Highland Terrain composition and structure). This resulted in the crater fill of water rich 
material, perhaps 18% to 29% of the total crater volume. Ongoing formation of the HT, 
including cratering, buried the crater and its infill.

6.2.2.2. Aram Chaos fractured and chaotic terrain
This subsection will discuss the fracturing of the Highland Terrain and the formation of 
the Chaotic Terrain within Aram Chaos. The fracturing and chaotization of the Lower 
Aram Chaos Formation, within the inner ring of Aram Chaos will be discussed in 6.2.2.3.  
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The Lower Aram Chaos Formation subsection. The release of water is discussed in the 
6.2.2.4. Water activity in Aram Chaos subsection.
The following definition of the chaotic terrain is used in this study: Chaotic Terrain (CT) 
is considered a lateral unit of the HT which is observed to have lost coherence with the 
surrounding HT, due to fracturing and erosion.  This is different  from the Glotch and 
Christensen (2005) definition. They also consider fractured terrain to be chaotic terrain.
The fractured Highland Terrain occurs between the inner and middle ring of Aram Chaos 
(Observation 14). Glotch and Christensen (2005) mapped the HT within Aram Chaos as 
Fractured Plains (see Figure 6.4). The fracturing formed 10 km scale HT mesas. Two 
windows of HT have been observed within the Lower Aram Chaos Formation (LACF) in 
the inner ring. These windows are interpreted to be fracture bounded HT mesas which 
indicates fractured HT also occurs within the inner ring, now covered by the Aram Chaos 
Formation (see Observations 26 and 28 and Cross Sections I & II, Figure 5.3.1). The 
fracturing included subsidence and collapse (see Cross Sections I & II, Figure 5.3.1).
The fracturing and collapse of Aram Chaos varies in intensity and characteristics. The 
pattern of the HT fractures is approximately concentric to the crater (Figure 5.5.2a), but 
can vary at different locations (Figure 5.5.1). In the Eastern quadrant of Aram Chaos f.e. 
no concentric ring fractures are observed and no collapse occurred; perhaps only bending 
of the HT inwards due to the collapse of the central region (Observation 23). The fracture 
pattern in the Eastern quadrant consists of relatively small fractures (see Figure 5.1.5, the 
Geological  Map  of  Aram  Chaos)  compared  to  the  other  quadrants.  The  Principal 
Orientations  (Figure  5.5.1)  of  the  fractures  differ  from the  other  quadrants,  which is 
mainly due to the lack of concentric ring fractures. The fractures occur in at maximum 
~500 m high mesas  and hills,  mapped as  Highland Terrain  (the  mesas)  and Chaotic 
Terrain.  They  are  based  on  relatively  smooth  terrain  (mapped  as  Highland  Terrain), 
which is covered by AACD (Observation 24). It is therefore inferred that the fractures 
extend to ~500 m depth. The chaotization subsequently degraded and eroded the HT until 
the ~500 m base. If the AACD was deposited on top of the HT base (see the  6.2.2.4.  
Water  activity  in  Aram  Chaos  subsection)  this  would  make  the  Eastern  quadrant 
chaotization older then the AACD deposition.
In the south of Aram Chaos Chaotic Terrain occurs (see Figure 5.1.5, the Geological Map 
of Aram Chaos), which is mapped as Knobby Terrain by Glotch and Christensen (2005). 
The Principal Orientations of this region (Figure 5.5.1) are not concentric to the crater. A 
broken up HT mesa within the Aram Chaos southern CT (Observation 21), suggests two 
different  fracturing  processes  occurred  within  Aram Chaos:  1)  large  scale  fracturing 
forming the ~10 km HT mesas, 2) smaller scale fracturing forming the ~1 km sized CT 
hills.  The  latter  process  involved  intense  fracturing,  e.g.  brecciation.  The  brecciation 
forming the southern CT most likely occurred prior to or during the large scale fracturing 
because  the  surrounding  fractured  HT contains  a  relatively  high amount  of  fractures 
radial to the southern CT (Figure 5.5.2c). This suggests the fracturing of the surrounding 
HT has  been influenced  by the  southern  CT region.  Possible  water  release  from the 
Southern CT will be discussed in the 6.2.2.4. Water activity in Aram Chaos subsection.
Other radial fracture patterns can be observed within the fractured HT (Observation 19), 
suggesting localized processes occurred at more locations. The possible processes behind 
the  fracturing  and chaotization  will  be discussed in  6.2.4.  Chaotic  terrain formation. 
Fracturing may be active in Aram Chaos until today (Observation 7).
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6.2.2.3. The Lower Aram Chaos Formation
This  section  will  discuss  the  deposition  and  fracturing  of  the  Lower  Aram  Chaos 
Formation. Its relation to the possible release of water will be discussed in the  6.2.2.4.  
Water activity in Aram Chaos subsection. Spectral mapping of the smooth LACF will be 
discussed in the 6.2.2.5. Spectral mapping of the layered deposits subsection.
The Lower Aram Chaos Formation (LACF) is divided in three lateral units, the fractured, 
broken and smooth LACF, and has been deposited on top of the fractured HT within the 
inner ring of the Aram Chaos crater.  It is therefore interpreted to have been deposited 
after the inner ring, consisting of subsided HT, formed (see Observation 22). Multiple HT 
and CT windows can be observed within the LACF (see Figure 5.1.5, the Geological 
Map of Aram Chaos).
The extent of the fractured Lower Aram Chaos Formation approximately agrees with the 
combined  extent  of  the  Subdued  Terrain  and  the  High  TI  (Thermal  Inertia)  Chaos, 
mapped by Glotch and Christensen (2005) (see Figure 6.4). They interpreted the High TI 
Chaos to be chaotic terrain formed by reworking their Fractured Plains unit (the HT). 
They observed “muted fractures” within the Subdued Terrain but did not discuss them. 
Their mapping does not agree with the findings of this study:

1. The fractured LACF is defined by its  fracture pattern and its  distinct  ‘glossy’ 
morphology (see Table 5.1). The fracture pattern and morphology of the Subdued 
Terrain  and  High  TI  Chaos  is  observed  to  be  similar  (see  Figure  5.1.5,  the 
Geological Map of Aram Chaos).

2. The fractured LACF is observed to be a deposit on top of the HT, approximately 
~350 m thick (Observation 26).

3. The high thermal inertia (TI) of the High TI Chaos is interpreted to be caused by 
the intense fracturing (see Figures 6.4 and 6.5).

The  extent  of  the  broken  LACF  does  not  agree  with  the  mapping  by  Glotch  and 
Christensen (2005) (see Figure 6.4). It mainly consists of the Knobby Terrain and High 
TI Chaos units, mapped by Glotch and Christensen (2005), which they interpret as lateral 
units, varying in the amount of disturbance. Also the CT in the south of Aram Chaos is 
mapped as Knobby Terrain by Glotch and Christensen (2005). This does not agree with 
my findings: the broken LACF consists of km scale mesas and smaller hills, whereas the 
CT  consists  of  broken  up  HT  mesas  forming  km  scale  rounded  and  sharp  hills 
(Observation 21).
The  extent  of  the  smooth  LACF  does  not  agree  with  the  mapping  by  Glotch  and 
Christensen (2005) (see Figure 6.4). It consists of the Primary and Secondary Hematite 
Units and the Non-Hematite Layered Unit, mapped by Glotch and Christensen (2005). 
Within the smooth LACF the mineral hematite, the sulphate kieserite and other hydrated 
minerals  have been detected  by TES and OMEGA. This  is  discussed in  the  6.2.2.5.  
Spectral mapping of the layered deposits subsection. The smooth LACF is interpreted to 
be a drape over underlying HT (Observation 27). This suggests the smooth LACF was 
deposited after the HT fracturing, subsidence and collapse had started.
The fractured, broken and smooth LACF were mapped as lateral units, because: 1) they 
are observed to be deposited on top of the HT and CT and underlying the Intermediate 
Aram Chaos Formation (see Cross Sections I & II, Figure 5.3.1) and 2) the broken and 
fractured LACF show a gradual transition boundary (Boundary 2, Table 5.2). The smooth 
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LACF however could also be a thin deposit on top of the fractured LACF (Boundary 3 in 
Table 5.2). There are arguments for and against this interpretation of the smooth LACF:

1. A HT-scale fracturing pattern can be observed within the fractured LACF (see 
Figure 5.1.5, the Aram Chaos Geological Map) suggesting the fracture pattern is 
(partly) controlled by HT blocks underneath. If the smooth LACF is a lateral unit 
perhaps no HT collapse  occurred underneath  these  locations.  This  however  is 
considered to be unlikely, making the smooth LACF a distinct unit.

2. The mineral hematite, the sulphate kieserite and other hydrated minerals, detected 
by TES and OMEGA (see  6.2.2.5.  Spectral  mapping of the layered deposits), 
were not detected in the broken and fractured LACF. This could be used to argue 
that the smooth LACF is indeed a distinct unit, although the mineral detection 
could perhaps also be caused by a thin cover (see 6.2.2.5. Spectral mapping of the  
layered deposits).

3. Some fractures within the LACF have raised rims and some show small thrusts at 
the base of the rim (Observation 30). This could have been caused by: 1) lateral 
compression due to subsidence and collapse of HT blocks underneath and/or 2) 
localized  release  of  water  from underneath  the  deposited  LACF,  forming  the 
LACF  fractures.  The  latter  suggests  the  smooth  LACF  is  a  lateral  unit.  The 
possible release of water will be discussed in the 6.2.2.4. Water activity in Aram 
Chaos subsection. Lateral compression can be explained by the inward dip of the 
concentric  rim  faults  of  multi-ring  craters  like  Aram  Chaos  (Figure  3.11): 
subsiding  material  cannot  be  easily  accommodated  and the  subsidence  causes 
inward compression.  The weak NNW-SSE and NE-SW Preferred Orientations 
could be indicative of the dominating compressive directions (normal to the two 
Principal Orientations: NEE-SWW, NW-SE).

4. The most southern window of fractured LACF within the smooth LACF is located 
at the boundary of the LACF and the CT and  Rounded Chaotic and Highland 
Terrain (RCHT) (Boundary 3 of Table 5.2, Figure 5.1.20). The fracturing pattern 
is  observed  to  continue  within  the  CT.  This  suggests  the  LACF  is  a  drape, 
deposited after the formation of the CT. The fracturing of the LACF could have 
formed after localized activity occurred (e.g. water release), suggesting a lateral 
unit explanation. The observation that the fractured LACF formed after the CT 
formation would indicate the CT in the Eastern quadrant of Aram Chaos formed 
prior to the deposition of the Aram Chaos Formation.

Considering the different arguments, the interpretation of the smooth LACF as a distinct 
unit, covering the fractured LACF, is found to be the most convincing. This suggests the 
fractured LACF extended at least as far East as the most Eastern fractured LACF window 
within the smooth LACF (see the Geological Map of Aram Chaos, Figure 5.1.5), which 
still  indicates  a  deposition of  the LACF within  the inner  ring of  Aram Chaos.  After 
deposition  the  LACF became fractured  and  broken.  The broken LACF could  be  the 
locations where water was released to the surface. This is further discussed in the 6.2.2.4.  
Water activity in Aram Chaos subsection. The smooth LACF was subsequently deposited 
as  the  first  unit  of  the  non-fractured  part  of  the  Aram  Chaos  Formation.  This  was 
followed by the deposition of the Intermediate Aram Chaos Formation and the Upper 
Aram Chaos Formation, which subsequently underwent erosion.
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6.2.2.4. Water activity in Aram Chaos
This section will discuss the possible 1) in and outflow of water though the Aram Chaos 
channel, 2) release of water from the Aram Chaos subsurface, 3) ponding within Aram 
Chaos. This is not a sequence of events.
The occurrence of the Aram Chaos channel connecting Aram Chaos with Ares Vallis 
suggests in and outflow of water occurred. It is reasonable to assume the channel formed 
by either crater inward or crater outward flow over the Aram Chaos rim, after which the 
channel incised. The depth of the channel relates to the depth of Aram Chaos subsidence 
which suggests  the incision occurred during ongoing subsidence. On the Aram Chaos 
crater rim the Aram Ares Channel Deposits (AACD) have been mapped. The AACD has 
a distinct morphology of lineations and small elongated hills, which is interpreted to be 
caused by water flow after deposition. Glotch and Christensen (2005) mapped the AACD 
as the more extensive Outflow Plains Unit (Figure 6.4).
Cabrol and Grin (2002) identified a possible sub-lacustrine delta structure at the Aram 
Chaos  part  of  the  Aram  Chaos  channel  (Figure  3.5),  indicating  inward  flow.  This 
structure  is  interpreted  in  this  study,  using  high-resolution  HRSC data,  to  consist  of 
streamlined  HT  mesas,  which  are  capped  by  the  AACD  (Observation  25).  The 
streamlined mesas were formed by crater  outward flow.  This  indicates  the AACD is 
deposited on top of the HT, after which both have been incised by crater outward flow 
through the Aram Chaos channel. This observation, and the fact that the AACD occurs on 
the crater rim would suggest  the AACD has been deposited early in the evolution of 
Aram Chaos as a result of crater inward flow. Glotch and Christensen (2005) do not 
discuss how the Outflow Plains Unit relates to the other deposits in Aram Chaos. In this 
study the  smooth LACF is  observed to embay the  AACD capped streamlined mesas 
(Figure 6.6), which  suggests the smooth LACF is younger then the AACD. A deposit 
looking similar to the AACD has been observed on a terrace of Ares Vallis, North of 
Aram Chaos (Observation 3, compare Figure 5.2.4 with Figure 5.1.10j).
The AACD morphology is also observed in the Aram Chaos channel wall, forming linear 
ridges (Observation 25, Figure 5.2.25d). Two scenarios could explain this observation 
(Figure 6.7):

1. The AACD forms layering within the Aram Chaos channel wall (Figure 6.7a).
2. The AACD is draped over the Aram Chaos channel wall (Figure 6.7b).

The first scenario suggests the AACD was deposited in a basin because it has a thickness 
of at least 1 km (the Aram Chaos channel wall height). Perhaps the AACD was deposited 
after the subsidence and collapse? This does not agree with the observations: the Aram 
Chaos channel incised the non-subsided Eastern quadrant in which the AACD occurs. 
Perhaps the AACD obscures faults? If this is not the case it suggests  the AACD forms 
part  of  the  HT  stratigraphy,  which  has  now  been  resurfaced.  The  AACD  could  be 
resurfaced deltaic  deposits  which  formed after  the Aram Chaos crater  impact,  in  the 
Noachian, during the HT formation when the water rich crater fill occurred (see 6.2.2.1.  
Crater formation and early evolution).
The second scenario would make the start of the Aram Chaos channel incision older then 
the AACD. The AACD capped streamlined HT mesas would then indicate at least one 
episode  of  crater  outward water  flow occurred after  the  AACD draping.  The AACD 
draping most likely originated from crater inward flow over the rim. The depth of the 
Aram Chaos channel at that time would most likely have been comparable with the depth 
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of incision of Ares Vallis. It would therefore be unlikely that water originating from Iani 
Chaos flowed over the, 2 km higher in elevation, Aram Chaos rim. It is therefore most 
likely the AACD forms layering. In any case, a more detailed study of the Aram Chaos 
channel region is needed to confirm one of the proposed scenarios, using f.e. HiRISE 
images and HRSC DTMs.
Crater  outward  flow  through  the  Aram  Chaos  channel  could  have  occurred  after 
subsurface water release within Aram Chaos. The water could have migrated through the 
HT fractures to the surface (Glotch and Christensen, 2005), perhaps resulting in ponding 
and/or flowing through the Aram Chaos channel. The CT in the south of Aram Chaos, 
which is interpreted to be brecciated HT (see 6.2.2.2. Aram Chaos fractured and chaotic  
terrain), could have resulted in the, most likely explosive, release of water. This water 
could have ponded within Aram Chaos or could have flowed through the Aram Chaos 
channel. Rotto and Tanaka (1995) f.e. interpreted the Aram Chaos channel to be larger, 
connecting  the  CT  in  the  south  of  Aram Chaos  with  Ares  Vallis  (Figure  6.8).  The 
mapping  of  this  study  however  did  not  detect  channel  morphology  within  the  Aram 
Chaos part of this possible channel: it is mapped as CT (see the Geological Map of Aram 
Chaos, Figure 5.1.5). Flooding from the southern CT could still have chosen this path and 
water could also have been released from the subsurface. If the Aram Chaos Formation 
had already been deposited it would most likely have been affected by the water release 
from the southern CT. This is however not observed, which would make  the outflow 
from  the  southern  CT  having  occurred  prior  to  the  deposition  of  the  Aram  Chaos 
Formation.
The fractured and broken LACF could have been deposited,  prior to fracturing,  after 
ponding  of  water  within  the  inner  ring  of  Aram  Chaos.  The  LACF  could  have 
subsequently  been fractured and been broken due  to ongoing water  release  from HT 
fractures underneath. This is strengthened by the observation of a HT-scale fracturing 
pattern within the fractured LACF (see Figure 5.1.5, the Aram Chaos Geological Map). It 
is however also possible that the material forming the fractured and broken LACF was 
transported into Aram Chaos through the Aram Chaos channel.
Glotch and Christensen (2005) interpret all the layered deposits to have formed in a sub-
lacustrine environment. This is not found to be likely because the Intermediate and Upper 
Aram Chaos Formation form a dome shape (see Cross Sections I & II,  Figure 5.3.1) 
which  cannot  be  easily  explained  by  a  sub-lacustrine  environment.  The  detection  of 
hematite, kieserite and other hydrates minerals within the smooth LACF and the IACF 
(see  6.2.2.5. Spectral mapping of the layered deposits) in any case suggest water was 
involved in the formation of the deposits.  More layered deposits with the characteristic 
dome shape have been observed on Mars (see f.e.  Fueten et  al.,  2006), but none are 
capped by material with an ‘icing’ texture as is the case with the ACF. Rossi et al. (2007) 
interpret dome shaped layered deposits to be the result of inclined deposition of layered 
deposits in long lasting spring deposits.
To conclude, no clear chronological episodes of water release, proposed by Glotch and 
Christensen  (2005),  can  be  observed,  although  the  differences  in  chaotization  within 
Aram Chaos suggest different events of water release occurred.

6.2.2.5. Spectral mapping of the layered deposits
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Spectral mapping of Aram Chaos was performed using TES (Glotch and Christensen, 
2005) and OMEGA (Gendrin et al., 2005; Combe et al., 2005). Glotch and Christensen 
(2005) detected grey crystalline hematite and Gendrin et al. (2005) detected the sulphate 
kieserite  and  other  hydrated  minerals,  within  what  was  mapped  in  this  study as  the 
smooth LACF and the IACF. Analysis of Aram Chaos spectra from OMEGA suggests 
red particulate hematite is present (Combe et al., 2005). They did not provide a map of 
the abundance. Grey crystalline hematite can be produced in an aqueous or hydrothermal 
depositional environment. Red particulate hematite is generally produced by leaching and 
weathering processes (Glotch and Christensen, 2005).
The mapping of the layered deposits by Glotch and Christensen (2005) was largely based 
on TES hematite distribution data (compare Figure 3.7 with Figure 6.9). They mapped a 
Primary and Secondary Hematite Unit and a Non Hematite Layered Unit. The extent of 
the Intermediate  Aram Chaos Formation (IACF) and the smooth Lower Aram Chaos 
Formation (LACF) together is largely the same as the combined extent of these three 
units  (see  Figure  6.4).  The  Primary  Hematite  Unit  covers  the  three  highest  hematite 
abundance patches. According to Glotch and Christensen it contains basaltic sand with a 
hematite  abundance  between  10%  and  15%.  The  Secondary  Hematite  Unit,  which 
surrounds the Primary Hematite Unit and contains less hematite, is interpreted by Glotch 
and  Christensen  (2005)  to  be  eroded  Primary  Hematite  Unit  material  which  was 
transported downhill. The Non-Hematite Layered Unit doesn’t contain hematite and is 
interpreted to be morphologically identical to and stratigraphically below the Primary 
Hematite Unit. It is mineralogically similar to the Subdued Terrain. This does not agree 
with my mapping:

1. HRSC data shows that the highest hematite abundance patches do not correlate 
with a distinct morphology (Figure 6.10). The morphology of the patches also 
differs among each other: one patch is being located in the smooth LACF, the 
other patches occur in the rougher IACF (Figure 6.10). However, hematite has 
also been detected in Aureum Chaos by Glotch et al. (2005), occurring near the 
Aureum Chaos Deposits (ACD). These deposits exhibit the same ‘icing’ texture 
as  the  UACF.  This  indicates  the  hematite  could  be  associated  with  this 
morphology.  However,  no  hematite  has  been  detected  within  the  UACF  and 
ACD.

2. Some of the Primary Hematite Unit locations, mapped in this study as the smooth 
LACF, are observed to stratigraphically underlie the deposits with high hematite, 
the IACF (see Cross Sections I & II, Figure 5.3.1).

3. The  locations  mapped  as  the  Non-Hematite  Layered  Unit  are  observed  to  be 
morphologically  different,  either  smooth  (the  smooth  LACF)  or  more  rugged 
(IACF).

This  suggests  the  hematite  is  uncorrelated  to  the  morphology.  It  could  however  be 
associated with the UACF and ACD. The hematite could perhaps be present within a lag 
deposit formed by deflation of the UACF and the ACD. The occurrence of UACF mesas 
within the IACF indeed suggests the deposit was once more extensive (see Figure 5.1.5, 
the Geological Map of Aram Chaos).
Using  OMEGA data  Gendrin  et  al.  (2005)  detected  the  sulphate  kieserite  and  other 
hydrated  minerals  within  Aram  Chaos  (Figure  6.11).  These  findings  approximately 
correlate with the mapping of this study (Figure 6.11): most smooth LACF is observed to 

73



be kieserite rich (red) and most IACF is observed to be rich in other hydrated minerals 
(pink). Only the most eastern outcrop of the smooth LACF does not correlate with a high 
amount of kieserite (Figure 6.11). This suggests the mapping of this study is wrong and 
the most eastern outcrop of the smooth LACF is in fact IACF. If this apparent correlation 
with morphology is correct it indicates water was involved in the formation of the smooth 
LACF and IACF.
The analysis of the OMEGA data in this study did not result in the detection of minerals 
(see 5.1.3.1. OMEGA mapping results). The combined extent of the smooth LACF and 
IACF was visible only for the ‘large spectral feature’ (see Figures 5.1.32 and 5.1.33). 
This feature however cannot be used to distinguish between mineralogy. It was observed 
within the mean spectra (see Figures 5.1.27 and 5.1.28) and is not an absorption feature, 
which are used to detect minerals. To conclude, the OMEGA results by  Gendrin et al. 
(2005) could not be reproduced.

6.2.2.6. Late-stage evolution
This subsection will discuss the late-stage development of the layered deposits within 
Aram  Chaos.  The  current  morphology  of  the  Aram  Chaos  Formation,  consisting  of 
multiple  mesas,  suggests  erosion  took  place  after  the  formation  of  the  ACF.  Flow 
morphology occurs in the Intermediate Aram Chaos Formation (IACF) (Figure 5.1.10h), 
which are parallel to the dominant wind direction (Figure 5.5.8). This suggests a wind 
related origin. The release of water through broken and fractured LACF could perhaps 
have  caused  weakening  of  the  overlying  ACF  layers,  after  which  surface  erosion 
processes exposed the fractured LACF windows. This would indicate water release was 
active after the formation of, at least part of, the non-fractured ACF
Small  patches of the Upper  Aram Chaos Formation (UACF),  mapped by Glotch and 
Christensen (2005) as the Cap Unit,  are located around the main deposit  (see Figure 
5.1.5,  the  Aram Chaos  Map).  Glotch  and  Christensen  (2005)  therefore  interpret  the 
deposit  was  once  more  extensive  and  has  been  eroded,  which  agrees  with  the 
interpretation  of  this  study.  The  mapping  extent  of  both  UACF and Cap Unit  agree 
because on THEMIS VIS, MOC and HRSC images the UACF material highly contrasts 
with the surrounding units (see Figure 6.4).
No fracturing is visible within the UACF outcrops, although sharp linear escarpments of 
the UACF mesas  (see Figure 5.1.5,  the Geological  Map of Aram Chaos) occur.  The 
general trend of this erosion morphology (the trend of the ACF mesa escarpments) is 
parallel to the general wind direction (compare Figure 5.1.5 with Figure 5.5.8). However, 
the trend is also parallel to one of the fractured LACF fracture Principal Orientations 
(Figure 5.5.1). This suggests both wind and fracturing have played a role in shaping the 
current erosion morphology. According to Glotch and Christensen (2005) a crater related 
doming  event  occurred  which  tilted  the  layered  deposits  (Figure  3.12).  This  is  one 
possibility; another being that the IACF and UACF were deposited prior or during the 
LACF fracturing event, caused by ongoing HT subsidence and collapse. Smooth LACF, 
which  occurs  stratigraphically  below the  IACF and UACF,  has  not  been extensively 
fractured. Therefore the current erosion morphology of the smooth LACF, the IACF and 
the UACF is interpreted to be caused by the dominant wind direction.

6.2.2.7. Summary
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This  section  describes  the  summarized  sequence  of  events  and  will  summarize  the 
differences  between  the  mapping  of  this  study  and  the  mapping  by  Glotch  and 
Christensen (2005).
The following sequence of events for Aram Chaos are proposed (see Figure 6.1):

1. HT formation during the Noachian including formation of the Aram Chaos 280 
km  in  diameter  crater.  Tharsis  related  regional  deformation  was  active.  The 
AACD could have formed as a deltaic deposit when the crater was filled with 
water rich material. This would imply the Noachian climate was warmer and the 
atmosphere was thicker compared to the current situation.

2. In the Hesperian the climate became colder and the water became ice. Subsequent 
pulses of endogenic heat could have melted the ice. This would have caused an 
unstable  situation  after  which  the  overlying  HT  collapsed.  This  resulted  in 
decompression vaporization which led to the brecciation of the southern CT (see 
6.2.4. Chaotic terrain formation).

3. Ongoing fracturing, subsidence and collapse of the HT in Aram Chaos, possibly 
resulting  in  water  release  through  the  fractures.  Ongoing  channel  incision. 
Formation of the Eastern quadrant CT.

4. Formation of the 150 km in diameter inner ring of Aram Chaos by HT subsidence 
and collapse.

5. Water ponding within the inner ring and the subsequent deposition of the LACF 
(except  the  smooth  LACF).  The  water  could  have  originated  from  the  HT 
fractures  or CT within Aram Chaos or from outside Aram Chaos through the 
Aram Chaos channel.

6. Fracturing  and  chaotization  of  the  LACF  due  to  ongoing  HT  fracturing, 
subsidence, collapse and possibly water release.

7. The possible draping of the AACD.
8. Formation of the smooth LACF, IACF and UACF on top of the fractured and 

broken LACF. The detection of hematite, kieserite and other hydrated minerals 
suggests water was involved in the formation of the units.

9. Erosion and possibly deflation of the UACF, IACF and smooth LACF by wind.
The mapping performed by Glotch and Christensen (2005) shows some major differences 
with the mapping of this research:

1. Mapping of the layered deposits by Glotch and Christensen (2005) is based on 
TES hematite abundances, but it is observed not to correlate with morphologically 
defined units in this study. It could perhaps be a thin cover, although controlled by 
outcrops.

2. The structural  and morphological  similarity  between Subdued Terrain  and the 
High  TI  Chaos  (both  mapped  in  this  study  as  the  fractured  LACF)  is  not 
recognized by Glotch and Christensen (2005).

3. The morphological difference between broken LACF and CT is not recognized by 
Glotch and Christensen (2005).

4. The  resulted  map  (Figure  3  in  Glotch  and  Christensen,  2005)  is  of  a  lower 
resolution then the mapping of this study.

The differences are not due to differences in data coverage, but, as said before, by their 
incorporation of TES data and the incorporation of HRSC anaglyphs in this study to 
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allow  3D mapping.  The  mapping  in  this  study is  mostly  based  on  morphology  and 
structure visible in high resolution HRSC and THEMIS VIS.

6.2.3. Evolution of Aureum and Iani Chaos
This section will discuss the evolution of the Aureum and Iani Chaos regions within my 
study area. Both regions are mapped as Chaotic Terrain (CT), surrounded by fractured 
HT (mesas), and have undergone subsidence and collapse. Subsequently deposits formed 
on top of the CT.
The part of Aureum Chaos in my study area is not connected to Ares Vallis, it is one of 
the source areas of the Simud and Tiu Vallis systems, of which Valles Marineris is also a 
source  area  (Figure  3.1).  Numerous  impact  crater  remnants  can  be  observed  within 
Aureum Chaos (see f.e. Figure 5.2.7 and Cross Section III, Figure 5.3.2). Fracturing may 
be active in Aureum Chaos until today (Observation 7). Deposits, mapped as Aureum 
Chaos Deposits  (ACD),  occur  on top of the CT (see the Geological  map of Aureum 
Chaos, Figure 5.1.6). The ACD morphology is similar to the UACF, exhibiting sharp 
escarpments  and  an  ‘icing’  texture  (Figure  5.1.17c  and  5.1.18).  Glotch  et  al.  (2005) 
observed hematite  within the CT near the ACD. This indicates the hematite could be 
associated with this morphology. However,  no hematite  has been detected within the 
UACF and ACD.  It  could  perhaps  be  present  in  the  stratigraphy of  both  units.  The 
hematite  could  be  lag  deposits  formed  after  deflation  of  the  UACF and  ACD.  This 
suggests  both  units  were  once  more  extensive  (for  UACF  see  6.2.2.6.  Late-stage 
evolution).
Iani Chaos lies within an outflow channel system connecting Margaritifer Valles in the 
south with Ares Valles in the north (Figure 3.9). It has therefore also been flooded. The 
incision  by  water  flow  from  Margaritifer  Valles  could  perhaps  have  lowered  the 
overpressure of buried water rich deposits triggering the formation of Iani Chaos (e.g. 
Coleman,  2005).  Channel  morphology  remnants,  surrounded  by  chaotic  terrain  occur 
within the northern part of Iani Chaos (Figure 5.2.3). This suggests that the chaotization 
progressed downstream, destroying channels. The CT farthest away from the current start 
of  the  outflow channel  would  then subsequently  be  the  oldest,  although chaotization 
could also have progressed upstream, fracturing and eroding the surrounding HT.
No clear crater remnants have been observed within Iani Chaos. The northern part of Iani 
Chaos is interpreted to be part of the Aram Chaos outer ring. This suggests structural 
control of at least the Aram Chaos crater is present (Schultz et al.,  1982). Within the 
northern part of Iani Chaos ridges occur which have been interpreted to be caused by 
compression (Observation 7). The compression ridges are fractured and are subsequently 
interpreted to have formed before the fracturing. They could perhaps have formed by 
upward stresses due to the instability of subsurface water.
The Iani Chaos Deposits (ICD) occur on top of the Iani Chaos CT (Cross Section IV, 
Figure 5.3.3 and the Geological map of Iani Chaos, Figure 5.1.7). The ICD have been 
divided into five types on the basis of morphology. They occur in patches and are not 
connected, except for type 3, which is non-horizontally layered (see 9 in Figure 5.4.2) 
and lies stratigraphically on top of type 4. The brightest deposits (types 2 and 4) have 
been influenced by wind erosion. Type 4 is morphologically similar to the smooth LACF 
and type 5 is morphologically similar to the UACF. Because of the possible association 
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of  the  UACF and ACD with hematite  (see  6.2.2.5.  Spectral  mapping of  the  layered 
deposits) it would be expected that hematite occurs around the type 5 deposits.
Activity within the CT of Aureum and Iani Chaos would have destroyed the ACD and 
ICD. The ACD and ICD are therefore interpreted to have formed during or after the final 
stage of water release from the CT. The similarity in morphologies between the ACF, 
ACD and ICD suggest that (parts of) the ICD and ACD have a similar origin as the Aram 
Chaos Formation deposits.

6.2.4. Chaotic terrain formation
Rodríguez et al. (2005a) did not discuss the origin of the HT and CT fracture patterns. 
Following their model it is likely the HT and CT fracture patterns (Figure 5.1.9) were 
formed  by  1)  crater  related  fractures  and  2)  cavern  subsidence  and  collapse  related 
fractures (see f.e. Cross Sections I & II, Figure 5.3.1). I propose a third process which 
could explain the observed fracture pattern and could explain the CT morphology: fluid 
assisted  brecciation.  This  process  occurs  on  Earth  and  is  associated  with  temporal 
variations  in  fluid  pressure  (e.g.  pulses)  in  a  hydrothermal  system  (Jébrak,  1997). 
According to Jébrak (1997) this occurs in two steps:

1. Hydraulic  fracturing,  which  occurs  when  the  fluid  pressure  increases  causing 
fracture  propagation.  Most  hydraulic  fracturing  on  Earth  occurs  during  an 
extensional stress. 

2. Critical fracturing occurs when the equilibrium between the fluid pressure and the 
lithostatic pressure is destroyed. A sudden opening (f.e. due to faulting) causes the 
fluid  pressure  to  decrease  resulting  in  decompression  and  brecciation.  The 
intersection  line  of  growing  fractures  are  commonly  zones  of  increased 
brecciation.

In this proposed scenario the hydrostatic pressure of the water in a hydrothermal system 
resulted  in fracture  propagation (hydraulic  fracturing).  The fracturing destabilized the 
overlying  HT  causing  it  to  collapse.  This  could  subsequently  have  resulted  in 
decompression of the water and brecciation of the overlying HT (critical fracturing). The 
decompression could have caused the liquid water to turn into vapour (Figure 6.12) after 
which  it  was  released  to  the  surface.  This  most  probably  was  an  instantaneous  and 
catastrophic  event.  The  resulting  decrease  in  water  volume  probably  caused  more 
instability of the overlying HT, resulting in more collapse and an increase in the pore 
pressure.  If  the  hydrothermal  system  remained  unconfined,  fluid  assisted  brecciation 
probably  did  not  occur  anymore.  HT  collapse  could  however  also  have  caused  the 
formation of confined spaces in the hydrothermal system. This could have resulted in 
renewed fluid assisted brecciation. 
The following observations  are  interpreted  to  be consistent  with  the  process  of  fluid 
assisted brecciation:

1. The current CT morphology consists of km-scale hills which are interpreted to be 
fracture bounded. The fracture density within the CT is higher than within the HT 
(Observation 10). The CT are interpreted to be the locations where groundwater 
emerged (Newsom, 2001). The surface release of water was likely an explosive 
event causing brecciation of the HT.

2. In the southern CT of Aram Chaos a broken up HT mesa is observed (Observation 
21).  This  suggests  two  different  fracturing  processes  occurred  within  Aram 
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Chaos: 1) large scale fracturing forming the ~10 km HT mesas, 2) smaller scale 
fracturing forming the ~1 km sized CT hills. The latter process involved intense 
fracturing, e.g. brecciation.

3. Within the fractured HT zones of intense fracturing are observed (Observation 9) 
which  are  interpreted  to  be zones where  1)  hydrothermal  activity  was  greater 
compared to other locations but 2) where the water did not reach the surface as 
was the case with the CT.

4. The build-up of the fluid pressure could have resulted in upward stresses of the 
HT above  and  subsequent  lateral  compression  of  the  HT.  This  could  explain 
compression related ridges in the North of Iani Chaos (Observation 8).

5. A radial fracture pattern is observed around the center of the CT in the south of 
Aram Chaos (Figure 6.6). The fractures could be 1) crater fractures or 2) fractures 
propagating radial outward from the Aram Chaos CT center. Other radial fracture 
patterns (e.g. Observation 19) can be observed in Aram Chaos.

Crater counts suggest the outflow channelling occurred in episodes in the Hesperian and 
into  the  Amazonian  (Masson  et  al.,  2001).  If  the  climate  during  the  Hesperian  and 
Amazonian was similar to the current climate, the buried water was most likely in the 
form of ice. If fluid assisted brecciation occurred the water must therefore have been 
liquid and under high temperature in a hydrothermal system. Only subsurface igneous 
activity could have created such an environment.

78



7. Implications and conclusions
This section will describe the implications and conclusions of this research. The goals of 
this  research  (see  1.  Introduction)  have  mostly  been  achieved:  only  the  creation  of 
minerals maps from OMEGA data was not successful. HRSC DTMs were available but 
were of the same resolution as the MOLA data and consequently only MOLA elevation 
was used.
The following implications and conclusions can be made about the regional evolution and 
geology:

1. Rodriquez  et  al.  (2005a)  proposed  the  stratigraphy  of  the  Highland  Terrain 
contains many buried impact craters, filled with water rich material, indicating a 
warmer climate during the Noachian. I propose the HT is formed by a complex 
interplay between the processes of volcanism, cratering, erosion, deposition and 
(regional) deformation (see 6.2.1.1. Highland Terrain composition and structure 
and Figure 6.3). This has implications for the rheology and density estimation of 
the, multiple kms thick, HT stratigraphy.

2. I agree with the model of chaotic terrain formation by Rodríguez et al. (2005a). 
They proposed the HT consists of water filled ‘cavernous systems’,  which are 
combined  fracture  systems  of  many  buried  impact  craters.  According  to  this 
model crater related fractures and cavern subsidence will  explain the observed 
surface  fracture  patterns.  I  propose  a  third  process,  which  could  have  been 
responsible for the observed fracture pattern and the formation of the CT: fluid 
assisted brecciation. This involved two steps: 1) fracture propagation due to an 
increase  in  hydrostatic  pressure  (hydraulic  fracturing)  and  2)  subsequent 
destabilization and collapse of the overlying HT resulting in decompression of the 
water and brecciation (critical fracturing). The decompression most likely resulted 
in  the  vaporization  of  the  water,  which  was  catastrophically  released  to  the 
surface. If the proposed process of fluid assisted brecciation is correct it indicates 
hydrothermal systems were present, already proposed by Rodríguez et al. (2005a). 
This implies subsurface igneous activity was the main trigger for chaotic terrain 
formation. 

3. Regional  deformation  most  likely  did  not  occur  during  the  formation  of  the 
fractures in the HT and CT. Buried and subsurface deformation structures, most 
likely related to Tharsis, could however be present in the HT stratigraphy.

The following implications and conclusions can be made about the geology and evolution 
of Aram Chaos:

1. The Aram Chaos crater is most likely a 280 km in diameter crater formed in the 
Noachian and buried in the HT stratigraphy. After formation it was filled with 
water rich materials, as proposed by Glotch and Christensen (2005). Ongoing HT 
formation, including deposition, erosion and cratering buried the crater.

2. The Aram Chaos channel most likely formed after crater inward or crater outward 
flow over the Aram Chaos rim. Subsequently incision occurred during ongoing 
subsidence of Aram Chaos. The final flow was most likely crater outward.

3. The Aram Ares Channel Deposits (AACD) are interpreted to be at least 1 km 
thick deposits within the HT stratigraphy. This implies the AACD are Noachian 
aged and formed as deltaic deposits when the Aram Chaos crater was filled with 
crater rich material.
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4. The Lower Aram Chaos Formation (except the smooth LACF) is considered to be 
a  deposited  within  the 150 km in diameter  inner  ring of Aram Chaos.  It  was 
subsequently fractured and broken by either ongoing subsidence and collapse of 
the underlying HT or water release from the HT fractures. The unit could have 
been  deposited  in  a  sub-lacustrine  environment  indicating  ponding  occurred 
within the inner ring of Aram Chaos.

5. The mapping of this study approximately agrees with the OMEGA mapping of 
kieserite  and  other  hydrated  minerals:  most  smooth  LACF  outcrops  contain 
kieserite and most IACF outcrops contain other hydrated minerals. Hematite is 
proposed to be associated with the UACF, forming deflation related lag deposits 
in the smooth LACF and IACF. This would imply that water was involved in the 
formation of smooth LACF, IACF and UACF, the non-fractured part of the Aram 
Chaos Formation. The doming morphology of these deposits is not corresponding 
with  a  sub-lacustrine  deposition  environment,  as  proposed  by  Glotch  and 
Christensen (2005). They could perhaps be spring deposits, as proposed by Rossi 
et al. (2007). More research, including crater counting, needs to be undertaken to 
better  understand  the  dome  shaped  morphology,  the  thickness  variations,  the 
stratigraphical relations and the relative age of the non-fractured ACF units.

The following conclusions can be made about the mapping and analysis in general:
1. The mapping performed by Glotch and Christensen (2005) is found to be different 

then the mapping of this research. This is mainly due to their incorporation of 
TES data and the incorporation of HRSC anaglyphs in this study to allow 3D 
mapping. The mapping in this study is mostly based on morphology and structure 
visible in high resolution HRSC and THEMIS VIS images.

2. The Concentricity lineament analysis technique designed in this study is a first 
approach to quantify lineament localizations. It has to be expanded by building an 
algorithm which automatically finds concentric and/or radial centers within the 
lineament data.

Proposed future research:
1. A  more  detailed  investigation  of  the  non-fractured  Aram  Chaos  Formation 

deposits, using high resolution HRSC data and HRSC derived DTMs. The Orion 
software could be used to measure strike and dips of the layering. Do the layer 
orientations  of  the  different  mesas  connect?  Or  did  the  layers  rotate  due  to 
subsidence and collapse of underlying HT?

2. A more detailed investigation of the Aram Ares Channel Deposits (AACD), using 
high resolution HRSC data and HRSC derived DTMs, to investigate the influence 
of the Aram Chaos channel incision and subsidence and collapse related faulting 
in the formation of the AACD. Is the observed AACD morphology in the Aram 
Chaos channel wall layering? Is the AACD part of the HT stratigraphy?
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Tables

Epoch N(1) N(2) N(5) N(16)
Late Amazonian
Middle Amazonian
Early Amazonian

<160
160-600
600-1600

<40
40-150
150-400

<25
25-67

Late Hesperian
Early Hesperian

1600-3000
3000-4800

400-750
750-1200

67-125
125-200 <25

Late Noachian
Middle Noachian
Early Noachian

200-400
>400

25-100
100-200
>200

Table 2.1. Crater counts for Martian epochs, after Tanaka (1986). N(Diameter) is the 
crater density, the number of craters, of diameter D or larger, per area times 106 km2. 
N(1) is only possible since MOC and THEMIS.

Epoch Type location
Upper Amazonian
Middle Amazonian
Lower Amazonian

Flood plains material, southern Elysium Planitia
Lava flows, Amazonis Planitia
Smooth plains material, Acidalia Planitia

Upper Hesperian
Lower Hesperian

Complex plains material, Vasistas Borealis
Ridged plains material, Hesperia Planum

Upper Noachian
Middle Noachian
Lower Noachian

Intercrater plains material, east of Argyre Planitia
Cratered terrain material, west of Hellas Planitia
Basement material, Charitum and Nereidum Montes

Table 2.2. Epoch and type locations for Mars (Tanaka, 1986).
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Reference Location Trigger Event and fluid Prediction
Sharp (1973) All chaotic terrain - Dissolution of 

rock material
- Deterioration of 

ground ice
- Removal of 

magma
- Combination of 

last 2.

- Subsidence due to removal of 
material. 

- Deterioration of ground ice could 
cause escarpment recession and 
development and breakup of blocks.

- Soluble rocks and solvent
- What caused deterioration?
- Volcanism

Carr (1979) All chaotic terrain - Pore pressure 
reaching the 
lithostatic 
pressure, caused 
by (1) an 
artesian aquifer 
system under 
high hydrostatic 
head or (2) 
growth of the 
permafrost base 
due to colder 
temperatures.

- Impact

Catastrophic:
Instability of confined aquifer below 
permafrost layer leading to uplift and 
fracturing of overlying terrain and 
eventually breakout and outflow of water.

- Uplift and fracturing prior to chaotic 
terrain formation should be visible in 
surrounding terrain.

- Chaotic terrain in low lying regions.
- Groundwater system extending from 

chaotic terrain to higher ground 
causing high hydrostatic head.

Nummedal and Prior 
(1981)

Referring to Carr 
(1979)

Circum-Chryse - Seismic event 
causing 
liquefaction.

- Pore pressure 
reaching the 
lithostatic 
pressure in 
confined aquifer 
(Carr, 1979)

Catastrophic:
- Subsurface material fails
- Collapse due to removal of solid 

material and/or water.
- Slumping of material
- Fracturing of surrounding area due 

to collapse and slumping

- Impacts and volcanism (seismic)
- Gradient in topography (failure)
- High water content of sediment
- See Carr (1979)

Mouginis-Mark 
(1985) and Chapman 
and Tanaka (2002)

Elysium Planitia 
and Circum-Chryse

Rise of magmatic 
material

Catastrophic: Interaction between layer of 
subsurface volatiles and volcanism 
(phreatomagmatic activity).

- Subice volcanism morphology (which 
was not identified in Elysium, except 
pseudo craters).

(Figure 4 from) 
Cabrol et al. (1997)

Referring to Carr 
(1979)

Shalbatana Vallis 
and Ma’adim 
Vallis.

Rise of magmatic 
material through 
cylindrical lava 
chimney.

Catastrophic: Rising of magma breaks 
through cryosphere. Release of liquid 
water and water vapor from aquifer (Carr, 
1979).

- See Carr (1979)
- Subice volcanism morphology
- Round chaos depressions.
- Chaos formation, spatially controlled 

by weakpoints where radial and 
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concentric Tharsis associated faults 
cross.

- Dike intrusion
(Figure 2 from) 
Komatsu et al. 
(2000)

Chaotic terrain 
related to outflow 
channels

Magmatic heating Catastrophic:
1. Melting of ice and dissociation of 

CO2 and/or methane clathrate.
2. Liquefaction and fluidization.
3. Explosion due to high gas pressure.
4. Outflow of water-sediment mix

- Volcanism
- Similarity to seabed pockmarks in 

continental shelves formed by 
dissociation of clathrate.

Max and Clifford 
(2001)

Referring to Carr 
(1979)

Chaotic terrain 
related to outflow 
channels

- Global or 
regional 
warming

- Subsurface 
igneous activity

- Local 
deposition or 
erosion

- Impacts
- Tectonic 

activity

Catastrophic:
Dissociation of methane hydrate in 
subpermafrost aquifer (Carr, 1979) 
resulting in explosive eruption of water 
and methane gas.

- See Carr (1979)
- Formation of methane hydrate.
- Methane in atmosphere?
- Methane indication for past or present 

life?
- Similarity to expulsion and collapse 

features on Earth, formed by methane 
hydrate dissociation.

Rodríguez et al. 
(2005a,b)

Circum-Chryse High heat flow Catastrophic and non catastrophic: 
subsidence due to removal of water from 
caverns

- Caverns controlled by impact fracture 
system

- Volcanism
Montgomery and 
Gillespie (2005)

Outflows 
emanating from 
Valles Marineris.

Magmatic heating 
due to Tharsis Bulge.

Catastrophic: Dewatering of evaporite 
deposits.

- Volcanism
- Presence of large amounts of evaporite 

deposits (such as possibly the 
Internally Layered Deposits on the 
floors of Valles Marineris chasmata).

Wang et al. (2005) Chaotic terrain 
related to outflow 
channels

- Impact larger 
then 100 km in 
diameter. 
Favorably 
occurring during 
Late Noachian 
until Early 
Hesperian when 
cryosphere was 
thinner.

Catastrophic:
Liquefaction of aquifers on a global scale, 
resulting in catastrophic release of ground 
water

- Thinner cryosphere
- No necessary spatial correlation 

between craters and chaotic terrain
- Liquefaction morphology (evidence 

for lateral spreading and collapse)
- High fluid content of material

Coleman (2005) Catastrophic 
outflow from 

Catastrophic outflow 
from Aromatum 

The carving by the water flow lowered 
the overpressure triggering the formation 

- Chaotic terrain occurring within 
outflow channel.
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Aromatum Chaos Chaos carved into the 
cryosphere, forming 
Ravi Vallis

of secondary chaotic terrain downstream. - Magmatic heating not necessary to 
explain the secondary chaotic terrain.

Table 2.3. Chaotic terrain formation hypotheses and predictions.
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Region Interpretation
A. Central hummocky zone. Uplifted basement controlled by maximum 

projectile penetration.
B. Peripheral unstable zone. Geothermal  melting  of  ice  saturated 

deposits above ring intrusions.
C. Stable, fractured zone. Uplifted basement.
D. Moat of chaotic terrain. Geothermal melting above ring intrusions.
E. Stable zone. Ejecta-covered megaterrace.
F. Ring arrangement of chaotic terrains. Intrusions  localized  along  outer  ring 

fracture.
G. Smooth-floored canyons. Eroded ejecta facies.
H. Outer concentric arrangement of chaotic 
terrains, rilles.

Poorly expressed outer fracture.

Table 3.1. Explanation of zones A to H of Figure 3.11, after Schultz et al. (1982).

Orbit # Available on the PSA?
h0103_0009
h0401_0001
h0456_0000
h0890_0000
h0901_0000
h0912_0000
h0923_0000
h0934_0000
h0945_0000
h0967_0000
h1000_0000
h1011_0000
h1022_0000
h1055_0000
h1337_0009
h1925_0000
h1936_0000
h1947_0001
h2196_0001

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
No
No
No

Table 4.1. HRSC images used for mapping Aram Chaos.
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Table 5.1

Unit name Type* Description
Highland Terrain (HT) G Highland Terrain is the largest mapped unit of my research area. It has been degraded by large-scale impacts. 

Wrinkle ridges (Figure 5.5.10) and relatively shallow fractures occur on its surface. It is at least 1.5 to 2 km 
thick (the difference between the mean HT elevation and the Chaotic Terrain Floor elevation). Small-scale 
variation of surface morphology has been ignored (see Observation 13). 100-200 m scale layering of HT is 
visible in the Ares Vallis main channel wall (Figure 5.1.13).
Fractured Highland Terrain occurs near the Chaotic Terrain. The fractures are 10-100 km scale. They are also 
visible in the MOLA elevation data with fracture valley depths around 250 – 750m.
Mesas (flat topped hills) of Highland Terrain occur within the Chaotic Terrain. Some mesas can reach the 
elevation of the lower elevated Chaotic Terrain Floor and are therefore interpreted to be collapse/subsidence 
features.
Type location: Figure 5.1.10a and b

Chaotic Terrain (CT) S/M Chaotic Terrain (CT) is a degraded lateral unit of HT. The CT unit consists of two types, varying in the amount 
of degradation:

Intermediate Chaotic Terrain (ICT): A type of Chaotic Terrain, intermediate in degradation between Fractured 
Highland Terrain and Chaotic Terrain Floor. The ICT consists of either sharp or rounded km-scale hills (Figure 
5.1.14) and shows the gradual loss of coherence due to degradation by fracturing and chaotization. Highly 
chaotisized areas do not clearly show fractures.
Mapping difficulties: It can grade into Small-scale Fractured and Chaotic Terrain (SFCT).
Type location: Figure 5.1.10a and c

Chaotic Terrain Floor (CTF): CTF is relatively low in elevation. It consists of knobs and rounded hills. The 
low elevation of the CTF is interpreted to be due to subsidence and erosion.
Type location: Figure 5.1.10a and d

Lower  Aram Chaos  Formation 
(LACF)

S/M/G? The Lower Aram Chaos Formation is interpreted to be a distinct unit deposited on top of the HT within the 
inner ring of Aram Chaos. It consists of three lateral units:

Fractured: This  unit  exhibits  a  distinct  ‘glossy’  morphology visible  on  THEMIS VIS.  It  is  cross-cut  by, 
compared to the HT fractures, relatively small-scale fractures (1-2 km scale). Some fractures have raised rims 
and some show small thrusts at the base of the rim (see Observation 30, Figure 5.2.31). Some HT fractures can 
be followed within the LACF. The relatively small-scale fracture pattern is either caused by the properties of 
the LACF material with larger-scale HT fractures underneath or due to a smaller-scale fracturization of the HT 
underlying the LACF.
Type location: Figure 5.1.10a and e

Broken: This part of the LACF is highly fractured and broken up considerably, forming ~1 km scale 100-200m 
high irregular mesas. It always occurs at the boundary of the Fractured Highland Terrain (see Figure 5.1.5, the 
Aram Chaos Geological Map). The fractures could penetrate to the Fractured Highland Terrain underneath.
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Type location: Figure 5.1.10a and f

Smooth: Mapped as the non-fractured part of the LACF. It consists of meter scale layering and is observed to 
be a drape (Observation 27).
Type location: Figure 5.1.10a and g

Intermediate  Aram  Chaos 
Formation (IACF)

G/M The Intermediate  Aram Chaos  Formation has  a  rugged  morphology with  at  some parts  1  km scale  ‘flow 
features’ on its surface (see type location). The flow features could be wind generated (they are oriented in the 
direction of the mean wind direction) but could also be resurfaced fluid flow features. Windows of underlying 
Lower Aram Chaos Formation occur within the IACF. The IACF is at maximum ~250 m thick (see Figure 
5.3.1, Cross Sections I and II) and consists of meter scale layering. The ‘flow features’ can either be caused by 
wind erosion (they are parallel to the general wind direction (Figure 5.5.8)) or they could be caused by water 
erosion.
Type location: Figure 5.1.10a and h

Upper  Aram  Chaos  Formation 
(UACF)

G/M Mapped as the upper part of the ACF. It consists of a ~10-100 m light toned cap material, which is relatively 
strong, with dark less strong material underneath. The cap material exhibits a specific ‘icing’ texture (Figure 
5.1.15)  and  forms  very  sharp  arcuate  ‘razor  blade-like’  escarpments  (see  Figure  5.1.5,  the  Aram  Chaos 
Geological Map). In the W the cap overlies the LACF, in the S the cap overlies the Fractured HT. The darker, 
softer material of the UACF underneath the cap thickens towards the NW (see Figure 5.3.1, Cross Sections I 
and II). The unit is at maximum around ~300 m thick. Wind eroded lineations occur in the North (Figure 
5.1.16).
Type location: Figure 5.1.10a and i

Aram  Ares  Channel  Deposits 
(AACD)

G/M The Aram Ares Channel Deposits has a distinct morphology of lineations and small elongated hills. It is 
observed to cap elongated streamlined Highland Terrain mesas (see Observation 25 and Figure 5.2.25c). The 
Aram Chaos channel incised the AACD and 100 meter scale layering can be observed in the channel wall, 
which is 1 km high (see Observation 25 and Figure 5.2.25d).
Type location: Figure 5.1.10a and j

Small-scale  Fractured  and 
Chaotic Terrain (SFCT)

S/M SFCT is fractured terrain mostly occurring in (flooded) highland terrain. It doesn’t exhibit the same elevation 
variation between HT and CTF as the larger scale chaotic terrain. It occurs in patches consisting of 100-500 m 
high mesas and hills. The smaller mesa height implies the fractures are also less deep rooted as HT and CT 
fractures.
Type location: Figure 5.1.10a and k

Light  Toned Channel  Deposits 
(LTCD)

G/M Deposits within the Ares Vallis outflow channel system showing a high thermal inertia in THEMIS IR night 
images. At one location the unit has been eroded suggesting a thickness of 200 – 300 m.
Type location: Figure 5.1.10a and l

Small-scale Hills Terrain (SHT) M SHT is defined as a surface with ~1 km scale hills (see Figure 5.1.8 for the mapped occurrences). The hills 
occur on HT (mesas). The same scale hills also occur within the Intermediate Chaotic Terrain and Chaotic 
Terrain Floor units. It is interpreted to be formed by a secondary process, either prior to or post fracturing and 
chaotization. Difficulty: distinction between small hills in Chaotic Terrain and SHT.
Type location: Figure 5.1.10a and m

Aureum Chaos Deposits (ACD) G/M These  deposits  occur  in  Aureum  Chaos.  Most  outcrops  exhibit  the  same  sharp  arcuate  escarpments  (at 
maximum ~ 300 m thick) as the UACF, but of a smaller scale. The top surface exhibits patches of ‘icing’ 
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texture  material  (Figure  5.1.17c  and  5.1.18)  also observed in  the  Upper  ACF (Figure  5.1.15).  Laterally  a 
variation in brightness can be observed. The two brightest outcrops are also relatively thick (~600 m) and do 
not exhibit the ‘icing’ texture (Figure 5.1.17a and b). One of these deposits exhibits flow morphology (Figure 
5.1.17b).
Type location: Figure 5.1.10a and n

Iani Chaos Deposits (ICD) G/M These deposits occur in Iani Chaos. Five distinct morphological types of deposits can be distinguished:

Iani Chaos Deposit type 1: This deposit consists of multiple 10 meter scale layers and is oriented parallel to the 
Ares Vallis outflow. Flow morphology is visible oriented parallel to the Ares Vallis outflow (see type location). 
It is observed to be at maximum approximately 500 m thick.
Type location: Figure 5.1.10a and o. The smaller deposit in the upper left of the image is of type 2.

Iani Chaos Deposit type 2: This deposit has a smooth curving relief. The deposit has linear grooves and linear 
dark dune deposits on its surface which are approximately parallel to the mean wind direction (Figure 5.5.8). 
Flow morphology can be observed (Figure 5.1.19).  The occurrence of windows of underlying CTF mesas 
suggest the material was deposited after the formation of the CTF. It is interpreted to have been eroded by a 
flow after deposition. Subsequently wind erosion formed the linear grooves.
Type location: Figure 5.1.10a and p

Iani Chaos Deposit type 3: This deposit looks the same morphologically as the E boundary of the smooth 
LACF (Figure 5.1.20). It is relatively dark but patches of bright material occur on its surface. It consists of 10 
meter scale layering.
Type location: Figure 5.1.10a and q

Iani  Chaos Deposit  type 4: This  deposit  is  very bright  and consist  of  100 meter  scale  layering,  which is 
observed to be at an angle (see 9 in Figure 5.4.2). The layer morphology is distinct, with linear grooves oriented 
NE. It is superpositioned on top of the type 3 deposit. The linear grooves are not aligned with the general wind 
direction, however wind directions of this orientation have been mapped (Figure 5.5.8).
Type location: Figure 5.1.10a and r

Iani Chaos Deposit type 5: This deposit is exhibits the same ‘icing’ texture as the UACF (Figure 5.1.21 and 
5.1.15).
Type location: Figure 5.1.10a and s

Outflow  Channel  Terrain 
(OCT)

M Outflow  Channel  Terrain  is  a  geomorphological  unit  which  underwent  flooding  and  channelization.  The 
channels have escarpments on each side. The channel floor consists of linear ridges aligned in the paleoflow 
direction. The channel terrain consists of multiple terraces, suggesting multiple outflow events. The source of 
the channels is Chaotic Terrain (e.g. Hydaspis, Iani, Aureum and Aram Chaos). Multiple stages of outflow have 
been observed (Observation 1)
Type location: Figure 5.1.10a and t
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Flooded  Highland  Terrain 
(FHT)

M Flooded terrain is a morphological unit consisting of terrain similar to Highland Terrain (no distinct boundary) 
but with a lower elevation (decreasing towards the OCT), a flow morphology consisting of linear ridges, tear-
shaped islands and the occurrence of Small-scale Fractured and Chaotic Terrain.
Type location: Figure 5.1.10a and u

Rounded Chaotic and Highland 
Terrain (RCHT)

M This unit consists of rounded hills and mesas and has only been observed in Aram Chaos, near the Aram Chaos 
channel linking Aram Chaos with Ares Vallis. The rounded hills and mesas occur in Highland Terrain and 
Intermediate Chaotic Terrain. The streamlined HT mesas occurring in the Aram Chaos channel (Figure 5.2.25c) 
are also mapped as RCHT. The rounded morphology suggests fluid flow.
Type location: Figure 5.1.10a and v

* Means of definition: S = Structural geological, M = Geomorphological, G = Geological (stratigraphic).
Table 5.1. Unit definitions.

Table 5.2

# Boundary between: Description
1 HT – ICT – CTF The Highland Terrain grades into Chaotic Terrain through the ICT and the CTF (Figure 5.1.22) in a general decrease of elevation:

1. HT becomes more and more fractured.
2. Intense fracturing causes Highland Terrain mesas to form.
3. The mesas degrade and become rounded or sharp hills.
4. The hills become smaller and less high.
5. The CTF consists of small hills. It is lowest in elevation and in Hydaspis Chaos and Aureum Chaos it grades into outflow 

channels.
The ICT and CTF differ from the HT geologically because the chaotization resurfaced older material. However no clear layering 
has been observed so stratigraphically the base of the HT is unknown. Therefore the ICT and CTF are considered HT material 
which have undergone chaotization. This involved intense fracturing (e.g. brecciation) and erosion. The mapping of the ICT and 
CTF  has  not  been  on  geological  (stratigraphical)  but  on  structural  geological  and  morphological  grounds.  The  minimum 
stratigraphical thickness of the HT is the difference between the mean HT elevation and the mean CTF elevation (1.5 to 2 km).

2 HT – (broken LACF) 
– fractured LACF

Mesas of Highland Terrain occur within the LACF. One of the mesas has a ~350 m high fractured LACF mesa on top (see 
Observation 26 and Figure 5.2.27).
Although  the  fractured  LACF and  HT  are  distinct  units,  no  clear  stratigraphical  relationship  was  observed  at  their  lateral 
boundaries. The boundary between the HT and the  fractured LACF is gradual and either consists of 1) the broken LACF (see 
Figure 5.1.5, the Aram Chaos Geological Map) or 2) a gradual transition (Figure 5.1.23). The boundary could be a thinning (dying 
out)  of  the  LACF material  towards  the  HT.  Later  fracturing  and  chaotization  formed  the  current  broken  up  and  fractured 
morphology.
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3 Fractured  LACF  – 
Smooth LACF

The smooth LACF principally occurs in the E part of Aram Chaos.  The fractured LACF mainly occurs in the W, although 
fractured LACF windows occur within the smooth LACF (Figure 5.1.24 and 5.1.20). This lateral difference in fracturing can be 
explained by 1) localized subsidence of underlying HT, 2) localized upward movement (f.e. by water release), 3) the smooth 
LACF is a relatively thin layer on top of the fractured LACF or 4) a combination. No clear stratigraphical relations have been 
observed to exclude one or more of the explanations. If however the fractured LACF became fractured during a regional event (or 
localized to the Aram Chaos crater) the third option would be the most logical, whereas it  would be unlogical that only the 
fractured LACF fractured during a deformation event. The smooth LACF is still mapped as a lateral unit of the LACF because it is 
observed to be deposited on top of the HT/CT and underlying the IACF.

4 Smooth  LACF  – 
HT/CT/RCHT

The smooth LACF is interpreted to be draped over underlying HT or CT (see Observation 27 and Figure 5.2.28). The smooth 
LACF gradually thins towards the boundary with the HT and/or CT or it ends in a sharp escarpment (Figure 5.1.20).
The Smooth ACF is observed to overlie RCHT (Figure 5.1.20). This would indicate that the outflow which formed the rounded 
mesas occurred prior to the deposition of the ACF.

5 HT/CT/RCHT  - 
AACD

The AACD is observed to cap elongated streamlined HT mesas (see Observation 25 and Figure 5.2.25c). The streamlined HT 
mesas could have formed during the erosional event(s) which eroded the ACCD and formed the channel, making the AACD older 
then these events. The streamlined HT mesas could not have formed prior to the ACCD deposition. Because this would indicate 
the channel formed prior to the ACCD terraces it cuts into.

6 AACD  –  smooth 
LACF

At one location the AACD seems to grade into the LACF (Figure 5.2.25e). However the smooth LACF could also thin and die out 
gradually towards the AACD.

7 HT – FHT – OCT Highland Terrain and Outflow Channel Terrain are either bounded by a channel escarpment or via the Flooded Highland Terrain. 
The FHT gradually lowers in elevation towards the OCT. The FHT has not been mapped as a clearly bounded polygon, but the 
area between the clear channel outline and the unclear channel outline (the farthest extent of the channel) on the map is an 
indicator of FHT. The region N, NE and E of Ares Vallis exhibits flow morphology, small channels and Small-scale Fractured and 
Chaotic Terrain. Therefore it is interpreted to be FHT. The OCT has not been mapped as a clearly bounded polygon, but the 
channel outline on the map is an indicator of OCT.

8 CT – SFCT In Iani Chaos the Chaotic Terrain grades into the Small-scale Fractured and Chaotic Terrain.
9 ACD – CT The ACD are thick deposits on top of the CT in Aureum Chaos, forming distinct hills with escarpments.
10 ICD – CT Types 1, 2, 4 are distinct deposits which are clearly superpositioned on top of the CT. Types 3 and 5 do not show a clear boundary 

and probably thin out gradually.
Table 5.2. Boundary descriptions.
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Name Definition
Chaotization The process(es) which formed the chaotic terrain: the degradation 

of  HT  mesas  from  fractured  HT,  via  ICT  to  CTF.  The 
chaotization  is  a  younger  event  than the  deposition  of  the  HT 
material,  but  it  excavates  older  material.  The  chaotization  is 
interpreted to have involved intense fracturing (e.g. brecciation). 
Breccia is a rock so fractured it has lost coherence. The release of 
water through the fractures was most likely an explosive event 
causing destruction of the HT.

Fractures Linear  features  visible  in  image  and  elevation  data  (MOC, 
THEMIS,  HRSC,  MOLA).  Elevation  data  shows  they  form  a 
linear valley. The width and depth of this valley says something 
about the size of the fractures.

Faults These are fractures with interpreted movement, such as the ring 
faults of Aram Chaos. An example is a fracture dividing two HT 
mesas, with one mesa considerably higher in elevation then the 
other.  This  is  interpreted  as  subsidence,  making  the  fracture  a 
normal fault.

Table 5.3. Definitions.

Type B1 B2 B3
ACD af 1
ACD af 2
ACD lsf

1.1411
1.3855
1.1124

1.1555
1.4143
1.3855

1.1842
1.4430
1.5291

ICD af 1
ICD af 2
ICD lsf

1.2849
1.3999
1.2130

1.3424
1.4143
1.5721

1.3999
1.4430
1.7007

Lower ACF af 1
Lower ACF af 2
Lower ACF lsf

1.3136
1.3999
1.2561

1.3424
1.4286
1.6293

1.3999
1.4861
1.8991

Intermediate ACF af 1
Intermediate ACF af 2
Intermediate ACF lsf

1.3136
1.3999
1.2273

1.3424
1.4286
1.6293

1.3999
1.4861
1.9132

Upper ACF af 1
Upper ACF af 2
Upper ACF lsf

1.2849
1.3999
1.1986

1.3424
1.4286
1.3999

1.3999
1.4430
1.7007

Table 5.4. The band wavelengths used for the band ratios (see Figures 5.1.25 to 5.1.29). 
The absorption feature (af) band ratios were calculated using (B1 + B3)/2*B2, the large 
spectral feature (lsf) band ratio was calculated using 2*B2/(B1 + B3).
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Figures 

 

 
Figure 2.1. Chaotic terrains on Mars (approved by the International Astronomical 
Union). a. Global equirectangular projected 128 pixel/degree MOLA elevation map 
spanning latitude 88N to 88S and Longitude 180W to 180E. Red is high elevation 
(maximum: 21249 m) and blue is low elevation (minimum: -8408 m). b. Chaotic terrains 
in the Xanthe Terra region of Mars, including Aram Chaos. 
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Figure 2.2. The five landing sites of NASA landers. 
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Figure 2.3. MOLA shaded relief image of Aram Chaos and Ares Vallis. 
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Figure 2.4. Lunar mare crater counts of specific diameters (the black dots) by Hartmann 
(upper diagram) and Neukum (lower diagram). Hartmann used a powerlaw fit and 
Neukum a polynomial fit as a production function for cratering. The upper solid line on 
both diagrams is the saturation equilibrium curve, an empirical upper limit for crater 
density. 
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Figure 2.5. A typical isochron diagram redrawn after Hartmann and Neukum (2001). 
Each set consists of an isochron derived after the Hartmann and Neukum production 
function. The upper solid line is the saturation equilibrium curve, an empirical upper limit 
for crater density. 
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Figure 2.6. A Mars cratering chronology model redrawn after Hartmann and Neukum 
(2001). The solid curves show the cratering rate in time for Mars. 
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Figure 2.7. Large scale topography of Mars. Global equirectangular projected 128 pixel/degree MOLA elevation map spanning 
latitude 88N to 88S and Longitude 180W to 180E. Black is high elevation (maximum: 21249 m) and white is low elevation 
(minimum: -8408 m). 
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Figure 2.8. Crustal thickness of Mars by Neumann et al. (2004). The lower map has a 
Mercator (75º to 75º) projection, the upper maps have polar stereographic projection 
(60º–90ºN for the left map and 60º–90ºS for the right map). The background is a MOLA 
shaded relief map. 
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Figure 2.9. Map of the magnetic field of Mars derived from two Mars years of observation by MAG/ER on board the MGS. The 
background is a MOLA shaded relief map. After Connerney et al. (2005). 

108



 
Figure 2.10. Explanation of the Martian orbit parameters, obliquity, eccentricity and precession. 
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Figure 2.11. Tectonic features of the western hemisphere of Mars. The left image shows extensional features (grabens and fault 
scarps), the right image shows compressional features (wrinkle ridges). Redrawn after Banerdt et al. (1992). 
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Figure 2.12. Map of valley networks, mapped using Viking and MGS data, on top of MOLA map. Redrawn from a map by Michael 
Carr. 
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Figure 2.13. A possible fluvial distributary fan. Redrawn after Malin and Edgett (2003).
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Figure 2.14. Part of outflow channel southwest of the Elysium Mons volcano. Part of THEMIS VIS image 20030620a.
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Figure 2.15. Map of outflow channels, mapped using Viking data, on top of MOLA map. Redrawn from a map from Carr (1996). 
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Figure 2.16. Outflow channel source regions. a. Circum-Chryse outflow channels with 
chasmata and chaotic terrain source regions. b. Chaotic terrain. c. Unnamed channel 
south of Ascraeus Mons with extensional tectonic feature as source region (Part of 
THEMIS image V08155020 centered on 6.0°N, 254.5°E). Image after Hanna and Phillips 
(2005). 
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Figure 2.17. Polar stereographic MOLA shaded relief map of the northern hemisphere of 
Mars, after Tanaka et al. (2003). Blue is low elevation, gray is high elevation. 
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Figure 2.18. Global scale geological map of Mars, using mollweide projection (with east longitude and centered on 260ºE) and 
MOLA shaded relief as background. N=Noachian, H=Hesperian, A=Amazonian, E=Early, L=Late. Map from Nimmo and Tanaka 
(2005). 
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Figure 2.19.  Diagram summarizing the evolution of Mars. 
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Figure 3.1. MOLA image of Xanthe and Margeritifer Terrae (image center is 4.3°N and -
33.1°E). 
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Figure 3.2. Part of polar stereographic northern lowlands geological map showing the 
Margaritifer Terra Region including Aram Chaos. Redrawn after Tanaka et al. (2005). 
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Figure 3.3. Map of Chryse Planitia and Valles Marineris, after Schultz et al. (1982), 
showing concentric rings of the Chryse and other impacts. 
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Figure 3.4. Negative Gravity anomalies of Valles Marineris and Chryse Planitia, after 
Smith et al. (1999). 
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Figure 3.5. Possible delta structure in the Aram Chaos channel. (1) 60 km long and 120 
km wide delta platform, (2) prodelta slope, (3) distributary channels, (4) deposit of fine 
material. Viking image 689A03. Redrawn after Cabrol and Grin (2002). 
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Figure 3.6. A terrain map of Aram Chaos and surrounding area, after Schultz et al. 
(1982). 
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Figure 3.7. Geological map of Aram Chaos, redrawn after Glotch and Christensen 
(2005). 
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Figure 3.8. Profiles of Aram Chaos chaotic and layered terrain (redrawn after Glotch and Christensen, 2005). The 
dashed parts in (a) refer to b,c and d. The A-B, C-D, E-F and G-H profile lines are shown on Figure 3.7. 
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Figure 3.9. Hemisphere view of MOLA elevation data (centered northeast of Argyre 
Planitia), redrawn after Parker et al. (2000).   
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Figure 3.10. MOLA elevation map of Margaritifer Basin, redrawn after Grant and Parker 
(2002). 
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Figure 3.11. Cross section model of typical multi-ring impact basin (>300 km in 
diameter) on Mars, after Schultz et al. (1982). The zones A to H are explained in Table 
3.1.  
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Figure 3.12. Possible stages of Aram Chaos development proposed by Glotch and 
Christensen (2005). 
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Figure 4.1. The planetocentric latitude (a) vs. the planetographic latitude (b). 
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Figure 4.2. Different variations of the Longitude System (lonsys) and the Central 
Longitude (clon) combination. The Longitude System can either be between 0° and 360° 
(lonsys = 360) or between –180° and 180° (lonsys = 180). The Central Longitude can be 
0° or 180°. Only lonsys = 360 and clon = 180 or lonsys = 180 and clon = 0 work with 
ArcGIS. 
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Figure 4.3. Polar Stereographic Projection. 
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Figure 4.4. OMEGA orbiting Mars, sensoring reflected solar radiation and thermal 
emitted radiation. Redrawn after Van der Meer and De Jong (2004). 
 

 
Figure 4.5. The solar irradiance curve for Earth (Source: http://ceos.cnes.fr:8100/cdrom-
00b/ceos1/ science/dg/dg1.htm). 
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Figure 4.6. ROIs of bright albedo regions within the three OMEGA orbits. 
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Figure 4.7. ROIs of the different deposits on top of the OMEGA orbits. 
 

 
Figure 4.8 Calculating ratios ((b1+b3)/2*b2) between the shoulders (b1 and b3) and 
lowest point (b2) of absorption features in spectra. 

  
136



 
Figure 4.9. Explanation of Concentricity / Radiality. 
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Figure 4.10. The Select By Location window. 
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Figure 5.1.1. The difference between geology and geomorphology. The geological layer 
is considered geology. It however forms part of the topography, which is geomorphology. 
The eroded channel is considered geomorphology, but not geology (it defines a lack of 
geology, the layers have been eroded). The dune and the channel deposit are both 
geology and geomorphology. 
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Figure 5.1.2. 50% transparent THEMIS IR day on top of color-coded MOLA elevation 
data in ArcGIS. This provides a sense of 3D, combining morphology and elevation. 
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Figure 5.1.3. Possible volcanic deposits visible in THEMIS IR night (Thermal Inertia) 
data. The TI of the area (pink) around the ~3 km in diameter and 200 m high possible 
volcanic construct (green) is high compared to the TI of the area farther away (blue). No 
high resolution data (MOC, THEMIS VIS, HRSC) is currently available covering the 
possible volcanic construct. Crater counts have not been performed so no age estimate is 
known. 
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Figure 5.1.8. Mapped occurrences of Small-scale Hills Terrain. 
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Figure 5.1.9. The mapped lineaments. 
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Figure 5.1.10. Mapped unit type locations. For explanation of the images see Table 5.1. 
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Figure 5.1.10 (continued). b. Highland Terrain (THEMIS IR day). c. Intermediate 
Chaotic Terrain (HRSC nadir). d. Chaotic Terrain Floor (HRSC nadir). e. Fractured 
Lower Aram Chaos Formation (THEMIS VIS). f. Broken Lower Aram Chaos Formation 
(THEMIS VIS). g. Smooth Lower Aram Chaos Formation (HRSC nadir). 
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Figure 5.1.10 (continued). h. Intermediate Aram Chaos Formation (HRSC nadir). i. 
Upper Aram Chaos Formation (HRSC nadir). j. Aram Ares Channel Deposits (HRSC 
nadir). k. Small-scale Fractured and Chaotic Terrain (HRSC nadir). l. Light Toned 
Channel Deposits (HRSC nadir). m. Small-scale Hills Terrain (HRSC nadir). 
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Figure 5.1.10 (continued). n. Aureum Chaos Deposits (THEMIS IR day). o. (HRSC 
nadir). p. (HRSC nadir). q. (HRSC nadir). r. (HRSC nadir). s. (HRSC nadir). 
 

 
Figure 5.1.10 (continued). t. Outflow Channel Terrain (HRSC nadir). u. Flooded 
Highland Terrain (HRSC nadir). v. Rounded Chaotic and Highland Terrain (HRSC 
nadir). 
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Figure 5.1.11. Possible volcanic deposits (Figure 5.1.3). The base map is a MOLA 
shaded relief map. 
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Figure 5.1.12. Mapped remnants of possible impact craters on top of MOLA elevation 
data (black is high, white is low). 
 

156



 
Figure 5.1.13. Approximately 100-200m scale layering of Highland Terrain, forming 
terraces, is visible in the ~1 km high main Ares Vallis channel wall. The circular shape of 
the terraced escarpment suggests the HT consists of buried impact craters. 
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Figure 5.1.14. THEMIS IR night image showing numerous km scale hills within the 
southern Chaotic Terrain of Aram Chaos.
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Figure 5.1.15. The surface morphology of the Upper Aram Chaos Formation (Part of 
MOC image M1201687, 2.93 m/pixel resolution). 
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Figure 5.1.16. Wind eroded lineations in the Upper Aram Chaos Formation material 
(THEMIS VIS, image center 338.77°E, 3.99°N). 
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Figure 5.1.17. The Aureum Chaos Deposits. For explanation see text. Main image center 
332.85°E, 3.69°S. a. Part of MOC image E0300828. b. Part of MOC image M1901566. 
c. Part of MOC image R1702066. 
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Figure 5.1.18. Part of the surface of the Aureum Chaos Deposits (Part of MOC image 
E0503434, 3.50 m/pixel resolution). 
 

162



 
Figure 5.1.19. Flow morphology observable in the Iani Chaos Deposit type 2 (HRSC 
nadir). 
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Figure 5.1.20. The boundary of the smooth Lower Aram Chaos Formation (dotted 
purple) with CT (grey) and Rounded Chaotic and Highland Terrain (RCHT) (yellow). 
The LACF is observed to have been locally fractured (arrow, mapped as fractured 
LACF). The fracturing pattern is observed to continue within the CT. This suggests the 
LACF formed after the formation of the Chaotic Terrain and its more rounded RCHT 
lateral unit. The fractured LACF could subsequently have formed after localized activity 
occurred (e.g. subsidence or water release) (HRSC nadir, image center 240.23°E, 
2.88°N). 
 

 
Figure 5.1.21. Morphology of the Iani Chaos Deposits type 5 (Part of MOC image 
E2000722, 4.47 m/pixel resolution). 
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Figure 5.1.22. Grading of high elevated Highland Terrain (dark yellow) via Intermediate 
Chaotic Terrain (grey) to low elevated Chaotic Terrain Floor (yellow) (Hydaspis Chaos) 
(HRSC nadir, image center 332.65°E, 2.31°N). 
 

 
Figure 5.1.23. Boundary between fractured Highland Terrain (yellow) and fractured 
Lower Aram Chaos Formation (purple) (THEMIS VIS, image center 337.64°E, 3.41°N). 
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Figure 5.1.24. Smooth (dotted purple) versus fractured (purple) Lower Aram Chaos 
Formation. The smooth LACF could either be locally fractured (b) or it is a distinct 
deposit on top of the fractured LACF (c). Green is the Intermediate Aram Chaos 
Formation (HRSC nadir, image center 339.75°E, 2.84°N). 
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Figure 5.1.25. Mean spectra of the Aureum Chaos Deposits. 
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Figure 5.1.26. Mean spectra of the Iani Chaos Deposits. 
 

169



 

R
ad

ia
nc

e 
(W

·m
-2

·sr
-1

) 

Wavelength (μm)

Figure 5.1.27. Mean spectra of the smooth Lower Aram Chaos Formation. 
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Figure 5.1.28. Mean spectra of the Intermediate Aram Chaos Formation. 
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Figure 5.1.29. Mean spectra of the Upper Aram Chaos Formation. 
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Figure 5.1.30. The band ratio maps for the Aureum Chaos Deposits belonging to the two 
absorption features and the large spectral feature. The Region of Interest is projected on 
one of the normal bands. 
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Figure 5.1.31. The band ratio maps for the Iani Chaos Deposits belonging to the two 
absorption features and the large spectral feature. The Region of Interest is projected on 
one of the normal bands. 
 

 
Figure 5.1.32. The band ratio maps for the smooth Lower Aram Chaos Formation 
belonging to the two absorption features and the large spectral feature. The Region of 
Interest is projected on one of the normal bands. 
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Figure 5.1.33. The band ratio maps for the Intermediate Aram Chaos Formation 
belonging to the two absorption features and the large spectral feature. The Region of 
Interest is projected on one of the normal bands. 
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Figure 5.1.34. The band ratio maps for the Upper Aram Chaos Formation belonging to 
the two absorption features and the large spectral feature. The Region of Interest is 
projected on one of the normal bands. 
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Figure 5.2.1. Overview of the different geological observations. The numbers refer to the 
observations numbers. a. Regional. b. Aram Chaos. 
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Figure 5.2.1 (continued). 
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Figure 5.2.2. The Ares Vallis outflow channel system consists of multiple cross-cutting 
channels (1 in Figure 5.2.1a for overview). The youngest outflow event incised the main 
Ares Vallis outflow channel (1). It is observed to cross cut an older channel (2 and profile 

180



C). Channels 1 and 2 incised into an higher elevated outflow terrace (3 and profiles A and 
B) (THEMIS IR day and color coded MOLA elevation). 
 

 
Figure 5.2.3. Outflow channels in HT (flow lineations in blue) have been cross cut by 
chaotization in CT (2 in Figure 5.2.1a) (HRSC nadir, image center 339.86°N, 0.74°S). 
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Figure 5.2.4. Surface morphology similar to the AACD (compare with Figure 5.1.10j) 
located on a terrace of Ares Vallis, North of Aram Chaos (3 in Figure 5.2.1a for 
overview). 
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Figure 5.2.5. Different types of craters (THEMIS IR day). The profile axes are in meters. 
a. unfractured crater, 32 km in diameter, within the unflooded HT (4a in Figure 5.2.1a). 
b. unfractured crater, 40 km in diameter, within the flooded HT (4b in Figure 5.2.1a). c. 

183



fractured crater, 75 km in diameter within the HT (4c in Figure 5.2.1a). d. Fractured 
crater remnant, 60 km in diameter, within the Chaotic Terrain (4d in Figure 5.2.1a). The 
red lines are interpretations of the collapsed blocks. The blue arrows point to the block 
surface top. 
 

 
Figure 5.2.6. Proposed scenario of fractured craters and crater remnants formation. a. 
Crater formation. b. Deposition of material within the crater with a high water content. c. 
Deposition of a cap deposit within the crater. d-e. Fracturing, collapse of the cap material 
and the (explosive) release of water. The grey material located between the collapsed 
blocks consists of relatively small hills and could be brecciated cap material (see also 
Observation 10). I interpret the collapse to be caused by subsurface topography of 
material underneath (possibly the water rich material). For complex craters or larger the 
subsurface topography could perhaps also be explained by a central uplift or a peak ring. 
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Figure 5.2.7. An impact remnant within Aureum Chaos (5 in Figure 5.2.1a). The sharp-
edged deposits are Aureum Chaos Deposits (HRSC anaglyph, east is upward). 
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Figure 5.2.8. Crater diameter vs. crater depth, measured for 18 fractured (including Aram 
Chaos) and 27 non-fractured craters in my research area. The crater depth was 
determined by estimating, using MOLA profiles, the difference between the mean 
elevation of the surface surrounding the crater and the mean crater floor elevation. The 
red and blue lines show the diameter-depth relation for complex craters (d = 0.19 x D0.55) 
and ‘proto-basins’, craters larger then 90 km in diameter (d = 0.98 x D0.18), respectively. 
The relations were derived by Garvin et al. (1999, 2000) using MOLA profiles of over 
1300 craters. Complex craters are defined as craters which exhibit a central uplift. They 
occur in the diameter range between 6-7 km (the transition from simple to complex 
craters) and 90 km (the complex-to-proto-basin transition). Proto-basin craters can have a 
ring uplift (peak ring) and/or have multiple rings (such as Aram Chaos). 
 

 
Figure 5.2.9. The occurrence of crater pits along a fault trace (7 in Figure 5.2.1a) (HRSC 
nadir, image center 334.33°E, 1.32°S). 
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Figure 5.2.10. Possible compression ridges at the edges of Northern Iani Chaos (8 in 
Figure 5.2.1a) (HRSC nadir, image center 340.59°E, 0.51°S). 
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Figure 5.2.11. Fractured HT in Iani Chaos with some mesas having a small-scale fracture 
pattern on its surface (compare mesa A with mesa B) (9 in Figure 5.2.1a) (THEMIS IR 
day combined with color-coded MOLA elevation (green is high, purple is low 
elevation)). 
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Figure 5.2.12. Example of Highland Terrain (yellow) fractures (red) continuing in the 
Chaotic Terrain (grey) in Aram Chaos (10 in Figure 5.2.1a) (HRSC nadir). 
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Figure 5.2.13. HRSC anaglyph (East is up, for location see Figure 5.2.1b). a. Fractures 
within the Aram Chaos Chaotic Terrain (Observation 10, see also Figure 5.2.12). b. 
Tearing of the HT (Observation 16) c. The fractured Highland Terrain continues into 
Aram Chaos (Observation 17) d. A ~30 km in diameter circular elevated area consisting 
of HT blocks (Observation 18, see also Figure 5.2.20). 
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Figure 5.2.14. Possible fracture offsets. a. At the southern border of Iani Chaos (11a in 
Figure 5.2.1a) (HRSC nadir). b. Within Aureum Chaos (11b in Figure 5.2.1a) (THEMIS 
IR day). 
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Figure 5.2.15. A possible contractional duplex system (12 in Figure 5.2.1a). a. THEMIS 
IR day image with fractures and interpreted sinistral movement. b. Color-coded MOLA 
elevation (orange is high, pink is low elevation) with fractures. c. Zoom of possible 
contractional duplex system fractures (HRSC nadir). 
 

 
Figure 5.2.16. Variability of Highland Terrain surface morphology. a. Flooded Highland 
Terrain (13a in Figure 5.2.1a). Two different morphologies can be distinguished (1 and 2) 
(HRSC nadir). b. Highland Terrain South of Aram Chaos (13b in Figure 5.2.1a) A 
smooth morphology occurs outside and within a fractured crater (3 and 4). A more 
rugged and cratered surface morphology occurs to the North (5). c. Rugged morphology 
is observed outside (6) and within (7) the Aram Chaos crater (13c in Figure 5.2.1a). 
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Figure 5.2.16 (continued). 
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Figure 5.2.16 (continued). 
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Figure 5.2.17. The rings of the Aram Chaos multiring crater. 
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Figure 5.2.18. Estimation of a pre-subsidence Aram Chaos HT elevation. a. The profile 
outlines on top of THEMIS IR day. b-i. The different MOLA profiles and an estimate of 
the pre-subsidence Aram Chaos HT elevation (red line) for each profile. This line was 
drawn at the location of the main crater rim, where a sudden change in elevation occurs. 
Most lines lie between –1500 and –2000. 

198



 
Figure 5.2.18 (continued). 
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Figure 5.2.19. Cartoon of possible events leading to current Aram Chaos HT geometry 
(the cartoon doesn’t depict a true cross section through Aram Chaos). a. Aram Chaos 
crater formation. b. Deposition of material within the crater with a high water content. c. 
Deposition of the HT material. d-e. Withdrawal of the water rich material, via crater 
fractures or to the surface in an explosive manner. This resulted in fracturing and 
brecciation (grey areas, see Observation 10) of the HT which subsequently collapsed. 
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Figure 5.2.20. Image showing Aram Chaos HT collapse to be varying (THEMIS IR day 
and color-coded MOLA elevation (green is high, grey is low elevation). For the location 
see 18 in Figure 5.2.1b. a. MOLA derived profile (black) and interpreted HT fault 
bounded blocks (red) The HT blocks are interpreted to be draped over subsurface 
topography. The profile is ~10 times exaggerated. 
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Figure 5.2.21. Fractures radial (red lines) to 4 localities (red circles) within Aram Chaos. 
The upper locality consists of an impact crater. 
 

202



 
Figure 5.2.22. Small arcs can be observed in the Western Aram Chaos rim. 
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Figure 5.2.23. A mesa is observed at the edge of the southern Chaotic Terrain (CT) of 
Aram Chaos (A) (for overview see 21 in Figure 5.2.1b). This mesa is observed to be 
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fractured. MOLA data (a) shows a similar sized area within the CT (B). This is 
interpreted to be a fractured mesa which underwent erosion. a. Color-coded MOLA data 
(white is low, orange is high elevation). b. Mosaic of THEMIS VIS and THEMIS IR day 
images. 
 

 

a b 

LACF 
HT 

Figure 5.2.24. A half crater occurs within Aram Chaos at the boundary between the 
fractured HT and the Lower Aram Chaos Formation (LACF) (for overview see 22 in 
Figure 5.2.1b). a. THEMIS IR day image. b. THEMIS IR day image and mapping. 
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Figure 5.2.25. The East part of Aram Chaos. a. Concentric rim fractures (red lines) did 
not develop in the East of Aram Chaos (HRSC anaglyph, East is up, for location see 19 in 
Figure 5.2.1b). b. Small-scale chaotization forming mesas ~500 m high (see Profile A). c. 
Multiple AACD (green) terraces have been formed by the Aram Chaos channel outflow. 
The AACD is observed to form a delta-shaped feature (HRSC anaglyph, West is up). d. 
Layering of AACD in the Aram Chaos channel wall (HRSC nadir). e. The AACD is 
observed to grade into smooth LACF. The observation could however also be explained 
by the gradual thinning of the smooth LACF. This would make the smooth LACF 
younger then the AACD. 
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Figure 5.2.25 (continued). 
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Figure 5.2.26. Cartoon showing possible events in the formation of the Aram Chaos 
channel and the AACD. a. Overflow of Aram Chaos, forming the Aram Chaos channel 
(see also Observation 3), b-c. Deposition of the AACD and continued incision of the 
Aram Chaos channel (also cutting through AACD) due to Aram Chaos subsidence d. 
Incision of the Aram Chaos channel by crater outward flow forming the streamlined HT 
mesas and eroding AACD. 
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Figure 5.2.27. A fractured Lower Aram Chaos Formation mesa (arrow) stratigraphically 
on top of a Highland Terrain window. a. THEMIS VIS image (22 in Figure 5.2.1b).  b. 
Birds eye view of THEMIS VIS draped over MOLA elevation (5x vertical exaggeration) 
showing the LACF mesa. c. Birds eye view with mapping overlay (purple = fractured 
LACF, purple with dots = broken LACF, yellow = HT, pink = UACF). 
 

 
Figure 5.2.27 (continued). 
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Figure 5.2.28. Draping of the smooth LACF (dotted purple) (HRSC anaglyph, East is up, 
for location see 23 in Figure 5.2.1b). 
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Figure 5.2.29. A Highland Terrain (yellow) window inside broken and fractured Lower 
Aram Chaos Formation terrain (purple). The HT window is interpreted to be a fracture 
bounded mesa which has been rotated due to collapse (HRSC anaglyph, East is up, for 
location see 24 in Figure 5.2.1b). a. THEMIS VIS mosaic (North is up) and profile lines 
A and B. Profile line A shows an elevated rim of broken LACF material along the 
southern edge of the HT mesa. Profile line B shows a valley along the western edge of 
the HT mesa where LACF material has collapsed (arrow). 
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Figure 5.2.30. Derived thickness of the Intermediate and Upper Aram Chaos Formation 
(see 4.7.1. Deriving the thickness of the Intermediate and Upper Aram Chaos Formation 
for method used). The thickness is calculated by subtracting the Nearest Neighbor 
interpolation from the MOLA elevation. A negative thickness value means that the 
Nearest Neighbor interpolation resulted in a higher elevation then the actual MOLA 
elevation and is subsequently not representative. 
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Figure 5.2.31. Thrusting normal to fractures in fractured Lower Aram Chaos Formation 
(image: THEMIS VIS). 
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Figure 5.4.1.  Aram Chaos Stratigraphy.
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Figure 5.5.1. Aram Chaos Rose Diagrams. For explanation see text. 
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Figure 5.5.2. Length-weighted Concentricity of Aram Chaos and its major units. The 
vertical values are a multiplication of the amount of lineaments and the length fraction of 
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these lineaments (summed length per total length) (see 4.6.3. Concentricity / Radiality). 
The columns represent bins of 5 degrees. a. Aram Chaos Highland and Chaotic Terrain 
lineaments (red lineaments of Figure 5.5.1). b. Aram Chaos inner ring lineaments (blue 
lineaments of Figure 5.5.1). c. Length-weighted Concentricity of lineaments within 120 
km around the highest chaotisized area of Aram Chaos. 
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Figure 5.5.3. Rose Diagrams and length-weighted concentricity of Crater 1 (a) and 
Crater 2 (b) (see Figure PQ). 
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Figure 5.5.3 (continued). 
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Figure 5.5.4. Overview of the largest fractured craters in my research area. 
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Figure 5.5.5. a. The lineament density map (See 5.6.5. Fracture Density). The lineament 
density is defined as the lineament length per square kilometer (km-1). b. The lineament 
density map on top of a MOLA shaded relief map. 
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Figure 5.5.6. a. For each high fracture density area length-weighted Rose Diagrams were 
created (black). The blue RD’s are from outcrops of Small-scale Fractured and Chaotic 
Terrain (SFCT) fractures. The purple RD’s are from Crater 1 (left) and Crater 2 (right) 
(see Figures 5.5.3 and 5.5.4). The orange RD’s are the Aram Chaos RD’s (see Figure 
5.5.1). b. All the lineaments in the non-flooded Highland Terrain and the low-fracture 
density Chaotic Terrain and the resulting RD. 
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Figure 5.5.7. Length-weighted concentricity. The extent of the concentricity was 
arbitrarily chosen. Area B (Aureum Chaos) is not completely circular because it borders 
my researched area. 
 

 
Figure 5.5.8. The wind directions derived from mapping wind streaks (see Figure 5.5.9) 
and a length-weighted Rose Diagram. 
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Figure 5.5.9. Color image from the HiRISE camera on board the Mars Reconnaissance 
Orbiter (MRO). The image shows ‘Victoria crater’, the final destination of the 
Opportunity MER Rover. The crater is ~800 m in diameter and the image is centered at -
2.1 degrees latitude, 354.5 degrees East longitude. The wind streaks are relatively loose 
material below the harder surface material which in time get blown out of the crater 
forming wind streaks (image redrawn after http://hiroc.lpl.arizona.edu/ 
images/TRA/TRA_000873_1780). 
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Figure 5.5.10. Mapped wrinkle ridges and Rose Diagram. 
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Figure  6.2. The  mean  wrinkle  ridge  orientation  in  my  research  area  (white  box)  is 
concentric to Tharsis.
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Figure 6.3. Schematized representation of the HT composition and structure. The HT 
thickness is at least 1-2 km thick.
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Figure 6.4. Comparison (c) between the mapping of this study (a) and the mapping by 
Glotch and Christensen (2005) (b). The red inlay is Figure 6.6.
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Figure 6.4 (continued). d. Left is the legend for the mapping of this study, right is the 
legend for the mapping by Glotch and Christensen (2005).

d
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Figure 6.5.  Comparison between the High TI Chaos (3) and the Subdued Terrain (2), 
mapped by Glotch and Christensen (2005) (1 is Knobby Terrain). For overview see red 
inlay in Figure 6.4. The difference in thermal inertia (b) between the High TI Chaos and 
Subdued Terrain is interpreted to be caused by the higher fracturing and chaotization in 
the High TI Chaos. In the mapping of this study both units are mapped as the fractured 
Lower Aram Chaos Formation. a. THEMIS IR day. b. THEMIS IR night.
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Figure 6.6. Streamlined HT mesas are observed to be capped by the AACD and embayed 
by smooth LACF. The streamlined HT mesas are interpreted to be formed by water flow. 
This makes the deposition of the AACD older then the water flow. The water flow most 
likely would have eroded the smooth LACF which suggests the smooth LACF is younger 
then the outflow and subsequently younger then the AACD.  a. HRSC nadir image.  b. 
Mapping  with  HRSC nadir  image  as  background.  c. Overview (THEMIS IR day as 
background).
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Figure 6.7. Two proposed scenarios to explain the observation of AACD in the wall of 
the Aram Chaos channel. For explanation see 6.2.2.4. Water activity in Aram Chaos.
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Figure 6.8. Mapping of Aram Chaos done by Rotto and Tanaka (1995) using Viking 
images (Background image: THEMIS IR day). The purple areas are chaotic terrain, the 
pink areas are outflow channels and the green areas are cratered terrain.
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Figure  6.9. Map  of  hematite  abundances  within  Aram  Chaos,  after  Glotch  and 
Christensen  (2005).  The  inlay  shows  the  Primary  Hematite  Unit  extent,  mapped  by 
Glotch and Christensen (2005). See also Figure 6.10.
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Figure  6.10. The  extent  of  the  Primary  Hematite  Unit,  mapped  by  Glotch  and 
Christensen,  on top  of  high resolution  HRSC data.  The right  patch is  located  in  the 
smooth LACF, the other patches occur in the rougher IACF.
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Figure 6.11. Comparison between (a) OMEGA detection of the suphate kieserite (red) 
and other hydrated minerals (pink) by Gendrin et al. (2005) and the (b) mapping of this 
study. a. Map redrawn from Gendrin et al. (2005) with yellow outlines of the mapping of 
this study. b. Mapping of this study. See Figure E for the legend.
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Figure 6.12. Pressure-Temperature (PT) diagram of water ice, liquid and vapour (image 
origin: http://www.aerospaceweb.org/question/astronomy/mars/water-phase.jpg) 
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Appendix A – Scripts 
 
A.1. thmimgprev.pl 
Create image preview download list from image number list. 
Unix/DOS usage: perl thmimgprev.pl fromlist tolist 
 

#!/usr/bin/perl –s 
 
$from = $ARGV[0]; 
$to = $ARGV[1]; 
open(HTMLFILE,'<'.$from); 
open(THEMISDOWN,'>'.$to); 
while($thmnr = <HTMLFILE>) 

{ 
 chomp($thmnr); 
 $url1 = "http://themis-data.asu.edu/img/browse/"; 
 $url = "$url1$thmnr\n"; 
 print THEMISDOWN $url; 
 print $url; 
 } 
close HTMLFILE; 
close THEMISDOWN; 

 
A.2. download.pl 
Downloads files using a download list using wget. 
Unix/DOS usage: perl download.pl list 
 

#!/usr/bin/perl –s 
 
$ifile = $ARGV[0]; 
open(LST,"<$ifile"); 
while ($input=<LST>) 

{ 
chomp($input); 
$return = system("wget --passive-ftp -nc $input"); 
} 

close(LST); 
 
A.3. thmurl.pl 
Create .QUB file download list from image number list. 
Unix/DOS usage: perl thmurl.pl fromlist tolist 
 

#!/usr/bin/perl –s 
 
$from = $ARGV[0]; 
$to = $ARGV[1]; 
open(HTMLFILE,'<'.$from); 
open(THEMISDOWN,'>'.$to); 
while($thmnr = <HTMLFILE>) 

{ 
 chomp($thmnr); 
 $url1 = "http://themis-data.asu.edu/pds/data/odt"; 
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 $url2 = lc(substr($thmnr, 0, 1)); 
 $url3 = "r0_xxxx/"; 
 $url4 = $url2; 
 $url5 = substr($thmnr, 1, 3); 
 $url6 = "xxrdr/"; 
 $url7 = $thmnr; 
 $url8 = "RDR.QUB"; 
 $url = "$url1$url2$url3$url4$url5$url6$url7$url8\n"; 
 print THEMISDOWN $url; 
 print $url; 

} 
close HTMLFILE; 
close THEMISDOWN; 

 
A.4. thmlev2.sh 
Unix shell script adapted from scripts made by David Shean 
(http://webgis.wr.usgs.gov/docs/thmirmos.txt and http://webgis.wr.usgs.gov/docs/thmvis 
mos.txt). 
Unix usage: tcsh thmlev2.sh 
 

# tcsh 
 
set mappars = "SIMP:0,OCENTRIC" 
 
foreach i (*RDR.QUB) 
$ISISEXE/thm2isis.pl $i $i.l1 -- -- $ISISM01DATA/thm_kernels_both.def.8 -- 180 -- -- 
 
# Choose between IR day, IR night or VIS: 
# dsk2dsk from=$i.l1 to=$i.l1.1b sfrom='"::2"' 
# dsk2dsk from=$i.l1 to=$i.l1.1b sfrom='"::3"' 
dsk2dsk from=$i.l1 to=$i.l1.1b sfrom='"::9"' 
 
rm --force $i.l1 
 
# Choose between using IR or VIS: 
# $ISISEXE/thmirmc.pl $i.l1.1b -- -- -- $mappars -- -- -- -- 0.1 
$ISISEXE/thmvismc.pl $i.1b -- -- -- $mappars -- -- -- -- -- -- -- -- -- -- -- -- 0.019 
 
rm --force $i.l1.1b 
end 
 
foreach i (*irmc.cub) 
dform.pl -t -gis=yes $i 
end 

 
A.5. tif2jpg2000.pl 
Script (for unix/linux) to convert all tif images in a directory to jpg images and copy the 
.tfw to .jgw. 
Unix usage: perl tif2jpg2000.pl 
 

#!/usr/bin/perl –s 
$ifile = "list"; 
system("ls -1 *.tif > list"); 
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open(LST,"<$ifile"); 
while ($input=<LST>) 

{ 
chomp($input); 
$cubname = substr($input, 0, 12); 

 system("cp $cubname.tfw $cubname.jgw"); 
 $output = "$cubname.jpg"; 

$return = system("convert $input -compress JPEG2000 $output"); 
} 

close(LST); 
system("rm --force list"); 

 
A.6. divdataset.pl 
Divides a dataset into X*X parts, using the georeference information from the worldfiles. 
It creates a directory per part and uses the windows ‘move’ program to move the images. 
Uses the Image::Size package (http://search.cpan.org/~rjray/Image-Size-3.0/Size.pm). 
Windows usage: perl divdataset.pl X 
 

#!/usr/bin/perl –s 
use Image::Size qw(:all); 
 
$griddiv = $ARGV[0]; 
$init = 1; 
$ifile = "jpg"; 
$to = "infotable"; 
system("dir/b *.jpg>jpg"); 
open(LST,"<$ifile"); 
open(TO,'>'.$to); 
while ($input=<LST>) 
 { 
 chomp($input); 
 $imgname = substr($input,0,-4); 
 $jgw = $imgname.".jgw"; 
 $i = 1; 
 open(JGWFILE,"<$jgw"); 
  while ($jgwlist=<JGWFILE>) 
  { 
  chomp($jgwlist); 
  if($i == 1) 
   { 
   $pixsize = $jgwlist; 
   } 
  if($i == 5) 
   { 
   $xcoordlu = $jgwlist; 
   } 
  if($i == 6) 
   { 
   $ycoordlu = $jgwlist; 
   } 
  $i++; 
  } 
 close(JGWFILE); 
 ($x, $y) = imgsize($input); 
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 # Specific for polar stereographic projection: 
 $xcoordc = $xcoordlu + (($x/2)*$pixsize); 
 $ycoordc = $ycoordlu - (($y/2)*$pixsize); 
 if($init == 1) 
  { 
  $xcoordmax = $xcoordc; 
  $xcoordmin = $xcoordc; 
  $ycoordmax = $ycoordc; 
  $ycoordmin = $ycoordc; 
  $init = 0; 
  } 
 if($xcoordc > $xcoordmax) 
  { 
  $xcoordmax = $xcoordc; 
  } 
 if($xcoordc < $xcoordmin) 
  { 
  $xcoordmin = $xcoordc; 
  } 
 if($ycoordc > $ycoordmax) 
  { 
  $ycoordmax = $ycoordc; 
  } 
 if($ycoordc < $ycoordmin) 
  { 
  $ycoordmin = $ycoordc; 
  } 
 print TO "$imgname,$xcoordlu,$xcoordc,$ycoordlu,$ycoordc,$pixsize,$x,$y\n"; 
 } 
close(LST); 
close(TO); 
 
# Set up the grid 
$xlength = $xcoordmax - $xcoordmin; 
$ylength = $ycoordmax - $ycoordmin; 
$gridx = $xlength/$griddiv; 
$gridy = $ylength/$griddiv; 
$xdone = $griddiv + 1; 
$ydone = $griddiv + 1; 
$leftx = $xcoordmin; 
$xpart = 1; 
until($xpart == $xdone) 
 { 
 $rightx = $leftx + $gridx; 
 $uppery = $ycoordmax; 
 $ypart = 1; 
 until($ypart == $ydone) 
  { 
  $lowery = $uppery - $gridy; 
  system("md $xpart.$ypart"); 
  open (IT,"<infotable"); 
  while (<IT>) 
   { 
   ($imgname,$xcoordlu,$xcoordc,$ycoordlu,$ycoordc,$pixsize,$x,$y) = 
split(',',$_); 
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   if(($xcoordc < $rightx) && ($xcoordc > $leftx) && ($ycoordc < $uppery) 
&& ($ycoordc > $lowery)) 
    { 
    print "$imgname lies within grid part $xpart x $ypart\n"; 
    system("move $imgname.* $xpart.$ypart"); 
    } 
   } 
  close(IT); 
  $ypart++; 
  $uppery = $lowery; 
  } 
 $xpart++; 
 $leftx = $rightx; 
 } 

 
A.7. arcgis2lst.pl 
A perl script to extract the .cub filenames from a text file generated by the ArcMap 
arcscript ‘List MXD Sources’. 
Usage: perl arcgis2lst.pl infile outfile 
 

#!/usr/bin/perl –s 
 
$from = $ARGV[0]; 
$to = $ARGV[1]; 
open(INFILE,'<'.$from); 
my $thmfind; 
read INFILE,$thmfind,-s $from; 
close INFILE; 
open(OUTFILE,'>'.$to); 
while($thmfind=~/(\\\\\b.*?.jpg)/isg) 
 { 

my $thmnr=$1; 
 $thmnr= substr($thmnr, 2, -4); 
 print OUTFILE "$thmnr.irmc.cub\n"; 
 } 
close OUTFILE; 

 
A.8. mosaicird.pdf 
Mosaicking for IR day. The script has to be run on the ISIS tae command line. It uses a 
list textfile created from the Table of Contents within ArcMap (mc.lst). This textfile lists 
all the irmc.cub or vismc.cub files in the correct mosaicking order. The temp.pdf routine 
creates irmc.cub.l4 or vismc.cub.l4 files. Therefore l4.lst has to be created from mc.lst 
listing the .l4 files in their correct mosaicking order. 
The LAT and LON arguments contain the latitude (A and B) and longitude (C and D) 
ranges for the mosaic. I used lonsys = 180 and therefore the longitude has to be given in 
this system (330 then becomes –30). 
 

procedure 
body 
 
b4equal FROMLIST=mc.lst MODE=SD 
equalizer FROMLIST=mc.lst 
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temp 
ush perl mc2l4.pl mc.lst l4.lst 
noseam FROMLIST=l4.lst TO=mosaic.cub LAT=(A,B) LON=(C,D) LINE=11 SAMP=11 
 
ush dform.pl -t -gis=YES mosaic.cub 
ush convert mosaic.tif -compress JPEG2000 mosaic.jpg 
ush cp mosaic.tfw mosaic.jgw 
 
end-proc 
.end 

 
A.9. mc2l4.pl 
For usage see Appendix A.7. 
 

#!/usr/bin/perl -s 
 
$from = $ARGV[0]; 
$to = $ARGV[1]; 
open(MCIN,'<'.$from); 
open(L4OUT,'>'.$to); 
 while($input = <MCIN>) 
 { 
  chomp($input); 
  $url = "$input.l4\n"; 
  print L4OUT $url; 
 } 
close MCIN; 
close L4OUT; 

 
A.10. mosaicirn.pdf 
Mosaicking for IR night. The script has to be run on the ISIS tae command line. It uses a 
list textfile created from the Table of Contents within ArcMap (mc.lst). This textfile lists 
all the irmc.cub files in the correct mosaicking order. 
A, B, C and D are the latitude and longitude ranges, respectively for the mosaic. I used 
lonsys = 180 and therefore the longitude has to be given in this system (330 then 
becomes –30). 
 

procedure 
body 
 
ush perl mosaic.pl mc.lst A B C D 
ush dform.pl -t -gis=YES mosaic.cub 
ush convert mosaic.tif -compress JPEG2000 mosaic.jpg 
ush cp mosaic.tfw mosaic.jgw 
 
end-proc 
.end 

 
A.11. mosaic.pl 
For usage see Appendix A.9. 
 

#!/usr/bin/perl –s 
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$ifile = $ARGV[0]; 
$lat1 = $ARGV[1]; 
$lat2 = $ARGV[2]; 
$lon1 = $ARGV[3]; 
$lon2 = $ARGV[4]; 
$init = "y"; 
 
open(LST,"<$ifile"); 
 
while ($input=<LST>) 
{ 
chomp($input); 
system("mosaic from=$input to=mosaic.cub init=$init lat=\($lat1,$lat2\) lon=\($lon1,$lon2\)"); 
$init = "n"; 
} 
close(LST); 

 
A.12. vicarstart.sh 
This shell script started the VICAR environment so that VICAR programs could be used. 
The path names should be changed to the locations of all the files on your system. 
 

#!/bin/tcsh 
source /usr/local/vicar/estec_setup.csh 
setenv MARSDTM /usr/local/vicar/data/mars_5km.dtm 
setenv LEAPSECONDS /usr/local/vicar/kernel/NAIF0008.tls 
setenv CONSTANTS   /usr/local/vicar/kernel/p_constants.ker 
setenv SUNKER      /usr/local/vicar/kernel/de405s.bsp 
setenv HWSPICE_TF  /usr/local/vicar/kernel/MEX_v08.TF 
setenv HWSPICE_TI  /usr/local/vicar/kernel/MEX_HRSC_V03.TI 
setenv HWSPICE_BC /usr4/users/joosthoe/kernels/data/ck/ATNM_PTR00334_050828_001.BC 
setenv HWSPICE_BSP /usr4/users/joosthoe/kernels/data/spk/ORMM_050901000000_00165.BSP 
setenv HWSPICE_TSC /usr4/users/joosthoe/kernels/data/sclk/MEX_060112_STEP.TSC 
alias xvd 'xvd -xrm "*enableDirectColor: false"' 

 
A.13. hrsc2jpg.pl 
Perl script to create map projected jpeg images of HRSC data. 
Usage: perl hrsc2jpg.pl projection_type listfile 
 

$trantype = $ARGV[0]; 
$ifile = $ARGV[1]; 
$HWLIB = $ENV{"HWLIB"}; 
 
open(LST,"<$ifile"); 
 
while ($input=<LST>) 
 { 

chomp($input); 
 if($trantype == "1") 
  { 
  $output = $input . ".simp"; 
  system("$HWLIB/dlrmaptran inp=$input out=$output mp_type=cylindrical_e_a 
cen_lat=0 cen_long=0 outmax=10240"); 
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  system("vtiff2 INP=$input OUT=$input.tif"); 
  system("convert $input.tif -compress JPEG2000 $input.jpg"); 
  } 
 if($trantype == "2") 
  { 
  $output = $input . ".pola"; 
  system("$HWLIB/dlrmaptran inp=$input out=$output mp_type=stereographic 
cen_lat=-90 cen_long=0 outmax=10240"); 
  system("vtiff2 INP=$input OUT=$input.tif"); 
  system("convert $input.tif -compress JPEG2000 $input.jpg"); 
  } 
    } 
close(LST); 

 
A.14. hrscworld.pl 
Perl script to grab information from the HRSC data headers to create world files (after a 
script by Trent Hare). 
Usage: perl hrscworld.pl listfile 
 

# After Trent Hare 
$ifile = $ARGV[0]; 
open(LST,"<$ifile"); 
while ($hrscfile=<LST>) 

{ 
chomp($hrscfile); 
open(FIL,'<'.$hrscfile); 
my $data; 
read(FIL,$data,10000); 
close FIL; 
@data = split /  /, $data; 
$c[1]="MAP_SCALE"; 
$c[2]="LINE_PROJECTION_OFFSET"; 
$c[3]="SAMPLE_PROJECTION_OFFSET"; 

 
foreach $c (@data) 
{  
($var, $val) = split /=/,$c; 
$h{$var}=$val; 
} 

 
$xydim = $h{$c[1]} * 1000; 
$ydim = $xydim * -1; 
$ulxmap = ($h{$c[3]} * $xydim * -1); 
$ulymap = ($h{$c[2]} * $xydim); 

 
$newworld = $hrscfile.".jgw"; 
open OUTWORLD, "> $newworld "; 
print OUTWORLD "$xydim\n"; 
print OUTWORLD "0.0\n"; 
print OUTWORLD "0.0\n"; 
print OUTWORLD "$ydim\n"; 
print OUTWORLD "$ulxmap \n"; 
print OUTWORLD "$ulymap \n"; 
close OUTWORLD; 
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  } 
close(LST); 

 
A.15. hrscsplit.pl 
Perl script to split HRSC data prior to projecting and .jpg conversion.  
Usage: perl hrscsplit listfile number (number is the amount of pixels, default is 20000) 
 

$ifile = $ARGV[0]; 
$pixels = $ARGV[1]; 
if($ARGV[1] == 0) 

{ 
$pixels = 20000; 
} 

 
$HWLIB = $ENV{"HWLIB"}; 
 
open (LST,"<$ifile"); 
while ($input=<LST>) 
 { 
 chomp($input); 
 open(HRSCDATA,'<'.$input); 
 my $hrsc; 
 read(HRSCDATA,$hrsc,10000); 
 close HRSCDATA; 
 if($hrsc=~/(NL=\b.*? )/isg) 
  { 
  $nlines=$1; 
  $nlines = substr($nlines, 3, -1); 
  print "The number of lines of $input: '$nlines'\n"; 
  } 
 if($hrsc=~/(NS=\b.*? )/isg) 
  { 
  $nsamples=$1; 
  $nsamples = substr($nsamples, 3, -1); 
  print "The number of samples of $input: '$nsamples'\n"; 
  } 
 $d = round($nlines/$pixels); 
 $g = round($nsamples/$pixels); 
 if(($d == 1) && ($g == 1)) 
  { 
  $d = 2; 
  $g = 2; 
  } 
 if($d < 1) 
  { 
  $d = 1; 
  } 
 if($g < 1) 

 { 
  $g = 1; 
  } 
 print "Creating matrix columns*rows: $g*$d\n"; 
 $e = $d + 1; 
 $h = $g + 1; 
 $part = round($nlines/$d); 
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 $sl = 1; 
 $x = 1; 
 until ($x == $e) 
  { 
  $samp = round($nsamples/$g); 
  $ss = 1; 
  $y = 1; 
  until ($y == $h) 
   { 
   $aa = $samp+$ss-1; 
   if($aa>$nsamples) 
    { 
    $samp = $nsamples - $ss + 1; 
    } 
   $bb = $part+$sl-1; 
   if($bb>$nlines) 
    { 
    $part = $nlines - $sl + 1; 
    } 
   print "DLRMAPTRAN from $input to $input.l$x.s$y\n  Starting line = $sl, 
n be es rt\n  Starting sample = $ss, number of samples = $samp\n"; um r of lin  = $pa
   system("$HWLIB/dlrmaptran inp=$input out=$input.l$x.s$y sl=$sl 
nl=$part ss n amp outmax=10240");  ss=$ s=$s
   print "Creating tiff...\n"; 
   system("vtiff2 inp=$input.l$x.s$y out=$input.l$x.s$y.tif"); 
   print "Converting tiff to jpg...\n"; 
   system("convert $input.l$x.s$y.tif -compress JPEG2000 
$input.l$x.s$y.jpg"); 
   print "Processing of $input completed.\n\n"; 
   $y++; 
   $ss = $ss + $samp; 
   } 
  $x++; 
  $sl = $sl + $part; 
  } 
 } 
close LST; 
system("ls -1 *.l?-s?>num"); 
system("perl hrscworld.pl num"); 
system("rm --force num"); 
 
sub round { 

my($number) = shift; 
return int($number + .5); 

} 
 

.16. hrsc2arcgis.pl 
esses PSA downloaded HRSC .IMG files and creates sinusoidally 

use Win32::OLE; 

A
This perl script proc
projected ArcGIS ready .bsq data. It does not work yet for polar data with a 
Stereographic projection. 
Usage: perl hrsc2arcgis.pl 
 

use Cwd; 
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$dir = getcwd; 
 
$ifile = $ARGV[0]; 
if($#ARGV < 0) 
 { 
 system("dir/b *.IMG>IMG"); 
 $ifile = "IMG"; 
 } 
 
open (LST,"<$ifile"); 
while ($input=<LST>) 
 { 
  chomp($input); 
  $output=substr($input,0,-4); 
  open(HRSCDATA,'<'.$input); 
  my $idata; 
  read(HRSCDATA,$idata,10000); 
  close HRSCDATA; 
   
  # header creation 
  $first=$idata; 
  if($first=~/(MAP_SCALE\b.*?\n)/isg) 
   { 
   $a=$1; 
   $a = substr($a,34,-12); 
   } 
  $second=$idata; 
  if($second=~/(LINE_PROJECTION_OFFSET\b.*?\n)/isg) 
   { 
   $b=$1; 
   $b = substr($b,34,-1); 
   } 
  $third=$idata; 
  if($third=~/(SAMPLE_PROJECTION_OFFSET\b.*?\n)/isg) 
   { 
   $c=$1; 
   $c = substr($c,34,-1); 
   } 
  $fourth=$idata; 
  if($fourth=~/(FILE_RECORDS\b.*?\n)/isg) 
   { 
   $d=$1; 
   $d = substr($d,34,-1); 
   } 
  $fifth=$idata; 
  if($fifth=~/(LINES\b.*?\n)/isg) 
   { 
   $e=$1; 
   $e = substr($e,34,-1); 
   } 
  $sixth=$idata; 
  if($sixth=~/(LINE_SAMPLES\b.*?\n)/isg) 
   { 
   $f=$1; 
   $f = substr($f,34,-1); 
   } 
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  $seventh=$idata; 
  if($seventh=~/(CENTER_LONGITUDE\b.*?\n)/isg) 
   { 
   $g=$1; 
   $g = substr($g,34,-1); 
   } 
  $xydim = $a * 1000; 
  $ydim = $xydim * -1; 
  $ulxmap = ($c * $xydim * -1); 
  $ulymap = ($b * $xydim); 
   
  # create header 
  print "Writing header for $input...\n"; 
  $header = $output.".hdr"; 
  open OUTHEADER, '>'.$header; 
  print OUTHEADER "nrows $e\n"; 
  print OUTHEADER "ncols $f\n"; 
  print OUTHEADER "nbands 1\n"; 
  print OUTHEADER "nbits 8\n"; 
  print OUTHEADER "byteorder I\n"; 
  print OUTHEADER "layout BSQ\n"; 
  print OUTHEADER "skipbytes $d\n"; 
  print OUTHEADER "ulxmap $ulxmap\n"; 
  print OUTHEADER "ulymap $ulymap\n"; 
  print OUTHEADER "xdim $xydim\n"; 
  print OUTHEADER "ydim $xydim\n"; 
  close OUTHEADER; 
     
  # create projection 
  $proj = $output.".prj"; 
  open OUTPROJ, '>'.$proj; 
  print OUTPROJ 
"PROJCS ars_Sinu M[\"D_Ma[\"M GCS[\"GCS_Mars_2000_Sphere\",DATUsoidal_clon$g\",GEO
rs_2000_Sphere\",SPHEROID[\"Mars_2000_IAU_IAG_Sphere\",3396190.0,0.0]],PRIMEM[\"Re
ference_Meridian\",0.0],UNIT[\"Degree\",0.0174532925199433]],PROJECTION[\"Sinusoidal\"],
PARAMETER[\"False_Easting\",0.0],PARAMETER[\"False_Northing\",0.0],PARAMETER[\"C
entral_Meridian\",$g],UNIT[\"Meter\",1.0]]"; 
  close OUTPROJ; 
   
  # rename .IMG 
  print "Renaming $input $output.bsq...\n"; 
  system("rename $input $output.bsq"); 
    
  # create and execute python script to assign projection to image. 
  print "Creating auxilary file (.aux) using python...\n"; 
  my $class = "esriGeoprocessing.GpDispatch.1"; 
  my $gp = Win32::OLE->new($class) || die "Could not create a COM $class object"; 
  $gp->defineprojection_management("$dir\\$output.bsq", "$proj"); 
  unlink($proj); 
  print "Building pyramids...\n"; 
  # This takes some time, if you don't want it, place # in front of the following line: 
  $gp->BuildPyramids_management("$dir\\$output.bsq"); 
 } 
close LST; 
unlink($ifile); 
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A.17. hrscanag.pl 
 two HRSC images which can be combined to form an anaglyph. It 

l transformation_type 

$ORI_MODE = "EXT"; 

Perl script to create
uses the following DLR VICAR routines: hrfill, dlrto8, hrortho and vtiff2. It also uses the 
ImageMagick ‘convert’ program to create jpeg2000 files. I used this script on a unix 
machine where the VICAR DLR routines were installed. All programs except vtiff2 are 
available in the minivicar package (http://pds-imaging.jpl.nasa.gov/data/mex/mex/hrsc/ 
mexhrsc_0001/software/). 
Unix usage: perl hrscanag.p
 

$ANAG_MPSCALE = 0.1; 
$ANCH_ANA_L3 = 100; 
$START_L = 1; 
$NOF_L = 0; 
$MAXOUTSIZE = 10240; 
 
$trantype = $ARGV[0]; 
if($trantype == "1") 
 { 
 $MP_TYPE = "cylindrical_e_a"; 
 $MP_CENLAT = 0; 
 $MP_CENLON = 0; 
 } 
if($trantype == "2") 
 { 
 $MP_TYPE = "stereographic"; 
 $MP_CENLAT = -90; 
 $MP_CENLON = 0; 
 } 
if($trantype == "3") 
 { 
 $MP_TYPE = "sinusoidal"; 
 $MP_CENLAT = 0; 
 $MP_CENLON = "--"; 
 } 
$HWLIB = $ENV{"HWLIB"}; 
 
system("ls -1 *.s12.??>s12"); 
 
open(LST,"<s12"); 
while ($input=<LST>) 
 { 
 chomp($input); 
 $i = $input; 
 $j = substr($input, 0,11)."nd2".substr($input,14,3); 
 system("$HWLIB/hrfill inp=$i out=$i.filled"); 
 system("$HWLIB/hrfill inp=$j out=$j.filled"); 
 if(-e "$i.filled") 
  { 
  system("$HWLIB/dlrto8 inp=$i.filled out=$i.8bit DNMIN=-1 DNMAX=-1"); 
  } 
 else 
  { 
  system("$HWLIB/dlrto8 inp=$i out=$i.8bit DNMIN=-1 DNMAX=-1"); 
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  } 
 if(-e "$j.filled") 
  { 
  system("$HWLIB/dlrto8 inp=$j.filled out=$j.8bit DNMIN=-1 DNMAX=-1"); 
  } 
 else 
  { 
  system("$HWLIB/dlrto8 inp=$j out=$j.8bit DNMIN=-1 DNMAX=-1"); 
  } 
 syste $HWLm(" ut=$i.lev3 IB/hrortho inp=$i.8bit ori=$ORI_MODE ext=$i"."_ext"." o
sl_i=$START_L nl_i=$NOF_L anch=$ANCH_ANA_L3 OUTMAX=$MAXOUTSIZE rep=yes 
dtm=0 mp_type=$MP_TYPE cen_lat=$MP_CENLAT cen_long=$MP_CENLON 
mp_sca=$ANAG_MPSCALE -usemp"); 
 system("$HWLIB/hrortho inp=$j.8bit ori=$ORI_MODE ext=$j"."_ext"." out=$j.lev3 
sl_i=$START_L nl_i=$NOF_L anch=$ANCH_ANA_L3 OUTMAX=$MAXOUTSIZE rep=yes 
dtm=0 fitto=$i.lev3"); 
 } 
close(LST); 
 
system("ls -1 *.lev3>lev3"); 
open(LST,"<lev3"); 
while ($input=<LST>) 
 { 
 chomp($input); 
 system("vtiff2 INP=$input OUT=$input.tif"); 
 system("convert $input.tif -compress JPEG2000 $input.jpg"); 
 } 
close(LST); 

 
.18. hrscdtm2arcgis.pl 

s only and you need ArcGIS 9.1 with Spatial Analyst. 

#!/usr/bin/perl 

A
This perl script is window
Usage: hrscdtm2arcgis.pl listfile 
 

 
use Cwd; 
use Win32::OLE; 
$dir = getcwd; 
$ifile = $ARGV[0]; 
my $class = "esriGeoprocessing.GpDispatch.1"; 
my $gp = Win32::OLE->new($class) || die "Could not create a COM $class object"; 
$gp->CheckOutExtension("Spatial"); 
 
open(LST,"<$ifile"); 
while ($dtmfile=<LST>) 
 { 
 print "Grabbing label from $dtmfile\n"; 
 chomp($dtmfile); 
 open(DTM,'<'.$dtmfile); 
 my $dtmlabel; 
 read(DTM,$dtmlabel,10000); 
 close DTM; 
 
 @dtmlabel = split /  /, $dtmlabel; 
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 $c[1]="MAP_SCALE"; 
 $c[2]="LINE_PROJECTION_OFFSET"; 
 $c[3]="SAMPLE_PROJECTION_OFFSET"; 
 $c[4]="LBLSIZE"; 
 $c[5]="NL"; 
 $c[6]="NS"; 
 $c[7]="POSITIVE_LONGITUDE_DIRECTION"; 
 $c[8]="CENTER_LONGITUDE"; 
 $c[9]="STOP"; 
  
 foreach $c (@dtmlabel) {  
 ($var, $val) = split /=/,$c; 
 $h{$var}=$val; 
 }; 
  
 if($h{$c[7]} =~ /EAST/) 
  { 
  $sinlon = $h{$c[8]}; 
  } 
 if($h [7]} =~ /WEST/) {$c
  { 
  $sinlon = -$h{$c[8]}; 
  } 
 $  $h{$c[1]} * 1000; xydim =
 $ulxm  = ($h{ap  * -1); $c[3]} * $xydim
 $ulymap = ($h{$c[2]} * $xydim); 
 $righe = $h{$c[5]}; 
 $colonne = $h{$c[6]}; 
 $skip = $h{$c[4]}; 
  
 $newfile = substr($dtmfile, 0, 10); 
 $bsqfile = $newfile.".bsq"; 
 $hdrfile = $newfile.".hdr"; 
 print "Writing header...\n"; 
 open OUTWORLD, "> $hdrfile "; 
 print OUTWORLD "nrows $righe\n"; 
 print OUTWORLD "ncols $colonne\n"; 
 print OUTWORLD "nbands 1\n"; 
 print OUTWORLD "nbits 16\n"; 
 print OUTWORLD "byteorder I\n"; 
 print OUTWORLD "layout BSQ\n"; 
 print OUTWORLD "skipbytes $skip\n"; 
 print OUTWORLD "ulxmap $ulxmap\n"; 
 print OUTWORLD "ulymap $ulymap\n"; 
 print OUTWORLD "xdim $xydim\n"; 
 print OUTWORLD "ydim $xydim\n"; 
 close OUTWORLD; 
 
 print "Renaming $dtmfile to $bsqfile\n"; 
 system("ren $dtmfile $bsqfile"); 
 $Expression = "select ( merge ( setnull ( $dir/$bsqfile > 32767 , $dir/$bsqfile ) , ( 
$dir/$bsqfile - 65536 ) ) , 'value <> -32768' )"; 
 $gp->SingleOutputMapAlgebra_sa($Expression, "$dir/$newfile"); 
  
 print "Assigning projection...\n"; 
 $proj = $newfile.".prj"; 

261



 open OUTPROJ, '>'.$proj; 
 print OUTPROJ 
"PROJCS[\"Mars_Sinusoidal_clon$sinlon\",GEOGCS[\"GCS_Mars_2000\",DATUM[\"D_Mars_
2000\",SPHER EM[\"RefeOID[\"Mars_2000_IAU_IAG\",3396190.0,169.8944472236118]],PRIM
rence_Meridian\",0.0],UNIT[\"Degree\",0.0174532925199433]],PROJECTION[\"Sinusoidal\"],P
ARAMETER[\"False_Easting\",0.0],PARAMETER[\"False_Northing\",0.0],PARAMETER[\"Ce
ntral_Meridian\",$sinlon],UNIT[\"Meter\",1.0]]"; 
 close OUTPROJ; 
 $gp->defineprojection_management("$dir/$newfile", "$proj"); 
 unlink($proj); 
 } 
close(LST); 

 
A.19. moc2arcgis.pl 

 perl script to reproject MOC images. It uses the gdal_translate program from GDAL 
 ArcGIS. It needs a moclatlons.txt file generated from SPICE 

A
and the geoprocessor from
and MOLA datasets by Shane Byrne. It also uses wget to download the MOC images. I 
assume the direction of the Mars Global Surveyor was NNEward when the MOC image 
was taken. A small amount of MOC images are NNW. 
Usage: moc2arcgis.pl ArcGIS_Attribute_Table_Export_file 
 

#!/usr/bin/perl -s 
 
# pre stuff 
use Image::Size qw(:all); 
use Cwd; 
use Math::Trig; 
use warnings; 
use Win32::OLE; 
$dir = getcwd; 
$from = $ARGV[0]; 
$pi = atan2(1,1) * 4; 
 
# Data input 
open(MOCLIST,'<'.$from); 
my $moc; 
read MOCLIST,$moc,-s $from; 
close MOCLIST; 
open(MOCDATA,'<'."moclatlons.txt"); 
my $mocdata; 
read MOCDATA,$mocdata,-s "moclatlons.txt"; 
close MOCDATA; 
 
# Do for every image   
while($moc=~/(http\b.*?,)/isg) 
 {  
 my $mocid=$1; 
 # conv sion fromer  wr.usgs website to msss.com website 
 $mocid = uc(substr($mocid,35,-7)); 
 $mocid1 = substr($mocid,0,1); 
 $mocid2 = substr($mocid,1,2); 
 $mocid3 = substr($mocid,0,3); 
 $url1 = "http://www.msss.com/moc_gallery/"; 
 if(substr($mocid2,0,1)=="0") 
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  { 
  $mocid2=substr($mocid2,1,2); 
  } 
 if((su ($mocid,0,2) =~ /SP/) || (substr($mobstr cid,0,2) =~ /AB/)) 
  { 
  $url2 = "ab1_m04"; 
  } 
 if d1 =~ /M/) ($moci
  { 
  if($mocid2 <= "4") 
   { 
   $url2 = "ab1_m04"; 
   } 
  if(($mocid2 >= "7") && ($mocid2 <= "12")) 
   { 
   $url2 = "m07_m12"; 
   } 
  if(($mocid2 >= "13") && ($mocid2 <= "18")) 
   { 
   $url2 = "m13_m18"; 
   } 
  if($mocid2 >= "19") 
   { 
   $url2 = "m19_m23"; 
   } 
  } 
 if($mocid1 =~ /E/) 
  { 
  if($mocid2 <= "6") 
   { 
   $url2 = "e01_e06"; 
   } 
  if(($mocid2 >= "7") && ($mocid2 <= "12")) 
   { 
   $url2 = "e07_e12"; 
   } 
  if(($mocid2 >= "13") && ($mocid2 <= "18")) 
   { 
   $url2 = "e13_e18"; 
   } 
  if($mocid2 >= "19") 
   { 
   $url2 = "e19_r02"; 
   } 
  } 
 if($mocid1 =~ /R/) 
  { 
  if($mocid2 <= "2") 
   { 
   $url2 = "e19_r02"; 
   } 
  if(($mocid2 >= "3") && ($mocid2 <= "9")) 
   { 
   $url2 = "r03_r09"; 
   } 
  if(($mocid2 >= "10") && ($mocid2 <= "15")) 
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   { 
   $url2 = "r10_r15"; 
   } 
  if(($mocid2 >= "16") && ($mocid2 <= "21")) 
   { 
   $url2 = "r16_r21"; 
   } 
  if($mocid2 >= "22") 
   { 
   $url2 = "r22_s04"; 
   } 
  } 
 if($mocid1 =~ /S/) 
  { 
  if($mocid2 <= "4") 
   { 
   $url2 = "r22_s04"; 
   } 
  if(($mocid2 >= "5") && ($mocid2 <= "10")) 
   { 
   $url2 = "s05_s10"; 
   } 
  } 
 # download map or non map projected 
 print ttempti"A ng to download map-projected image...\n"; 
 $urlmap = "$url1$url2/full_jpg\_map/$mocid3/$mocid.jpg\n"; 
 system("wget --passive-ftp --tries=1 -nc -nv $urlmap"); 
 $map = 0; 
 if(-e "$mocid.jpg") 
  { 
  $map = 1; 
  } 
 if($m == 0) ap 
  { 
  print "Unsuccesfull, attempting to download map-projected image...\n"; 
  $urlnonmap = "$url1$url2/full_jpg\_non_map/$mocid3/$mocid.jpg\n"; 
  system("wget --passive-ftp --tries=1 -nc -nv $urlnonmap"); 
  } 
 # ocessing  start pr
 if(-e ocid.jp"$m g") 
  { 
  print "Deriving image corner latitude/longitudes...\n"; 
  # derive info from moclatlons.txt 
  $mocdata0=$mocdata; 
  $mocid0 = uc($mocid); 
  ($x, $y) = imgsize("$mocid.jpg"); 
  if($mocdata0=~/($mocid0\b.*?\n)/isg) 
   { 
   $all=$1; 
   ($mocid,$ione,$itwo,$ithree,$ifour,$ifive,$isix,$iseven,$ieight) = 
split(',',$all); 
   # conversion of 0 > 360 east longitude to -180 > 180 east longitude. 
   if($ione > 180) 
    { 
    $ione = $ione - 360; 
    } 
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   if($ithree > 180) 
    { 
    $ithree = $ithree - 360; 
    } 
   if($ifive > 180) 
    { 
    $ifive = $ifive - 360; 
    } 
   if($iseven > 180) 
    { 
    $iseven = $iseven - 360; 
    } 
   } 
  if($map == 0) 
   { 
   $fa1 = ($ione - $ithree)**2; 
   $fa2 = ($itwo - $ifour)**2; 
   $fb1 = ($ione - $iseven)**2; 
   $fb2 = ($itwo - $ieight)**2; 
   $fa = sqrt($fa1 + $fa2); 
   $fb = sqrt($fb1 + $fb2); 
   $factorx = $x / $fa; 
   $factory = $y / $fb; 
   $zeropointx = $ifive; 
   $zeropointy = $ieight; 
   $x1 = ($ione - $zeropointx) * $factorx; 
   $y1 = ($itwo - $zeropointy) * $factory; 
   $x2 = ($ithree - $zeropointx) * $factorx; 
   $y2 = ($ifour - $zeropointy) * $factory; 
   $x3 = ($iseven - $zeropointx) * $factorx; 
   $y3 = ($ieight - $zeropointy) * $factory; 
   $x4 = ($ifive - $zeropointx) * $factorx; 
   $y4 = ($isix - $zeropointy) * $factory; 
   $newx = $x1; 
   $newy = abs($y2); 
   # start gdal and arcgis processing 
   print "Converting and rescaling image to tiff using gdal_translate...\n"; 
   system("gdal\\gdal_translate -outsize $newx $newy $mocid.jpg temp.tif"); 
   unlink("$mocid.jpg"); 
   my $class = "esriGeoprocessing.GpDispatch.1"; 
   my $gp = Win32::OLE->new($class) || die "Could not create a COM $class 
o ctbje "; 
   my $SourcePoints = "0 0; $x1 0; 0 $y2; $x1 $y2"; 
   my $TargetPoints = "$x4 $y4; $x3 $y3; $x2 $y2; $x1 $y1"; 
   print "Warping image...\n"; 
   $gp->Warp_management("$dir\\temp.tif", $SourcePoints, $TargetPoints, 
"$dir\\temp2.tif", "POLYORDER1"); 
   $gp->CheckOutExtension("Spatial"); 
   print "Converting 255 to NODATA...\n"; 
   $asciidata = "2552NODATA.txt"; 
   open AD, '>'.$asciidata; 
   print AD "255\tNODATA"; 
   close AD; 
   $gp->ReclassByASCIIFile_sa("$dir\\temp2.tif", "$dir\\$asciidata", 
"$dir\\$mocid.tif", "DATA"); 
   unlink($asciidata); 
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   unlink("temp.tif"); 
   unlink("temp.aux"); 
   unlink("temp2.tif"); 
   unlink("temp2.aux"); 
   unlink("temp2.rrd"); 
   unlink("temp2.tif.xml"); 
   unlink("temp2.tif"); 
   unlink($mocid.".aux"); 
   unlink($mocid.".rrd"); 
   unlink($mocid.".tif.xml"); 
   print "Converting back to jpeg using gdal_translate...\n"; 
   system("gdal\\gdal_translate -a_nodata 1 -of jpeg $mocid.tif $mocid.jpg"); 
   unlink("$mocid.tif"); 
   # create worldfile 
   print "Creating worldfile...\n"; 
   $yscale = (1 / $factory) * (($pi * 3396190.0) / 180); 
   $xscale = (1 / $factorx) * (($pi * 3396190.0) / 180); 
   $ulymap = $zeropointy * (($pi * 3396190.0) / 180); 
   $ulxmap = $zeropointx * (($pi * 3396190.0) / 180); 
   $newworld = $mocid.".jgw"; 
   open OUTWORLD, '>'.$newworld; 
   print OUTWORLD "$xscale\n"; 
   print OUTWORLD "0.0\n"; 
   print OUTWORLD "0.0\n"; 
   print OUTWORLD "-$yscale\n"; 
   print OUTWORLD "$ulxmap \n"; 
   print OUTWORLD "$ulymap \n"; 
   close OUTWORLD; 
   # create and assign projection 
   print "Assigning projection...\n"; 
   $proj = $mocid.".prj"; 
   open OUTPROJ, '>'.$proj; 
   print OUTPROJ 
"PROJCS[\"Mars_Equicylindrical_clon=0\",GEOGCS[\"GCS_Mars_2000\",DATUM[\"D_Mars_
2000\",SPHEROID[\"Mars_2000_IAU_IAG\",3396190.0,0.0]],PRIMEM[\"Reference_Meridian\"
,0.0],UNIT[\"Degree\",0.0174532925 l\"],PARA199433]],PROJECTION[\"Equidistant_Cylindrica
METER[\"False_Easting\",0.0],PARAMETER[\"False_Northing\",0.0],PARAMETER[\"Central_
Meridian\",0.0],UNIT[\"Meter\",1.0]]"; 
   close OUTPROJ; 
   $gp->defineprojection_management("$dir\\$mocid.jpg", "$proj"); 
   unlink($proj); 
   print "Building pyramids...\n"; 
   $gp->BuildPyramids_management("$dir\\$mocid.jpg"); 
   } 
  else 
   { 
   # image is already map projected so only create worldfile 
   print "Creating worldfile...\n"; 
   $yscale = abs($ieight - $ifour) * (($pi * 3396190.0) / 180) / $y; 
   $xscale = abs($ifive - $ione) * (($pi * 3396190.0) / 180) / $x; 
   $ulymap = ((($pi * 3396190.0) / 180) * $ieight); 
   $ulxmap = -(abs($ifive - $ione) * (($pi * 3396190.0) / 180)) / 2; 
   $newworld = $mocid.".jgw"; 
   open OUTWORLD, '>'.$newworld; 
   print OUTWORLD "$xscale\n"; 
   print OUTWORLD "0.0\n"; 
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   print OUTWORLD "0.0\n"; 
   print OUTWORLD "-$yscale\n"; 
   print OUTWORLD "$ulxmap \n"; 
   print OUTWORLD "$ulymap \n"; 
   close OUTWORLD; 
   # create and assign projection 
   $proj = $mocid.".prj"; 
   open OUTPROJ, '>'.$proj; 
   $sinlon = ($ifive + $ione) / 2; 
   print OUTPROJ 
"PROJCS[\"Mars_Sinusoidal_clon$sinlon\",GEOGCS[\"GCS_Mars_2000_Sphere\",DATUM[\"D
_ rs_ _S ",SPHEROID[\"Mars_2000_IAUMa 2000 phere\ _IAG_Sphere\",3396190.0,0.0]],PRIMEM[
\"Reference_Meridian\",0.0],UNIT[\ "Sinusoida"Degree\",0.0174532925199433]],PROJECTION[\
l\"],PARAMETER[\"False_Easting\",0.0],PARAMETER[\"False_Northing\",0.0],PARAMETER[
\"Central_Meridian\",$sinlon],UNIT[\"Meter\",1.0]]"; 
   close OUTPROJ; 
   print "Assigning projection...\n"; 
   my $class = "esriGeoprocessing.GpDispatch.1"; 
   my $gp = Win32::OLE->new($class) || die "Could not create a COM $class 
object"; 
   $gp->defineprojection_management("$dir\\$mocid.jpg", "$proj"); 
   unlink($proj); 
   print "Building pyramids...\n"; 
   $gp->BuildPyramids_management("$dir\\$mocid.jpg"); 
   } 
  print "\n"; 
  } 
 else 
  { 
  print "Unsuccesfull, $mocid.jpg cannot be found!..\n\n"; 
  } 
 } 

 
A.20. MOLA2arcgis.pl 

A.TAB MOLA.TXT 
 to ArcMap via Tools > Add XY Data make sure you change the 

Sphere",SPHEROID["MOLA

Usage: perl MOLA2arcgis.pl MOL
When you add the data
projection to MOLAproj.prj. 
 ---------- beginning of MOLAproj,prj ------------ 
PROJCS["Equirectangular projection using MOLA 
sphere",GEOGCS["MOLA_Sphere",DATUM["D_MOLA_
_Sphere",3396000.0,0.0]],PRIMEM["Reference_Meridian",0.0],UNIT["Degree",0.01745
32925199433]],PROJECTION["Equidistant_Cylindrical"],PARAMETER["False_Eastin
g",0.0],PARAMETER["False_Northing",0.0],PARAMETER["Central_Meridian",0.0],P
ARAMETER["Standard_Parallel_1",0.0],UNIT["Meter",1.0]] 
-------------- end of MOLAproj,prj ---------------- 
 

#!/usr/bin/perl -s 
# MOLA2arcgis.pl 
 
$ifile = $ARGV[0]; 
$to = $ARGV[1]; 
$line = 1; 
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open(PNTLST,'>'.$to); 
print PNTLST "X,Y,LON,LAT,Z,ORBIT\n"; 
open(LST,"<$ifile"); 
while ($input=<LST>) 
 { 
 chomp($input); 
    if ($line > 2){ 
 $lon = substr($input,0,9); 
 $lat = substr($input,10,7); 
 $z = substr($input,22,8); 
 $orbit = substr($input,67,5); 
 if(substr($lat,0,1) =~ / /) 
  { 
  $lat = substr($lat,1,(length($lat)-1)) 
  } 
 if(sub ($lat,0,str 1) =~ / /) 
  { 
  $lat = substr($lat,1,(length($lat)-1)) 
  } 
 if(sub ($lon,0str ,1) =~ / /) 
  { 
  $lon = substr($lon,1,(length($lon)-1)) 
  } 
 if(sub ($lon,0str ,1) =~ / /) 
  { 
  $lon = substr($lon,1,(length($lon)-1)) 
  } 
 if(sub ($orbitstr ,0,1) =~ / /) 
  { 
  $orbit = substr($orbit,1,(length($orbit)-1)) 
  } 
 if(sub ($orbitstr ,0,1) =~ / /) 
  { 
  $orbit = substr($orbit,1,(length($orbit)-1)) 
  } 
 # conv sion ofer  0 > 360 east longitude to -180 > 180 east longitude. 
 if  180) ($lon >
  { 
  $lon = $lon - 360; 
  } 
 # Lat e is OCitud entric so can be directly related to the Y belonging to 180 degrees: 
 $ n2(1,1) * 4; pi = ata
 $y = 96000 (33 $lat; * $pi / 180) * 
 $x = (3396000 * $pi / 180) * $lon; 
 print PNTLST "$x,$y,$lon,$lat,$z,$orbit\n"; 
 } 
  line++;     $
 } 
close LST; 
close PNTLST; 
print "Saved to '$to'."; 

 
A.21. OMEGAsplit.pl 
Usage: perl OMEGAsplit.pl 
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$ifile = $ARGV[0]; 
use Cwd; 
my $dir = getcwd; 
 
open (OC, '> omegasplit.pro'); 
open (LST,"<$ifile"); 
while ($input=<LST>) 
 { 
 chomp($input); 
 print OC "ENVI_OPEN_FILE, '$dir/$input', r_fid=ac_all\n"; 
 print OC "envi_file_query, ac_all, ns=ns, nl=nl\n"; 
 print OC "dims = [-1,0,ns-1,0,nl-1]\n"; 
 print OC "pos = lindgen(128)\n"; 
 print OC "ENVI_OUTPUT_TO_EXTERNAL_FORMAT, /ENVI, fid=ac_all, pos=pos, 
d s=dims, OUT_NAME='$dir/$input-IR-C'\n"; im
 print OC "pos = lindgen(128) + 128\n"; 
 print OC "ENVI_OUTPUT_TO_EXTERNAL_FORMAT, /ENVI, fid=ac_all, pos=pos, 
d s=dims, OUT_NAME='$dir/$inputim -IR-L'\n"; 
 print OC "pos = lindgen(96) + 256\n"; 
 print OC "ENVI_OUTPUT_TO_EXTERNAL_FORMAT, /ENVI, fid=ac_all, pos=pos, 
d s=dims, OUT_NAME='$dir/$input-VIS'\i n"; m
 print OC "\n\n"; 
 } 
p t OC "close\n"; rin
print OC "END\n"; 
close (OC); 
close (LST); 

 
A.22. writeOMEGAproj.pl 
Perl script to write the projection IDL code for all the kdat OMEGA data in the directory. 
Usage: perl writeOMEGAproj.pl 
 

#!/usr/bin/perl -s 
 
$ifile = "orbs"; 
 
# UNIX: 
# system("ls -1 *kdat > orbs"); 
# DOS: 
system("dir/s/b *kdat > orbs"); 
 
open(LST,"<$ifile"); 
open (OC, '> OMEGAproj.pro'); 
 
while ($omegalst=<LST>) 

{ 
chomp($omegalst); 
$ORB = substr($omegalst, 0, -5); 
print OC "ENVI_OPEN_FILE, '$ORB\_lonlat', r_fid=lonlat\n"; 
print OC "ENVI_OPEN_FILE, '$ORB\_kdat', r_fid=kdat\n"; 
print OC "params = [3396190.0, 0.0, 0.0, 0.0, 0.0]\n"; 
print OC "name = 'Mars Equirectangular Sphere'\n"; 
print OC "datum = 'D_Mars_2000'\n"; 
print OC "envi_file_query, kdat, nb=nb\n"; 
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print OC "pos  = lindgen(nb)\n"; 
print OC "AreoLatLong = ENVI_PROJ_CREATE(/geographic, datum=datum)\n"; 
print OC "AreoAramChaos = ENVI_PROJ_CREATE(type=17, name=name, datum=datum, 

params=params)\n"; 
print OC "ENVI_DOIT, 'ENVI_GLT_DOIT', I_PROJ=AreoLatLong, 

O_P ID=lonlat, ROJ=AreoAramChaos, OUT_NAME='$ORB\_GLT', R_FID=orbglt, X_F
X_POS=0, Y_FID=lonlat, Y_POS=1\n"; 

$return = print OC "ENVI_DOIT, 'ENVI_GEOREF_FROM_GLT_DOIT', 
BACKGROUND=0 , FID=kdat, GLT_FID=orbglt, POS=pos, OUT_NAME='$ORB\_PROJ'\n\n"; 

} 
close(LST); 
print OC "close\n"; 
print OC "END\n"; 
close (OC); 

 
A.2 ectrum’ IDL function 
This script was created by Harald van der Werff. 

sa DL command line: RESULTS = Divide_By_Spectrum(image,spectrum) 

3. ‘Divide_By_Sp

U ge within I
 

function Divide_By_Spectrum,image,spectrum 
 
 ns = N_ELEMENTS(image[*,0,0]) 
 nl = N_ELEMENTS(image[0,*,0]) 
 nb = N_ELEMENTS(image[0,0,*]) 
 
 output = FLTARR(ns,nl,nb) 
 
 for x = 0, ns-1 do begin 
   for y = 0, nl-1 do begin 
     output[x,y,*] = image[x,y,*]/float(spectrum) 
   endfor 
 endfor 
 
 return, output 
 
end 

 
A.24. Concentricity / Radiality 
VBA script to calculate the Concentricity and Radiality of a selection of lineaments 

la to a specific point (with Xcenter/Ycenter coordinates). re tive 
 

Dim Pi As Double 
Dim Angle As Double 
Dim Dx As Double 
Dim Dy As Double 
Dim Xcenter As Double 
Dim Ycenter As Double 
Dim RadAngle As Double 
Dim RadialAngle As Double 
Dim Concentricity As Double 
 
Xcenter = VALUEX 
Ycenter = VALUEY 
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Pi = 3.1415926535897932384626433832795028841972 
 
Dx = Xcenter - [Easting] 
Dy = Ycenter - [Northing] 
RadAngle = 90 - ( atn (Dy / Dx) * ( 180 / Pi )) 
 
If ( [GEOANGLE] > 180) Then 
   Angle = [GEOANGLE]  - 180 
ElseIf ( [GEOANGLE] < 180) Then 
   Angle = [GEOANGLE]  
End If 
 
RadialAngle = Angle - RadAngle 
 
If ( abs (RadialAngle) > 90) Then 
   Concentricity = 180 - abs (RadialAngle) 
ElseIf ( abs (RadialAngle) < 90) Then 
   Concentricity = abs (RadialAngle) 
End If 
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Appendix B – Mars Simple Cylindrical Projection 
The projection parameters can be saved in a file with a .prj extension. This projection 
uses an ellipse and the zero degree longitude as central meridian (clon=0). 
 

PROJCS["Mars Simple Cylindrical (Ellipse, clon=0)", 
GEOGCS["GCS_Mars_2000", 

DATUM["<custom>", 
SPHEROID["<custom>",3396190.0,169.8944472236118]], 

PRIMEM["Reference_Meridian",0.0], 
UNIT["Degree",0.0174532925199433]], 

PROJECTION["Equidistant_Cylindrical"], 
PARAMETER["False_Easting",0.0], 
PARAMETER["False_Northing",0.0], 
PARAMETER["Central_Meridian",0.0], 
PARAMETER["Standard_Parallel_1",0.0], 
UNIT["Meter",1.0]] 
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